
Welcome! 
Being our inauguration eNewsletter, I know some of you will have great ideas to improve this format. So feel free to 

provide positive and negative feedback to me at tips@learnlogos.com 

Thanks! And Enjoy 

John Fallahee 

President/CEO 

LearnLogos.com 

ALERT!!! 

Free Book for Logos 4: The Greek New Testament: SBL Edition 
Learn More/Download Now: http://www.logos.com/sblgnt?sblgnt 
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OPTIMIZING LOGOS 4 

Guides: Faster than a Speeding Bullet 
When you run your passage guide, exegetical guide, and Bible word study report you may experience what I call “The 

Great Wait”! You know what I am talking about…it can take some time for Logos 4 to search your library and return 

important results in the guides. After the guides are finally completed, and your computer “catches its breath”; you can 

actually start clicking and reading the search results.   

I propose a different approach. Instead of the Logos default of “expanding” every section of the guide, you should 

“collapse” every section. Here is what I mean: 

 

 

 

Expanded 

 

Collapsed 

 

 

HOW TO:  (Guides > Passage Guide, Exegetical Guide, Bible Word Study) 

Shortcut: Click the link to open the Passage Guide, Exegetical Guide, Bible Word Study 

To collapse any section, simply click on the section name or the small, black triangle.   

To expand any section, simply click on the section name or the small, black triangle. 

Note: Whenever you close the guide, Logos 4 will remember which section of the guide is expanded, and which is 

collapsed. A good “housekeeping” habit is to open and close one section at a time. This will keep Logos 4 fast, almost as 

fast a speeding bullet : ) 

 

logos4:Guide;t=Passage_Guide
logos4:Guide;t=Exegetical_Guide
logos4:Guide;t=Bible_Word_Study


PRAYER 

Prayer List: I Almost Forgot to Pray! 
We know the power of prayer, we know the importance of prayer, but few of us persevere in prayer. Let me show one 

tool that can change all that. It’s the prayer list.  

Shortcut: Click here to open the prayer list 

How to: Tools > Prayer List 

 

Once the prayer list is opened, you can change the name of the prayer list from “Untitled Prayer List” to something more 

specific.  There is no need to click “Add prayer”, since Logos 4 by default has added one already. Of course, you will need 

to click “Add prayer” to add additional prayers to the prayer list.   

In order to type your prayer, click the white space to the right of the small white box under the word “today”. 

  

You can now enter the details of your prayer including the name of the prayer, specific details of the prayer, and even 

create a tag or word that you can associate with the prayer to organize and search later to find your prayer. Some tag 

ideas could include the following: Family, Church, Co-Workers, Government, etc.  

Now that you have entered you prayer details, it is important to determine how often you want pray this prayer. Logos 4 

has a built in reminder system to help you remember to pray. In the bottom right you will the word “every” and the 

word “day”. These are the defaults. If you click on “day” you can choose the starting and ending dates. You can also 

choose whether you will pray on a daily, weekly, monthly, or yearly basis. Next, you need to choose the frequency. In 

other words, how many days, how many weeks, how many months, and how many years to pray this prayer. See below: 

 

Once you have finished entering the details of your prayer, you can close this prayer list and Logos 4 will remember 

everything you typed. Look for your prayer list on the home page.

 

logos4:PrayerList;title=Untitled_Prayer_List


Historical Background/Theological Background 

Commentaries: It was so long ago! 
Bridging the biblical past with our present day is important when it comes to interpretation and application. 

But it can be difficult tracking down the relevant information. One of the first places I visit for this information 

is the Bible Knowledge commentary.  

 

Shortcut: Click here to open this commentary 

Did you know that at the front of every commentary is a mini-history lesson? Check this out: 

 

Do you see that at the beginning of every book of the Bible you can learn about the title, author, date, purpose, themes, 

and additional historical background?  

 

What book do you use for historical background research?   

Email me so I can share in our next eNewsLetter. 

tips@learnlogos.com 
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Outlining 

Getting a Quick Overview  
 

There are several ways to outline a text and use an outline for studying. This week I would like to introduce 

to you the idea of using an outline to review large sections of the biblical text, even overview a whole book 

of the Bible. Please keep in mind that it is essential that you have read the book several times before taking 

this step.   

One of my favorite resources for this task is the Outline Bible by Harold Wilmington 

Action: Click here to open The Outline Bible 

As you can see below, this resource explains in an exposition, summary fashion the details of the book. So anytime you 

are studying a verse or passage of the book, review the whole book’s outline to grasp how that passage fits in the 

greater context. 

 

If you are leader, teacher, or preacher this is a must use book. By the way, if you had Logos prior to Logos 4, you may 

already have this book in your library. If Logos 4 is your first Logos Bible Software program than you will need to 

purchase this book. Click here to buy this book from Logos. 

Do you use outlines from a different book, let me know via email: tips@newsletter.com? 

  

logosres:outlnbbl;ref=Bible.Jud1
logosres:outlnbbl;ref=Bible.Jud1
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Word Study 

To Infinity and Beyond…the Dictionaries and Lexicons 
If you have used the Exegetical Guide or Bible Word Study Report, then you have used dictionaries and lexicons to 

further understand the meaning of a word.  But what happens when this is not enough information or you want to know 

more about a word?  

One of my favorite techniques is to search for a Hebrew or Greek Word in my entire library or in a special collection 

(we’ll talk about this next week) I have created. You will be thrilled to realize how many other books can provide 

additional insight into a word’s meaning. 

Here are the steps: 

Step 1:  Open an interlinear Bible like the NAS and right click on a word. In this example, we are in Philippians 4:10 and 

are right clicking on the word “revived”. Click here to go to Philippians 4:10 in the NAS. 

Step 2: Choose from the menu at the right, ‘manuscript’. 

Note: The reason we chose ‘manuscript’ verses ‘lemma’ is that many use this form in their writings. You can search the 

lemma form as well. 

Step 3: Choose from the menu at the left, ‘search entire library’. 

 

Please remember that results will vary based on the books and resources in your library. Click here to run the search. 

 

logosres:nasb95;ref=BibleNASB95.Php4.10
logos4:Search;kind=Basic;q=$E1$BC$80$CE$BD$CE$B5$CE$B8$CE$AC$CE$BB$CE$B5$CF$84$CE$B5;match=stem


Illustrations/Applications 

A Picture is worth a thousand words… 
I don’t know about you, but I struggle to find good illustrations. The best illustrations are from your own life, but even 

these too can be limited or not appropriate to share with others. So this week I will share with you a list of all the books 

of illustrations I have and how many illustrations are in each book. I have also included hymn books because of their 

rich, vivid lyrical content. 

 

If you are using a book of illustrations that I did not mention, please let me 

know so I can tell others in the next eNewsLetter! Email: tips@learnlogos.com 
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Searching 

The Surgeon’s Search 
If you have spent any time in Logos searching for something specific than you probably have experienced the frustration 

of the two extremes: finding nothing relevant and finding too much of something! 

Well, I have a tip that you can use to avoid this problem. It is the surgeon’s search.  

Here is the search formula: 

Key Verse + Key Books + Key Word = Relevant Search Results 

Here is an example of the search: 

<bible = john 3:16> WITHIN 10 WORDS faith  

Ok, let’s break this down search formula. Note: You need to use the “Basic Search Engine”   

 <bible = john 3:16> This is the most important part of the search query. If an author has taken the time to cite a 

verse in their discussion, there is a high probability the discussion has something to do with John 3:16.  

 “faith” This is a keyword. Please notice that I did not use any words from the verse John 3:16. If I had, then my 

search results would include any book that mentioned the text of this passage. This would increase my search 

results significantly with necessarily gaining any additional insight about the verse. I chose faith, because it’s an 

idea or topic associated with the passage. This is so important. If I am looking to gain a greater insight into faith 

and its relationship to John 3:16, I need to find discussions in books that mention this as well. If the book talks 

about John 3:16 without ever mentioning faith, well I don’t want that in my search results. So choose your topic 

or related idea carefully.  

  “WITHIN 10 WORDS” First this must be all caps. Now the purpose of this phrase is keep John 3:16 and the topic 

faith in close proximity. I chose “10 words” as a good starting point. If you get too many results, choose “5 

Words”. If you get to few results, choose “20 words”.  This “proximity” is essential because if the author of a 

book is talking about “John 3:16” in one chapter and talking about “faith” in another chapter, than that author 

does not have the information I am looking for. However, if the author has joined the ideas together in close 

proximity, than it has a high probability of being very relevant to my study. 

Now you may have noticed that we have discussed key words and key verses, but what about key books? This last part 

of the search formula is equally important. I need to ask the question, where would I most likely find this information? 

For example, if I was looking for an illustration related to “John 3:16” and “faith” than I would create and search a 

collection of books of illustrations. If I wanted more scholarly insights into this passage, I would create and search 

commentaries. In fact, I would replace the English word “faith” and use the Greek word for believe “πιστεύω”. 

Click here to run the following search with your library <john 3:16> WITHIN 10 WORDS faith 

As you can see this search formula is not only precise but it is flexible. Have fun with this one! 

Email me your most helpful “surgeon’s search” to tips@learnlogos.com 

 

 

 

logos4:Search;kind=Basic;q=$3Cbible_$3D_John_3:16$3E_WITHIN_10_WORDS_faith;match=stem
mailto:tips@learnlogos.com


Book Overview & Review 

Topical Analysis of the Bible 
One of my favorite books in my digital library is the little know “Topical Analysis of the Bible”. I like it for three reasons. 

#1) It has a very detailed outline of some of the most significant topics in the Bible! 

#2) It has a plethora (fancy word for a whole bunch!) of Bible references! 

#3) It is easy to use! 

Take a look below: 

 

Click here to buy the book from Logos 
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How to Study the Bible 

12 Important Questions 
How do you interact with the Bible when you read? Years ago I learned about inductive Bible study and five important 

questions to ask the text: Who, What, Where, When, Why & How (The 5Ws and H). This helped me turn Passive Bible 

Reading into Active Bible Study. As I read each verse, I would ask these questions and then write down in a list what I 

learned from the biblical text. It revolutionized my Bible study time. 

Today, I would like to take you further. I would like to help you gain greater insight into scripture and help you organize 

better what you learn from scripture. In fact, these twelve questions can help see how one verse is related to another.  

The questions are as follows: 

12 KEY QUESTIONS 
 

# 1) What does this verse say about the scriptures? # 7) … salvation? 
# 2) … God the Father? # 8) … Israel? 
# 3) … God the Son (Jesus Christ)? # 9) … Church? 
# 4) ... God the Holy Spirit? #10) … Angels? 
# 5) … man? #11) …Demons? 
# 6) … sin? #12) ..end times/yet to be fulfilled prophecy? 
 

So let me give you an example of how this works: 

Ephesians 2:1 (NAS) 1 And you were dead in your trespasses and sins, 

Man: Because man is spiritually dead, he sins and trespasses 

This technique will not only help you see clearly these great themes of the Bible, but you will see how these doctrines 

are important to understanding the Bible. 

 

  



Prayer 

Integrating Prayer into Bible Study 
A unique role that prayer can play in your Bible study is asking God to illuminate your mind. I chose the word illuminate 

specifically because God does not audibly speak directly to His people today. Through the written Word and the Holy 

Spirit’s help, we can gain insight into the scriptures, but we must ask.  

Therefore, using the prayer list tool, I suggest that when you read the text for the first time, and questions about the 

text come to mind, write those down and place them in the prayer list. Then before you study, lift up these questions to 

the Father and ask him to help you find the answers to these questions to your study.  

Here are some example prayers that I have used in the past: 

 Lord, I am really stuck in understanding Ephesians 2:1-3, why does Paul bring up their past? 

 Father, what is the connection between Philippians 2:1-3 and Philippians 4-13? 

Now after you prayer, be on alert for the answer!  

By the way, keep those questions for teaching and preaching, they are very useful in introducing the text to your 

audience. More often than not, they are asking the same questions.  

 

  



How to Preach 

Clarity 
Many students and preachers ask me, what is the most important aspect of preaching and/or teaching? At first blush, 

this is a hard question to answer, because there are so many elements that go into preaching. Such as, character and 

lifestyle of the preacher, preparation and study time, presentation style, the text chosen, etc. But when you step back 

from it all, there is one aspect of preaching that if missing, the sermon and/or the lesson would utterly fail. That aspect is 

clarity. 

When I raise the issue of clarity, what I am referring to is are you making the Bible clear to the listener. Are you 

explaining the text so that they can understand its meaning? As I listen to preachers today, there is more confusion than 

clarity in the pulpit. They are clear to understand, but they don’t clearly explain the text and that difference will result in 

a congregation that will grow in the grace and knowledge of the truth or become undiscerning.  

The scriptures are clear, and it is the responsibility of the preacher to make it clear to the audience. Furthermore, the 

Holy Spirit is not limited by man, but it can do a greater work when the Bible is speaking rather than man is speaking. 

I believe the most significant way to improve the clarity of your message is to get an outline rooted in the biblical text. 

In my training videos, I have a video that shows you how to create a clear outline from the Biblical text: 

1. Best Practices (Supplemental CD)  

o Lesson 5 Observing the Text, Exercise 6 – Identifying Key Ideas/Clauses with the Text (6 Minutes) 

 

  



Q & A / Questions & Answers 

Sentence Diagramming/Structuring 
Question: 

 How do I change the default text size for all my books? 

Answer: 

There are actually two ways.  

o First, you change the zoom or program scaling. This literally will make everything bigger or small.  

Tools > Program Settings > Accessibility > Program Scaling > You choose the % 

o Second, you can change the text or font size of the all books, everything else remains the same.  

Tools > Program Settings > Accessibility > Default Text Size > You choose the % 

Email me your questions, and maybe you will be in the next newsletter! 

tips@learnlogos.com 

mailto:tips@learnlogos.com


Welcome! 
I know some of you will have great ideas to improve this format. So feel free to provide positive and negative feedback 

to me at tips@learnlogos.com 

Note: There are several types of links in this document: book links, scripture links, and more. Feel free to click on them. 

Thanks! And Enjoy 

John Fallahee 

President/CEO 

LearnLogos.com 

ALERT!!! 

1. Free Book for Logos 4: The Lexham English Bible 
Learn More/Download Now: http://www.logos.com/product/6162/lexham-english-bible 

2. Free Book for Logos 4: Gospel Coalition Foundation Documents 
Learn More/Download Now: http://www.logos.com/product/5163/gospel-coalition-foundation-documents 
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OPTIMIZING LOGOS 4 

Guides: Sights & Sounds 
Sights: You may have noticed that when you click on a link to a book/resource a flashing, orange circle will appear. I 

have found this to be a little annoying and slow the performance of the program. See instructions below. 

Sounds: I remember one elder meeting when a pastor walked in late during prayer time, then turned on his Logos 

program, and well, you can imagine what happened next! If you wish to avoid having Logos sing to your friends, family, 

and others when you least expect it, try the instructions below. 

HOW TO:  (go to the Main Menu > Tools > Program Settings) 

Sights: Next, click the circle labeled “NO” for “Show Visual Cues” 

Sounds: Next, click the circle labeled “NO” for “Play Sounds” 

 

 

 

 

 

 

 

 

 

 

 

 

 



PRAYER 

Two Must Have Books for Prayer:  
Do you remember in Luke 11:1, after Jesus finished praying to the Father, one of the disciples asked Jesus “Lord, teach 

us to pray…”? What if you could learn how to pray in such a way that others would ask you to teach them how to pray? 

Well you can get prayer training from two key books: 

 John MacArthur’s Alone with God 

This book will teach how to pray based on the Lord’s Prayer/Disciples Prayer (Matthew 6:9-13, Luke 11:1-4) 

 Kenneth Boa’s Handbook to Prayer 

This book will help you develop a habit of prayer 

HOW TO:  (File > Prayer List) 

Click here to use your prayer list in Logos 4 to record your prayers.   

logosres:nasb95;ref=BibleNASB95.Lk11.1
http://www.logos.com/product/105/alone-with-god
http://www.logos.com/product/570/handbook-to-prayer-kenneth-boa
logos4:PrayerList;title=My%20Prayer%20Journal
http://www.logos.com/product/105/alone-with-god
http://www.logos.com/product/570/handbook-to-prayer-kenneth-boa
http://www.logos.com/product/105/alone-with-god
http://www.logos.com/product/570/handbook-to-prayer-kenneth-boa


Historical Background/Theological Background 

Theology: Seeing the “Forest through the Trees” 
If you have studied the Bible for any time you know the experience of studying one passage and having related passages 

come to mind. The more you study, the more connections you will see.  

Theology books can help connect the passage you are studying to the larger Scriptural theme; in other words you can 

see the proverbial “forest through the trees”. 

So how do you use a theology book this way? I thought you would never ask! 

HOW TO:  

1) To discover the theological theme let’s open one of your theology books. I am going to use Moody’s Handbook 

of Theology. You could use any theology book from your library or even create a collection of theology books. 

2) Next, let’s open the basic search engine (Choose from the main menu, Search, then click Basic Search) and then 

type in the find box <bible = Romans 8:28>.  Click here and I will do it for you automatically. 

3) Now let’s look at the search results: 

 
4) If you look closely at the search results we can see various theological themes: Predestination, God, Grace. 

Wow! You are a theologian! Now if you click the Bible verse links in the search results, you will get more cross 

references for this theological theme! Wow! You know your Bible better! 

 

What is your favorite theological book? 

 tips@learnlogos.com 
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Outlining 

Using Syntax to Develop a Biblical Outline: Part 1 
The number one struggle that I have seen among Bible students, leaders, teachers and preachers is developing a Biblical 

outline. 

For some it can take hours or even days to figure out what the main idea and subordinate ideas are of the Biblical text. 

And even after all that effort, many are not confident that the final outline is truly reflective of the Biblical author’s 

intent. 

The next few newsletters will be devoted to making use of Syntax to develop a Biblical outline that reflects the Biblical 

author’s intent. 

HOW TO:  

The first step is to open the eBook “OpenText.org Syntactically Analyzed Greek New Testament: Clause Analysis”. 

 Go to the main menu at the top, click on the “Library” or “Book” icon 

 

 In the “find box” type “opentext” (Note: no quotes, and no space between open and text) 

 Click on the title “OpenText.org Syntactically Analyzed Greek New Testament: Clause Analysis” 

 

 Next, let’s go to the passage Matthew 28:16 by entering the passage in the bible reference box. 

 

logosres:opentextgraph;ref=BibleNA27.Mt28.16


 

 Now all these abbreviations can be maddening! Let’s turn some of these off. Here are my settings: 

 

 Now our syntax is easy to read: 

 

 Ok, are you ready for a vocabulary lesson?  

PC  you might think “politically correct” but it actually is “Primary Clause” or in simpler terms, it’s the main idea or 

main thought.   

P  is predicator or verb.  

S  is subject.  

EC  is embedded clause or a phrase inside another large phrase that further defines the phrase 

SC  is the secondary clause or a phrase dependent on another phrase and further defines the phrase 

So how does this help you make a better Biblical outline?  

Let’s look at the PC and write down the S and the P and build a preliminary “skeleton” outline. 

I. Disciples Proceeded (Matthew 28:16) 

That’s it! Wow. You may be thinking this seem way too easy! And well, you are right!  

 

 



With these syntax graphs you can more quickly identify the main idea because syntax takes into account morphology 

and grammar! Let’s do another one for practice, look at OpenText for Matthew 28:17. 

 

Now there is no S (subject) by itself, but the subject is mentioned with the P (predicator/verb). 

II. They Worshipped (Matthew 28:17a) 

III. Some Doubted (Matthew 28:17b) 

Wow! You are building an outline! Why don’t you try Matthew 28:18 on your own. Here is the solution. 

IV. Jesus Spoke (Matthew 28:18a) 

V. Authority has been given (Matthew 28:18b) 

Now let’s do one more, Matthew 28:19-20 

 

Now watch out for those embedded clauses: 

VI. Make Disciples 

a. Go 

b. Baptizing 

c. Teaching 



Can you see why I made “Make Disciples” the main verb, it’s the only P (predicator/verb) connected directly to the PC 

(primary clause/main idea). Go, Baptizing, and teaching are verbs that are connected to EC (embedded clause/phrase 

within a phrase) and therefore are subordinate to “Make Disciples”.  How many times have you heard a sermon on the 

“Great Commission” where the teacher/preacher emphasized “GO” as the most important point! Yikes! The main point 

is “Make Disciples”. Go, baptizing, and teaching define the process of “Making disciples”. 

In the next LearnLogos.com eNewsletter I will show you how to “chunk” or refine this outline further!  

If you want more in-depth training on this, get my Interactive Training Videos (see Blue Disc, Supplemental Exercises, 

Lesson 5, Exercise 6) or signup for my Distant Education Class:  

 
Click One 
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Word Study 

Bring Order to Chaos! Creating a Collection of Hebrew, Aramaic, and Greek Dictionaries 
In the last LearnLogos.com eNewsletter we searched our entire library for a Greek word. This time, let’s search a 

specialized collection of Hebrew, Aramaic, and Greek dictionaries and lexicons (note: Lexicons is just another type of 

dictionary) 

Now you may be asking, “John, why would I search a Hebrew dictionary for a Greek word or vice versa?” It may surprise 

you to know that there are Greek words in some of your Hebrew dictionaries and Hebrew words in your Greek 

dictionaries. And when that happens, it will help you find even more information about a word, plus you can build a 

bridge between the OT and NT. 

So let’s get at it: 

HOW TO:  

 Go to the main menu and choose “Tools”, and then choose “Collections” from the menu 

 

 Now you are confronted with a seemingly complex screen, but with a little help, you will master this tool!  

 

 Click in the box labeled “Unnamed Collection” and type the following: Hebrew-Greek Dictionaries 

 In the box labeled “Rule”, type the following: type:lexicon 



Note: Rules are amazing! As you can see, by using a special field called “type” and using the special keyword “lexicon”, 

all of the dictionaries and lexicons appeared in the list. We don’t have to find and manually name every Hebrew, 

Aramaic, and Greek dictionary! That saves time and is more accurate. An additional benefit of rules is that when you add 

books to your Logos 4 library, the rules will automatically add any new dictionaries. You don’t have to update your 

collection! Now that is smart! 

So here is what my collection of dictionaries looks like: 

 

 Now let’s close this window by clicking on the “X” in the upper right corner of this collections window and remember, 

Logos 4 will automatically save this collection. 

 Now let’s search for a word using this collection.  Go to the main menu and click the search icon: 

 



 Click on “basic” at the top right of your search window 

 

 Click on “Entire Library” or whatever may be the second colored word listed 

 

 Type “Hebrew” in the “Search in Box” and click “Hebrew-Greek 

Dictionaries” collection that you created 

 

 In the “find” box, type “love” (note: do not use quotes) and press the enter key and examine the search results. 

 

Note: I clicked on the “by Book” option to view my results “by books view” 

As you can see we have Hebrew and Greek dictionaries in our results! Now you are a scholar who knows multiple 

languages! 

By the way, you can search using Hebrew and Greek words as well. 
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Illustrations/Applications 

Finding the Right Illustration 
Finding an illustration that is related to a specific passage can be difficult, but not with Logos 4. Let me show you a 

search technique I use to save time and find the best illustration connected to my passage. 

There are two steps to this process:  

(1) Create a collection of your illustrations books  

(2) Search your collection of illustrations 

HOW TO:  

 Go to the main menu and choose “Tools”, and then choose “Collections” from the menu 

 

 Click in the box labeled “Unnamed Collection” and type the following: Illustrations 

 

 In the box labeled “Rule”, type the following: title:illustration OR title:quotes 

 

 



 

 

 Here is my collection; yours will differ depending on the books in your library 

 

 Go ahead and close this window by clicking on the “x” in the upper right corner of this window 

 Let’s seach this collection. Click on the “Search” icon in the main menu 

 

 Click on “basic” at the top right of your search window 

 

 Click on “Entire Library” or whatever may be the second colored word listed 

 

  



 Type “Illustrations” in the “Search in Box” and click “Illustrations” collection that you created 

 

 In the “find” box, type “<john 14:6>” (note: do not use quotes) and press the enter key and examine the search 

results. 

 

All these illustrations cite John 14:6. Now you can go through the search results and pick the best illustration for your 

context. 

BUT WAIT! Let’s get even more specific! 

 In the “find” box, type “<john 14:16> WITHIN 10 WORDS exclusive” (note: do not use quotes) and press the enter key 

and examine the search results. 

 

Do you see how we narrowed our search results! This technique really helps when you get too many search results or 

you are looking for something very specific. 

 

 

 



Searching 

When does Jesus pray? 
Back in my seminary days, I wrote a paper on Jesus and His Pattern of Prayer. It really gave me a new and biblically 

based perspective on prayer. In order to complete this assignment I needed to find every instance where Jesus talked 

about prayer, when He prayed, and any reference to Jesus and prayer. Let me show you how Logos 4 can help you learn 

about prayer from Jesus Christ. 

 Go to the main menu and choose “Search” 

 

 At the top, right of the Search window, choose “Bible” 

  

 Now let’s make changes to the following search criteria. 

 

 Click on “All Bible Text” and choose “Search Fields” and then click the box labeled “Words of Christ” 

 

 There is no need to change the search criteria “All Passages” to search only the gospels because when you search the 

“Words of Christ” you end up only searching the Gospels and a little bit of Acts and Revelation. 

 Pick your preferred English Translation. I have chosen the ESV for this example. 

 In the find box type “pray” (note: do not include the quotes) 

 Go ahead and examine the search results so you can learn about Jesus’ pattern of Prayer. 

 

 

 

 

  



Book Overview & Review 

Roy Gingrich’s Commentaries in Outline Form (100 vols.) 
A unique resource that is available in Logos 4 is the Roy Gingrich’s Commentaries in Outline Form. It is an 

amazing set, 100 volumes for $279. However, you can buy individual books of the Bible for only $ 4.95. 

 

 

BENEFITS 

#1) One of the most detailed outlines for every book of the Bible! 

#2) It has a plethora (fancy word for a whole bunch!) of Bible references! 

#3) Very helpful for sermon outline development 

#4) Concise explanations of the Biblical text 

Take a look below: 

 

Click here to buy the book from Logos 

 

 

http://www.logos.com/product/3259/roy-gingrichs-commentaries-in-outline-form
http://www.logos.com/product/3259/roy-gingrichs-commentaries-in-outline-form


How to Study the Bible 

The most important word for Bible Study… 
When I teach and train people to study the Bible I often observe at the outset the “deer in the headlights” look. It 

happens immediately after they open their Bible and turn to their passage to study. Have you experienced this? It is an 

almost paralyzing and overwhelming feeling when you consider all that one can glean from any Biblical text. But fear 

not, there is a simple solution to avoid this pitfall.  

FOCUS ON THE VERBS!  

Surprised? Yes…that is the secret to a productive, focused, and effective Bible study. Think about it…the subject is 

connected to the action of the passage. There may be an object connected to the verb as well. Furthermore, the verb 

itself describes what is happening in the passage. Starting with the verbs as our “jump off point” we can begin to ask the 

5Ws & H questions (Who, What, Where, When, Why & How).  

Furthermore, as you study the verbs it will give you a simple and straight path through the Biblical text. And as you study 

the verbs, it will cause you to ask questions of the Biblical text that will direct your study in a productive direction rather 

than a chaotic, confusing path.  

FOCUS ON THE VERBS! 

  



Prayer 

R.E.F.L.E.C.T. ON THE GLORY OF PRAYER 
There are a lot of acronyms to guide believers through prayer: 

ACTS 
Adoration 
Confession 
Thanksgiving 
Supplication 

IOU’S 
Incline 
Open 
Unite 
Satisfy 

PRAY 
Praise 
Repent 
Ask 
Yield 

PRAISE 
Praise 
Repentance 
Adoration 
Intercession 
Supplication 
Eternal Results 

PUSH 
Pray 
Until 
Something 
Happens 

 

So you may ask, why one more? Most of these acronyms just cover the basic ideas of prayer, but don’t help you develop 

a richer, more intimate prayer life. So what does the R.E.F.L.E.C.T. acronym look like? I thought you would never ask… 

Remember the Glories of God 

Examine Your Motives and Manner 

Face Life Through Scriptures 

Love God 

Experience the Sovereignty of God 

Concern Yourself with the Kingdom 

Take Every Opportunity 

When you begin with prayer, focus first on God, not yourself! Bless Him as commanded in Psalm 103! The challenge for 

most of us in this step is we don’t know our Bible well enough to bring to mind all that God is, all that He has done, and 

all that He will do! Therefore, the purpose of this step is honor, revere, adore, and respect His great character and His 

great deeds. Praise God for who He is and what He has done! Let everything that has breath praise the Lord. Praise the 

Lord! (Psalm 150:6) 

Here are some additional ideas and Bible cross references to guide you in prayer this week as you: 

Remember the Glories of God 

A.     Desire to see the Glory of God (Exodus 33:18) 

B.     Desire for others to see the Glory of God (Ephesians 1:18) 

C.     Meditate often on the glory of God’s Character (2 Chronicles 6:14ff) 

D.     Meditate on the glory of His Works and His Written Word (Psalm 19) 

 

  

logosres:nasb95;ref=BibleNASB95.Ex33.18
logosres:nasb95;ref=BibleNASB95.Eph1.18
logosres:nasb95;ref=BibleNASB95.2Ch6.14
logosres:nasb95;ref=BibleNASB95.Ps19


How to Preach 

The Proposition, The Big Idea, the CIT… 
 

A sermon without a purpose, are words for the wind! – Anonymous 

Have you (and most likely you have) listened to more than one sermon where you have no idea why the preacher 

preached the sermon? This is unfortunately an all too common occurrence. However, believe it or not, it is a very 

avoidable condition! It requires one simple step, the proposition statement. 

The proposition is a one sentence, purpose statement. It describes for the audience what will be accomplished in the 

sermon. It will call them to act on the Biblical text. Without this purpose statement, the sermon loses its impact and 

power over the audience. The sermon turns into a lecture rather than an exhortation for change! 

The proposition has 3 parts: 

1) Overviews the key points of the message 

2) Purpose clause/Linking clause/Transition clause 

3) Implication for obedience and disobedience to the message 

Let me give you several examples: 

Tonight, let’s explore 3 foundational truths that will teach you and I how to live with the past and be 

transformed from “mess to masterpiece”.
 

I have color coded the phrases from the proposition statement with the various parts of the proposition statement. 

The proposition tells us there will be a 3 point sermon and its implication is to help us live with the past in a 

transformative way. If we apply these 3 points, we will be transformed from “mess to masterpiece” 

Let’s do another one. 

From Psalm 103, David provides us 5 critical steps in building a foundation to honor rather than dishonor God the Father 

in our worship. 

Can you see the elements more clearly now? Now you may be wondering where do you place this “proposition”. 

I recommend you place it right at the end of the introduction and before the body of the message. 

Lastly, I refine the proposition toward the end of the sermon. 

 

If you want more training on this subject, check out my training videos. I have a video lecture and two training exercises 

that will teach you how to create a proposition for your next message: 

See the Best Practices (Supplemental CD)  

o Lesson 11 Proposition/Main Idea, Lesson 1 – How to Build a Proposition/Purpose Statement 

o Two Exercises: (1) Create a Proposition (2) Examine Propositions in Sermons 

  



Q & A / Questions & Answers 

Sentence Diagramming/Structuring 
Question: 

 How do I reuse a search window so that I don’t have too many search windows open? 

Answer: 

 After you open your search window, click on the resource panel (top left of the search window). 

Click on the menu choice “Send searches here”. Please notice the check mark by the menu choice and the “red 

bulls eye” icon that appears in the resource panel. 

 

Email me your questions, and maybe you will be in the next newsletter! 

tips@learnlogos.com 

mailto:tips@learnlogos.com
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Welcome! 
I know some of you will have great ideas to improve this format. So feel free to provide positive and negative feedback 

to me at tips@learnlogos.com 

Note: There are several types of links in this document: book links, Scripture links, and more. Feel free to click on them. 

Thanks! And Enjoy 

John Fallahee 

President/CEO 

LearnLogos.com 

ALERT!!! 

Webinars for Download:  

 Preparing Sermons with Logos 4, Session 1 Only $ 4.99 

 Inductive Bible Study with Logos 4, Session 1 Only $ 4.99 

 50% Off Logos 4 Training Bundle Only $39.99  

UPCOMING LIVE WEBINARS 

 Mon, Dec. 13, 9-10 PM (ET) Inductive Bible Study with Logos 4, Session 2 

o Click Link to Signup: Notes, Prayer, Copy & Paste, Historical Background, Q & A 

 Tue, Dec. 14, 9 PM to 10 PM (ET) Studying the Bible with Logos 4, Session 2 

o Click Link to Signup: Taking Notes, Prayer, Meditation, Historical Analysis, Q&A 

 Thu, Dec. 16, 9 PM to 10 PM (ET) Preparing Sermons with Logos 4, Session 2  

o Click Link to Signup: Prayer Prep. for Teach/Preach, Keys to Historical Analysis, Q&A 

6 Free Books for Logos 4 from Thomas Nelson 
Learn More/Download Now: http://www.nelsonministryservices.com/nms/dept.asp?dept_id=5076&ref=11523 

 Note: The instructions from Thomas Nelson may be a little cumbersome and you have to install Logos 3 if you 

don’t have it installed. But if you want the following books, it might be worth the headache. 

1. KJV Bible 

2. KJV Bible Commentary 

3. Nelson’s Complete Book of Bible Maps and Charts  

4. Smith’s Bible Dictionary 

5. Enhanced Strong’s Lexicon 

6. What Does the Bible Say About 

mailto:tips@learnlogos.com
http://www.learnlogos.com/
http://www.learnlogos.com/store/
http://www.learnlogos.com/store/
http://www.learnlogos.com/store/
http://www.learnlogos.com/index.php?option=com_content&view=article&id=83:webinar-signup-december&catid=60
http://www.learnlogos.com/index.php?option=com_content&view=article&id=83:webinar-signup-december&catid=60
http://www.learnlogos.com/index.php?option=com_content&view=article&id=83:webinar-signup-december&catid=60
http://www.nelsonministryservices.com/nms/dept.asp?dept_id=5076&ref=11523
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OPTIMIZING LOGOS 4 

Extra! Extra! Read all about! 
The home page in Logos 4 is an amazing innovation. Not only does it present information in a newspaper format, but it 

displays information based on what you study and read in Logos 4. Now that is impressive and smart! 

Now when I first saw the home page as a longtime Logos 3 user, I turned it off initially – too much information, let me 

just study!...But after a while, I realized its benefits and turned it back on!  

 

The first challenge is to understand what “news articles” you have in your personalized “Logos eNewspaper”. For 

example, I have highlighted one article in orange and if you notice at the bottom of each article is the article type. 

Now you may be thinking, how many types of articles are there? Well if you click the “customize” menu option in the 

lower, left corner of the home page, you can get such a list. As you can see below, highlighted in orange are the various 

elements or “articles” you can add or subtract from your “eNewspaper”.  

Once your “customize” menu appears, you can choose to display an article by “checking” the 

box or you can remove an article by “unchecking” the box. 

Regardless of what you choose, I recommend you at least leave “Logos Blog”, “Logos Community 

Pricing”, and “Logos Pre-Pubs”. These three “articles” will keep you up-to-date on great deals 

and other important announcements. 
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PRAYER 

Help Me Pray… 
You may not realize how quickly you can find help to improve the way you pray. It begins at the home page. 

HOW TO:  

1. Type “prayer” (do not use quotes) and click the button labeled “Go” or choose “Search for Prayer” from the 

menu that appears 

 

2. Click and expand the topic section 

 

3. Under the “Look it up” section you will see all the articles in your library about the topic “prayer” 

Now there is a new feature in Logos 4 called “Search for…”. This is a really helpful tool because it further explores your 

topic. When you click on these topics, Logos will find this information in your library, helping you to pray!  
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Historical Background/Theological Background 

“History is written by the victors.” – Winston Churchill 

Choosing a good set of history books for your studies can enrich your study time; provide answers to important 

historical background questions, and frankly save time. For my Historical Background Collection, I include Bible 

Dictionaries, Bible Handbooks, Atlases, and OT/NT Surveys.   

Here a few of my favorite books: 

Anchor Yale Bible Dictionary 

Baker Encyclopedia of the Bible 

Halley's Bible Handbook 

Holman Bible Atlas 

The MacArthur Bible Handbook * Consider buying the MacArthur Life Works Collection – Great Value 

A Survey of Old Testament Introduction 

New Testament Introduction 

Jensen’s Survey OT & NT 

The Oxford Dictionary of the Christian Church, rev. ed. 

Dictionary of Deities and Demons in the Bible 

 

How do you create a collection? Check out this FREE exclusive training video for newsletter subscribers only!  

This video is from the bundle training videos at www.LearnLogos.com 

Do you have a favorite book for historical background? Email me: tips@learnlogos.com 

  

 

  

http://www.logos.com/product/1660/anchor-yale-bible-dictionary
http://www.logos.com/product/5798/baker-encyclopedia-of-the-bible
http://www.logos.com/product/5437/halleys-bible-handbook
http://www.logos.com/product/7301/holman-bible-atlas-a-complete-guide-to-the-expansive-geography-of-biblical-history
http://www.logos.com/product/2391/the-macarthur-bible-handbook
http://www.logos.com/product/8582/john-macarthur-essential-bible-study-library
http://www.logos.com/product/1157/a-survey-of-old-testament-introduction
http://www.logos.com/product/595/new-testament-introduction
http://www.logos.com/product/4500/jensens-survey-of-the-old-and-new-testament
http://www.logos.com/product/2227/the-oxford-dictionary-of-the-christian-church-rev-ed
http://www.logos.com/product/4236/dictionary-of-deities-and-demons-in-the-bible
mailto:tips@learnlogos.com
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Outlining 

Using Syntax to Develop a Biblical Outline: Part 2 
Last week we began a series devoted to making use of Syntax to develop a Biblical outline that reflects the Biblical 

author’s intent. We did this for the Greek New Testament. This week we explore the Hebrew Old Testament. 

HOW TO:  

The first step is to open the eBook “The Hebrew Bible: Andersen-Forbes Phrase Marker Analysis (0.95)”. 

 Go to the main menu at the top, click on the “Library” or “Book” icon 

 

 In the “find box” type “andersen” (Note: no quotes) 

 Click on the title “The Hebrew Bible: Andersen-Forbes Phrase Marker Analysis (0.95)”. 

 

 Next, let’s go to the passage 1 Samuel 15:22 by entering the passage in the Bible reference box. 

  

 

 

 

logosres:afsyntaxgraphs;ref=BibleBHS.1Sa15.22
logosres:afsyntaxgraphs;ref=BibleBHS.1Sa15.22
logosres:afsyntaxgraphs;ref=BibleBHS.1Sa15.22
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 Now all these abbreviations can be maddening! Let’s turn some of these off. Here are my settings: 

  

 Now our syntax is a little bit easier to read: 

 

 Ok, are you ready for a vocabulary lesson?  

CL OBLQ: Primary Clause/Main Structure, in simpler terms, it’s the main idea or main thought.   

VB GRAM: Primary Verb 

SBJ GRAM: Primary Subject 

PREP: Prepositional Phrases 

NOTE: There are numerous elements in the syntax graphs. Please consult A Systematic Glossary to the Andersen-Forbes 

Analysis of the Hebrew Bible for more information and greater detail.  

 

  

logosres:afglossary;pos=Article$3DTITLE$7CArticleLength$3D325$7CContext$3DA$250aSystemat$7COffset$3D0$7COffsetInContext$3D0$7CResource$3DLLS:AFGLOSSARY$7CVersion$3D2009-10-28T20:17:02Z
logosres:afglossary;pos=Article$3DTITLE$7CArticleLength$3D325$7CContext$3DA$250aSystemat$7COffset$3D0$7COffsetInContext$3D0$7CResource$3DLLS:AFGLOSSARY$7CVersion$3D2009-10-28T20:17:02Z
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Are you ready to start building your Biblical outline? 

STEP 1 – IDENTIFY AND GROUP EACH ‘CL OBLQ’ INTO SEPARATE PHRASES 

 Start with the “CL OBLQ” and diagram/organize these as the main points 

 Note: focus on the subjects and verbs 

 Note: Try to work along with me! 

 

Phrase #1: “Has the LORD as much delight in burnt offerings and sacrifices As in obeying the voice of the LORD?  
 

 

Phrase #2: “Behold, to obey is better than sacrifice” 

 

Phrase #3: “And to heed than the fat of rams” 

 
 

Phrase #4: “For rebellion is as the sin of divination” 
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Phrase #5: “And insubordination is as iniquity and idolatry”  

 

Phrase #6: “Because you have rejected the word of the LORD” 

 

Phrase #7: “He has also rejected you from being king” 

 

STEP 2 – IDENTIFY THE MAIN SUBJECT (SBJ GRAM) AND VERB AND BEGIN TO SIMPLIFY OUTLINE 

 Simplify the outline by identifying the main subject and the main verbal action 

 Note: focus on the subjects and verbs 

 

1. THE LORD’S DELIGHT 
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2. OBEY 
 

 
3. Heed 

 

 

4. Rebellion 
 

 

5. Insubordination 
 

 
6. You have rejected 

 

 
7. He (Lord) Rejected 
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STEP 3 – REFINE OUTLINE’S SUB-POINTS  

 Look for Sub-points: Example with prepositional phrase (PREP)  

 

1. THE LORD’S DELIGHT  
a. BURNT OFFERINGS & SACRIFICES 
b. OBEYING HIS VOICE 

 

 
 
 

2. OBEY 
a. Better than sacrifice 

 

 
3. Heed 

a. (Better is implied) than the fat of rams 
 

 

4. Rebellion 
a. Is Sin of Divination 
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5. Insubordination 
a. Is iniquity 
b. Is Idolatry 

 
6. You have rejected 

a. Word of the Lord 

 
7. He (Lord) Rejected 

a. You being king 
 

STEP 4 – REFINE OUTLINE BY GROUPING POINTS TOGETHER FOR FINAL SERMON  

1. What is the Lord’s delight? 
a. Burnt Offerings & Sacrifices? 
b. Obeying His Voice? 

2. What is the Lord’s Answer? 
b. Obedience is Better than sacrifice 
a. Heeding is (Better is implied) than the fat of rams 

3. What is the Lord Conclusion? 
a. Rebellion is Sin of Divination 
b. Insubordination is iniquity & Idolatry 

4. What is the Lord’s Punishment? 
a. Rejecting the Word of the Lord = Rejected as king 

 

That’s it! Wow. You may be thinking this seems way too easy! And well, not as easy as Greek, but close! Remember, with 

these syntax graphs you can quickly identify the main idea because syntax takes into account morphology and grammar!  

If you want more in-depth training on this, get my Interactive Training Videos (see Blue Disc, Supplemental Exercises, 

Lesson 5, and Exercise 6) or signup for my Distant Education Class:  

  
Click One 

http://www.learnlogos.com/index.php?option=com_content&view=article&id=84
http://www.learnlogos.com/index.php?option=com_content&view=article&id=78:distant-education-class-outline&catid=65
http://www.learnlogos.com/index.php?option=com_content&view=article&id=84
http://www.learnlogos.com/index.php?option=com_content&view=article&id=78:distant-education-class-outline&catid=65
http://www.learnlogos.com/index.php?option=com_content&view=article&id=84
http://www.learnlogos.com/index.php?option=com_content&view=article&id=78:distant-education-class-outline&catid=65
http://www.learnlogos.com/index.php?option=com_content&view=article&id=84
http://www.learnlogos.com/index.php?option=com_content&view=article&id=78:distant-education-class-outline&catid=65
http://www.learnlogos.com/index.php?option=com_content&view=article&id=84
http://www.learnlogos.com/index.php?option=com_content&view=article&id=78:distant-education-class-outline&catid=65
http://www.learnlogos.com/index.php?option=com_content&view=article&id=84
http://www.learnlogos.com/index.php?option=com_content&view=article&id=78:distant-education-class-outline&catid=65
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Word Study 

Perseus: Isn’t he a Greek god or hero or something? 
Actually, Perseus is a major hero from Greek mythology best known for his clever decapitation of Medusa. But the 

“Perseus” I am referring to is a database of Greek words that can help your word studies. Did you know you can access 

this amazing tool from Logos 4?  

HOW TO:  

 Let’s open the New American Standard Bible to Philippians 4:10 and right click on the word revived 

 

 Choose from the menu Lemma  

 Choose from the menu “Perseus Lookup” 

Now an internet browser will open and take you to the Perseus Website where you can explore the Greek word for 

“revive”. 

 

logosres:nasb95;ref=BibleNASB95.Php4.10
http://www.perseus.tufts.edu/hopper/morph?la=greek&l=A%29NAQA%252FLLW


 
13 

 Next click on the phrase “Word frequency statistics” 

 

This list shows you the ancient Greek texts that use the Greek Word for “Revive”. We can see one use in the New 

Testament and 3 uses in two others texts “Aeschylus, Agamemnon”.  

This tool is a great way to see how people used the Greek word outside of the New Testament, before, during and after 

the New Testament was written. 

Warning: The site can be a little difficult to navigate and find the English translations. For more training on Perseus and 

other word study tools in Logos 4, order my Interactive Training Videos below. Just click the image. 

 

 

 

 

 

 

  

http://www.learnlogos.com/index.php?option=com_content&view=article&id=84
http://www.learnlogos.com/index.php?option=com_content&view=article&id=84
http://www.learnlogos.com/index.php?option=com_content&view=article&id=84
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Illustrations/Applications 

Illustrations in the most unusual of places…  
Having a good set of books with illustrations can be useful for studying, teaching, and preaching, but illustration books 

are not the only place where you can find good illustrations. Believe it or not, devotionals are a great place to find 

illustrations. These books are especially useful because they usually have an application built right into the illustration 

and many have a key Bible verse associated with the illustration. 

To find all the devotional books in your library follow these instructions: 

HOW TO:  

 Go to the main menu at the top, click on the “Library” or “Book” icon 

 

 In the find box, type the following:   type:devotional 

 

Here are some of my favorite devotionals: 

Morning and Evening 

Tozer on the Holy Spirit 

Strength for Today 

http://www.logos.com/product/377/morning-and-evening-daily-readings
http://www.logos.com/product/5008/tozer-on-the-holy-spirit
http://www.logos.com/product/4037/strength-for-today
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Searching 

Got a question? 
If you are familiar with the Socratic Method, you’ll know that it is a method of teaching by asking questions instead of 

lecturing. 

In Logos 4, you can easily find all the questions in any book of the bible: 

 Open your favorite Bible, for this example, let’s use the ESV. 

 

 In the find box, type the following:   ESV, and then click on the title “English Standard Version” 

  

 Next, press CTRL+F on your keyboard, please notice the “find box” that appears in the upper right corner of the ESV. 

 

 Now type “?” (Note: do not type the quotes) Do you see the highlighted “question”? 

 

http://changingminds.org/techniques/questioning/socratic_questions.htm
logosres:esv;ref=BibleESV.Mk8.29
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 To find the next “question”, simply click the forward button, to see the previous “question”, simply click the 

backward button. 

 

Now at this point, you may be wondering, “John, is there a way to search the whole Bible?” Unfortunately, no…however, 

Logos does sell a book, All the Questions of the Bible for $ 4.95. 

 

 

 

 

 

  

http://www.logos.com/product/1171/all-the-questions-in-the-bible
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Book Overview & Review 

The Exhaustive Dictionary of Bible Names 
You probably did not realize you own this one! From Bible Study Library and up, you have a dictionary 

with over 3000 names! The book is 250+ pages.  

 

 

By the way, for additional books on names, click on the following books to learn more: 

    

 

BENEFITS OF THIS BOOK FOR BIBLE STUDY 

#1) Detailed definitions of every name in the Bible! 

#2) There are two appendixes: (1) The Jewish Calendar (2) The Stones in the Breastplate.   

#3) Under Jehova, you can see the various names of God.  

#4) On page 132, you have the descriptive titles of Jesus 

#5) On page 50, you read about the restorative titles of believers!  

#6) A pronunciation guide 

SEE BELOW:  

 

http://www.logos.com/product/4511/the-names-of-the-trinity-collection
http://www.logos.com/product/2252/every-name-of-god-in-the-bible
http://www.logos.com/product/7270/his-names-are-wonderful-getting-to-know-god-through-his-hebrew-names
http://www.logos.com/product/1195/his-name-is-jesus
http://www.logos.com/product/8071/intimate-moments-with-the-hebrew-names-of-god
http://www.logos.com/product/7299/thats-easy-for-you-to-say-your-quick-guide-to-pronouncing-bible-names-3rd-ed
http://www.logos.com/product/4236/dictionary-of-deities-and-demons-in-the-bible
logosres:exdctbibnm;ref=Page.p_257
logosres:exdctbibnm;ref=Page.p_259
logosres:exdctbibnm;hw=Jehovah
logosres:exdctbibnm;ref=Page.p_132;off=-93
logosres:exdctbibnm;ref=Page.p_50;off=-60
http://www.logos.com/product/4511/the-names-of-the-trinity-collection
http://www.logos.com/product/2252/every-name-of-god-in-the-bible
http://www.logos.com/product/7270/his-names-are-wonderful-getting-to-know-god-through-his-hebrew-names
http://www.logos.com/product/1195/his-name-is-jesus
http://www.logos.com/product/8071/intimate-moments-with-the-hebrew-names-of-god
http://www.logos.com/product/7299/thats-easy-for-you-to-say-your-quick-guide-to-pronouncing-bible-names-3rd-ed
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How to Study the Bible 

Observation: Making Lists 
PITFALL: Another big pitfall in studying the Bible is failing to study a topic thoroughly; in other words, failing to check 

every scripture from Genesis through Revelation. Now if this was a 100 years ago, with no computers, I could 

understand missing a few passages here and there. But today, we have Logos 4. We can search on a word, phrase, or 

topic and instantly call up every instance in seconds.  

Making lists is an effective technique that can help you in your immediate study of the Bible as well as your long term 

growth in the knowledge of the Word. 

HOW DO YOU MAKE A LIST 

Let’s search the Bible for the word “Vision”.  

HOW TO:  

 Go to the main menu at the top, click on “Search” 

 

 Next, at the right, click Bible. 

 

 In the find box, type “judgment seat” (note: include the quotes since we want to search for this phrase) 

 

 

 

 

 

 

 

 

logos4:Search;kind=Bible;q=$22judgment_seat$22;match=stem
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 Let’s now open a note file. Go to the main menu > choose File > then choose notes. 

 

 Now that the note file is open, let’s rename it to “Judgment Seat” 

 

 Let’s begin to observe the text and add what we learned to the note. Click “add note” and then type “Key Verses” in 

the first box. Then click in the second box. In the second box, we will type our notes. 

 

 So how do we observe the text? Here are some questions that I use to get started: 

6 Initial Questions 

Who…is mentioned in the text in reference to the Judgment Seat? 

What…role does this judgment seat serve in this passage? 

Where…is this judgment seat? 

When…did this take place? 

Why…is the judgment seat being discussed? 

How…is the judgment seat related to the context of this passage? 

Now keep in mind there are many more 5W & H questions to ask… 

Look for Contrasts (“but”), Purpose Statements (“for” and “so that”), and Conclusions (“therefore”). 
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12 Key Theological Questions 

Additionally, if you recall from my first newsletter, there are an additional 12 questions to ask for each of these 

passages: 

12 KEY QUESTIONS 
 

# 1) What does this verse say about the Scriptures? # 7) … salvation? 
# 2) … God the Father? # 8) … Israel? 
# 3) … God the Son (Jesus Christ)? # 9) … Church? 
# 4) ... God the Holy Spirit? #10) … Angels? 
# 5) … man? #11) …Demons? 
# 6) … sin? #12) ..end times/yet to be fulfilled prophecy? 

 

Additional Resources 

This is an excellent starting point! From here I would perform a Bible Study on all the key verbs, and other key 

words in each passage. Then I would check out Treasury of Scripture Knowledge for key Bible cross references, 

Bible dictionaries, encyclopedias, and commentaries.  

The Study Funnel 

Please notice that we started first with the Bible and then moved to books where I can find opinions of other notable 

scholars. This is what I call “The Study Funnel”. You start with the Bible first and then move to multiple sources. 

Additionally, when you move beyond the Bible, start with concise resources before moving to in-depth resources. For 

example, for a word study dictionary I would use Louw-Nida before I would use the TDNT. 

Conclusion 

This may seem like a lot of work, but as you organize this information in your notes, you will be building a wonderful, 

reusable resource that you can continue to use and develop further as you study. Imagine what a lifetime of study can 

do to bring you closer and more intimate with our Great God and Savior! 

  

logosres:tsk2008;ref=VolumePage.V_1,_p_iii
logosres:louwnida;art=title
logosres:tdnt;art=title
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How to Improve Your Prayer/Devotional/Quiet Time 

R.E.F.L.E.C.T. ON THE GLORY OF PRAYER, Part 2 
Last week we introduced the prayer acronym R.E.F.L.E.C.T. to help explore and enhance your prayer life. We began with 

Remember the Glories of God. This week we will look at “E” for Examine Your Motives and Manner 

Remember the Glories of God 

Examine Your Motives and Manner 

Face Life Through Scriptures 

Love God 

Experience the Sovereignty of God 

Concern Yourself with the Kingdom 

Take Every Opportunity 

After focusing on God and remembering the Glories of God we move to that stage in prayer were we examine our 

motives and manners. For prayer to be intimate, we have to have a right view of God and a right view of ourselves 

before God. To view ourselves correctly, we confess our sins and we examine our motives. We have to make sure we 

don’t approach God as a hypocrite. Did you know that before Jesus taught the disciples to pray in Matthew 6:9, in 

Matthew 6:5, Jesus warns them not to pray like the hypocrites? Since God is all-knowing and all-seeing, we must 

approach Him transparently, holding nothing back. 

Here are some additional ideas and Bible cross references to guide you in prayer this week as you: 

Examine Your Motives and Manner  

A.     Ways & Words (Matthew 6:5-7) 

B.     Lack of Faith & Lusts (James 4:1-3, 1 Timothy 2:1-8) 

C.     Pray for one another (James 5:16) 

D.     Pray Earnestly (James 5:17) 

E.      Ask (Matthew 7:7, Luke 11:9) 

F.      Look at the Lord’s prayer/or the Disciple’s Prayer for guidance (Matt. 6:9-13) 

G.     Watch (Colossians 4:2) 

H.     Wrong Manner & Motive (James 4:3)  

logosres:nasb95;ref=BibleNASB95.Mt6.5-7
logosres:nasb95;ref=BibleNASB95.Jas4.1-3
logosres:nasb95;ref=BibleNASB95.1Ti2.1-8
logosres:nasb95;ref=BibleNASB95.Jas5.16
logosres:nasb95;ref=BibleNASB95.Jas5.17
logosres:nasb95;ref=BibleNASB95.Mt7.7
logosres:nasb95;ref=BibleNASB95.Lk11.9
logosres:nasb95;ref=BibleNASB95.Mt6.9-13
logosres:nasb95;ref=BibleNASB95.Col4.2
logosres:nasb95;ref=BibleNASB95.Jas4.3;off=3
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How to Preach 

Let’s Transition… 
 

A sermon without proper transitions is like an intersection without stop lights! - Crash 

One rainy night, on a dark road my car approached an intersection and the lights were flashing yellow. It had been some 

time since my last road test…does the flashing yellow light mean I stop? What about the other cars, will they stop? Oh 

yeah, yellow means proceed with caution and as I transitioned through the intersection safely, I saw that they had a 

flashing red light, so they were stopped at the intersection, waiting for me to pass…safely! 

Think with me about the many transitions in a sermon. There is the introduction to the proposition, and then we drive to 

the overview of the outline, and then turn to the body. Within the body of the text, we motor through the explanation 

of the text, and then we see the illustrations, and pause at the application. Don’t forget we need to venture further and 

bring our trip to the end with the conclusion. Of course there might be other windy roads and unfamiliar landscapes as 

we add content as the spirit leads.  But remember, at each intersection, there must be some kind of transition, some 

kind of signpost to let your audience now where they are and where they are going. As passengers in your “car” they are 

listening and wondering what the destination is, when will you stop, and what they should be watching. Because your 

sermon is “audio”, they need “verbal signposts” or “verbal transitions” to assist them in navigating with you through 

your message. 

So what do these “verbal transitions” sound like? Here are my top five “verbal transition techniques”: 

1. Transition by Questioning 

a. Example: 15 Words of Hope by John MacArthur 

b. Notice at the beginning of paragraph 7 and 8, he begins with a question and then proceeds to answer 

the question to transition from one paragraph to the next. 

c. Example: But that brings up the question...How? The Apostle Paul has been talking about the ministry 

of reconciliation. 

 

2. Transition by Summarizing 

a. Example: Jesus Christ and the Law of God by John Piper 

b. Notice at the beginning of sermon he uses this device to transition from the introduction to the body. 

c. Example: I would like to sum up for you the meaning of Education for Exultation: 

  •      first, the meaning as it relates to buildings; 

  •      second, the meaning as it relates to funding; 

  •      third, the meaning as it relates to process; and 

  •      fourth, the meaning as it relates to Jesus Christ and the Law of God. 

 

3. Transition by Foreshadowing 

a. Example: The Ruler of the Waves by J.C. Ryles 

b. Notice at the beginning of the introduction this preacher prepares our transition with images. 

c. Example: Come now, and let us study together a page in our Master's history. Let us consider what we 

may learn from the verses of Scripture which stand at the head of this tract. You see Jesus there 

crossing the lake of Galilee in a boat with his disciples. You see a sudden storm arise while He is asleep. 

The waves beat into the boat, and fill it. Death seems to be close at hand. The frightened disciples 

awake their Master and cry for help. He arises and rebukes the wind and waves, and at once there is a 

http://www.gty.org/Resources/Sermons/47-39_15-Words-of-Hope
http://www.desiringgod.org/resource-library/sermons/jesus-christ-and-the-law-of-god
http://www.biblebb.com/files/ryle/ruler_of_the_waves.htm
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calm. He mildly reproves the faithless fears of his companions, and all is over. Such is the picture. It is 

one full of deep instruction. Come now, and let us examine what we are meant to learn. 

 

4. Transition by Defining 

a. Example: Affliction is Certain by Gil Rugh 

b. Notice how the preacher defines the word and transitions into an explanation. 

c. Example: Paul says he prays for the Thessalonians "earnestly." This word means "abundantly, beyond 

all measure, exceedingly, and overflowing all bounds." It is an adverb that describes something that 

goes beyond all measure. So when Paul says that he is praying "earnestly," he is indicating the intensity 

with which he prays. This word is used only two other times in the New Testament, both times by Paul. 

In Ephesians 3:20, Paul says, "Now to Him who is able to do exceeding abundantly beyond all that we 

ask or think, according to the power that works within us." We cannot grasp, with our finite minds, all 

that God can do. It is "exceeding abundantly" all that we can comprehend. This is the same concept used 

in 1 Thessalonians 3:10. Paul is praying for them more than they could comprehend. His prayers for 

them are "overflowing." Do you have anyone in your life that you are praying for "earnestly?" Is it any 

wonder that Paul's ministry was effective? 

 

5. Transition by Bridging 

a. Example: God’s Handwriting Upon David by Charles Spurgeon 

b. Notice that this preacher simply takes two ideas, the one previous and the one next up and places it in 

one sentence.  

c. Example: “And of the houses thereof,” the places where the priests and Levites dwelt. Get a clear view 

of the houses that Christ gives his people to dwell in; how they dwell in him, how they abide in him, and 

go no more out for ever. I cannot enlarge on this; but you can think it out for yourselves, and explain it 

to your hearers and scholars. Think of those mansions of present joy and future bliss which they shall 

have who come in by the true and living way, even by Christ Jesus, who is the one way of entrance into 

the temple of salvation. 

In wrapping up this topic, here are several websites that provide “transitional words and phrases”: 

http://owl.english.purdue.edu/owl/resource/574/02/ 

http://www.uark.edu/campus-resources/qwrtcntr/resources/handouts/transitions.htm 

http://www.smart-words.org/transition-words.html 

http://www.ehow.com/how_4864740_use-transitional-devices.html 

http://essays.org.uk/english/simplicity/ 

 

 

 

 

 

http://www.biblebb.com/files/gr1122.htm
http://owl.english.purdue.edu/owl/resource/574/02/
http://www.uark.edu/campus-resources/qwrtcntr/resources/handouts/transitions.htm
http://www.smart-words.org/transition-words.html
http://www.ehow.com/how_4864740_use-transitional-devices.html
http://essays.org.uk/english/simplicity/
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Q & A / Questions & Answers 

Internet Shortcuts 
Question:  How do I create a shortcut to a website (or anything else) in Logos 4? 

Answer:  Drag the website URL/Web Address to the shortcut bar in Logos 4. 

 Click on the shortcut icon associated with the web address of your internet browser and drag it to Logos 4 

  

 

 

 When you see the shortcut icon, drag to Logos 4 (Note: You can drag any shortcut to Logos 4) 

 

 Drop the shortcut on the Logos 4 shortcut bar.  

(Note: It important to have both applications in view for dragging & dropping.  

 

Email me your questions, and maybe you will be in the next newsletter! 

tips@learnlogos.com 

mailto:tips@learnlogos.com
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Merry Christmas and Happy New Year! 
I hope you like the new look of our eNewsletter.  

You can click on the colored links above and it will take you to LearnLogos.com to learn more about these training 

products.  

Note: There are other types of links in this document: book links, Scripture links, and more. Feel free to click on them. 

Thanks! And Enjoy! 

John Fallahee 

President/CEO 

LearnLogos.com 

#1 Just Released…Session 2 Webinars for Download 
 How to Study the Bible with Logos 4, Session 2 Only $ 4.99 

 Preparing Sermons with Logos 4, Session 2 Only $ 4.99 

 Inductive Bible Study with Logos 4, Session 2 Only $ 4.99 

#2 Session 1 Webinars for Download:  
 Preparing Sermons with Logos 4, Session 1 Only $ 4.99 

 Inductive Bible Study with Logos 4, Session 1 Only $ 4.99 

#3 Training CDs:  
50% Off Logos 4 Training Bundle Only $39.99  

#4 Upcoming Live Webinars – NOTE: SCHEDULE CHANGE 
 Thu, Jan. 10, 9-10 PM (ET) Inductive Bible Study with Logos 4, Session 3 

o Click to Signup: Marking up the text, Part 1, Using theology rightly, Q & A 

 Mon, Jan. 17, 9 PM to 10 PM (ET) Studying the Bible with Logos 4, Session 3 

o Click to Signup: Performing Theological Analysis/Build theological Library, Q&A 

 Tue, Jan. 24, 9 PM to 10 PM (ET) Preparing Sermons with Logos 4, Session 2  

o Click to Signup: Theology for Teaching/Preaching, Build Theological Library, Q&A 
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1 Free Bible for Logos 4 from Bible.org 
Net Bible WITHOUT NOTES 

About the NET Bible Translation: 

The New English Translation (NET) is an amazing new translation of the Bible.  It was completed by more than 25 

scholars – experts in the original biblical languages – who worked directly from the best currently available Hebrew, 

Aramaic, and Greek texts. As the first translation published free on the Internet, the NET Bible was developed for 

Ministry First ™. 

Reviews about the NET Bible: http://bible.org/article/what-others-are-saying-about-net-bible 

Download Instructions: Visit http://store.bible.org/product.asp?ProductID=251 and add to the shopping cart and check 

out. 

Note: You may need Logos 3 to be installed 

1 Free Commentary for Logos 4 from Galaxie.com 
The Minor Prophets 

About The Minor Prophets 

A short commentary on the Minor Prophets by Hampton Keathley IV. 

Download Instructions: Visit http://store.galaxie.com/product.asp?ProductID=48 and add to the shopping cart and 

check out. 

Note: You will need Logos 3 to be installed 

 

 

 

 
Click One  

http://www.learnlogos.com/index.php?option=com_content&view=article&id=84
http://www.learnlogos.com/index.php?option=com_content&view=article&id=78:distant-education-class-outline&catid=65
http://www.learnlogos.com/index.php?option=com_content&view=article&id=84
http://www.learnlogos.com/index.php?option=com_content&view=article&id=78:distant-education-class-outline&catid=65
http://bible.org/
http://bible.org/article/what-others-are-saying-about-net-bible
http://store.bible.org/product.asp?ProductID=251
http://www.galaxie.com/
http://store.galaxie.com/product.asp?ProductID=48
http://www.learnlogos.com/index.php?option=com_content&view=article&id=84
http://www.learnlogos.com/index.php?option=com_content&view=article&id=78:distant-education-class-outline&catid=65
http://www.learnlogos.com/index.php?option=com_content&view=article&id=84
http://www.learnlogos.com/index.php?option=com_content&view=article&id=78:distant-education-class-outline&catid=65
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William Shakespeare: What's in a name? That which we call a rose by any other 

name would smell as sweet… 
Shakespeare had it right when he penned these poetic musings, making the point that what matters most is not so much 

the name but what it is or what it does! But in Logos 4, the name is as important as the content, especially when you are 

trying to find your content! 

There are several “name optimizing strategies” when it comes to naming your notes, handouts, passage lists, prayer 

lists, etc. 

Strategy #1 - Integrate Bible passages into the name of your document 

i.e. Notes about the Biblical text should be named after the passage: Mark 1:1-10, John 5:10-15 

Strategy #2 – Integrate Key Words/Topics into the name of your document 

i.e. Notes about people, places, or events should use the keywords/topics that you would find in a dictionary: Jesus, 

Jerusalem, or Rapture. 

Strategy #3 – If you are taking notes from your pastor; be sure to include their name. I recommend last name and then 

first name. 

i.e. 2010-12-12 Gallaty.Robby  or Title Book Author Date (Seeing is Believing Mark 8:1-26 Gallaty.Robby 2010-12-12) 

With these three strategies you can more easily find your files and organize them. So now when you use the find box, 

just type the passage or the keyword/topic and voila! You will find it more quickly! 

 

By the way, Logos is pre-selling The Complete Works of William Shakespeare for $ 29.95. 

 

http://www.logos.com/product/6336/the-complete-works-of-william-shakespeare
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What if you could study every prayer in the Bible? 
You can with this amazing book: An Exposition on Prayer in the Bible 

 

Imagine traversing through Biblical history from Creation to Adam to the Cross, then through the early church and lastly 

peering into the prophetic future and reading the prayers of God, saints and sinners! With 3000 pages, a topical index, 

Bible introductions, Bible outlines, and alliterated teaching outlines with commentary, you will be certain to learn how 

to pray and gain fresh Biblical insights into the meaning and historical backgrounds  of these prayers. 

Tip: There are two buying options:  

Buy as one book:  $ 259.95  

Buy each book separately:  

Genesis – 2 Samuel:  $ 49.95 

1 Kings – Malachi:  $ 49.95 

Matthew – Acts: $ 49.95  

Romans – Revelation: $ 49.95 

=========================== 

Total:   $ 199.80 

Now did you catch the price difference? Apparently Logos is not aware of the savings of $60 when buying these books 

separately! I do not think anything is left out. Now that I have brought attention to this, the price may increase…buy 

now and save! 

  

http://www.logos.com/product/3440/an-exposition-on-prayer-in-the-bible
http://www.logos.com/product/3440/an-exposition-on-prayer-in-the-bible
http://www.logos.com/product/4210/an-exposition-on-prayer-in-the-bible-genesis-2-samuel
http://www.logos.com/product/4211/an-exposition-on-prayer-in-the-bible-1-kings-malachi
http://www.logos.com/product/4212/an-exposition-on-prayer-in-the-bible-matthew-acts
http://www.logos.com/product/4213/an-exposition-on-prayer-in-the-bible-romans-revelation
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Theology by the Book, Chapter, and Verse… 

Two must have book/resources: 

    

Buy Now: $ 21.95   Buy Now: $ 28.95 

Whenever you study a passage in Scripture it has a theological context and various theological themes. However, it can 

be difficult to understand the multitude of theological contexts and discover the various theological themes in one book 

of the Bible let alone all 66, especially if you have never used a theology book or studied theology systematically. 

Theologian Roy Zuck authored these two fantastic resources to save you the time and enrich your Biblical studies. 

The book is organized like your Bible, in two volumes. Nearly every book has an introduction and historical background 

section. The author summarized the theological themes in a commentary fashion with Biblical cross references.  

Additionally, each book has unique information; for example, in Genesis the author explores the covenants, whereas in 

Peter and Jude it deals with salvation and atonement. Lastly, there is a subject and person index. 

So now you may be asking, how do you use these books in Logos? 

I would use these books in one of two ways. 

1) Simply read this before I study the passage in-depth to become aware of the theological concerns of the book 

2) I would search for a verse in these books with the search engine as a collection and then read what find. 

Note: See the November newsletter or Overview Training Videos to create a collection and search for a verse in a 

collection or order your training discs by CTRL+Click on the image at the right. 

Orange Video Training Disc:  

 Beginner > Searching > Collections 

 Beginner > Searching > Searching 

 Beginner > Searching > Basic Search 

http://www.learnlogos.com/index.php?option=com_content&view=article&id=84
http://www.logos.com/product/718/a-biblical-theology-of-the-old-testament
http://www.logos.com/product/135/a-biblical-theology-of-the-new-testament
http://www.learnlogos.com/index.php?option=com_content&view=article&id=84
http://www.logos.com/product/718/a-biblical-theology-of-the-old-testament
http://www.logos.com/product/135/a-biblical-theology-of-the-new-testament
http://www.learnlogos.com/index.php?option=com_content&view=article&id=84
http://www.logos.com/product/718/a-biblical-theology-of-the-old-testament
http://www.logos.com/product/135/a-biblical-theology-of-the-new-testament
http://www.logos.com/product/718/a-biblical-theology-of-the-old-testament
http://www.logos.com/product/135/a-biblical-theology-of-the-new-testament
http://www.learnlogos.com/store/
http://www.learnlogos.com/index.php?option=com_content&view=article&id=84
http://www.logos.com/product/718/a-biblical-theology-of-the-old-testament
http://www.logos.com/product/135/a-biblical-theology-of-the-new-testament
http://www.learnlogos.com/index.php?option=com_content&view=article&id=84
http://www.logos.com/product/718/a-biblical-theology-of-the-old-testament
http://www.logos.com/product/135/a-biblical-theology-of-the-new-testament
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Parallelism: par•al•lel•ism \ˈpa-rə-ˌle-ˌli-zəm \ the quality or state of being parallel, 

repeated syntactical similarities introduced for rhetorical effect 

One of the most frequently used literary devices you will find in the Bible is parallelism. You will see this most notably in 

the Psalms and Proverbs. To find parallel passages you will need to look for truths that are side by side or where one 

idea follows another. However, be aware that the parallel thought in many cases defines, completes, emphasizes, or 

drives the reader toward a conclusion and even sometimes contrasts the idea. In summary, parallelism repeats the same 

thought in different terms. 

Here is my first example from Psalm 103:2-5. In this example, the parallel idea expands the idea of “Benefits”. There are 

six benefits: 

      2      Bless the LORD, O my soul,  

      And forget none of His benefits;  

     3       Who pardons all your iniquities, (Benefit #1) 

       Who heals all your diseases; (Benefit #2) 

     4       Who redeems your life from the pit, (Benefit #3) 

       Who crowns you with lovingkindness and compassion; (Benefit #4) 

     5       Who satisfies your years with good things, (Benefit #5) 

 So that your youth is renewed like the eagle. (Benefit #6) 

 

Here is my second example from James 4:8. Notice the repeating of the idea with additional information. 

James 4:8 Draw near to God and He will draw near to you.  

Cleanse your hands, (A) 

you sinners; (B) 

and purify your hearts, (A’) 

you double-minded. (B’) 

 

Here is my third example, Proverbs 11:1. In this example, the parallel is antithetical. That is to say, two ideas contrast 

one another to make a single point. I color coded what is paralleled and contrasted. 

Proverbs 11:1 

 1 A false balance is an abomination to the LORD,   

But a just weight is His delight. 

If you can see the parallelism in the text, then you can identify the preaching point of the passage.  This is the point you 

want to make in your teaching and preaching outline. 
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LEMMA VS. MANUSCRIPT: What is the difference? Why does it matter? 

What is the Difference? 

The lemma is the word you will find in a dictionary.  It is sometimes called the root word. 

The manuscript is the word you will find in the Hebrew or Greek Bible. These are the words written in the Bible. 

The lemma has one form, whereas the manuscript has many forms. 

For example, let’s look at Romans 4:5 But to the one who does not work, but believes in Him who justifies the ungodly, 

his faith is credited as righteousness.  

HOW TO:  

 Go to Romans 4:5 in your Bible and right click on the word justifies. Please notice the menu that appears: 

 

 At the right you can choose between lemma and manuscript. Let’s click on lemma. 

 Choose from the menu “Search this Resource”. 

 

 

 

 

logosres:nasb95;ref=BibleNASB95.Ro4.5
logosres:nasb95;ref=BibleNASB95.Ro4.5
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 Our search results show us every place in the New Testament where the Greek word/Lemma for Justify is mentioned. 

Now this report can be a bit overwhelming, so let’s click on the word Analysis at the right. 
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 See our Analysis below.  Next, click the column titled “form”. This will sort each form and group them together. Now 

that the list is sorted, you can see all the “manuscripted forms”.  

Why does it matter? 

Well, look at the column labeled “Result”. You can see how the manuscript form has been translated into English. Do 

you see all the different ways is has been translated? There are various English words for two main reasons. First, the 

translators change the word based on its morphology or parts of speech and secondly, context. This matters to help you 

more clearly understand and define the word. 

 Let’s look closer at the morphology or parts of speech. Using the horizontal scroll bar at the bottom, scroll to the right 
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 Now, at the far right you can see how the lemma/root has specific morphological attributes. These attributes: parts of 

speech, case, gender, mood, number, person, tense, and voice will determine the meaning and translation. 

 

Application: When you study a word in its context, be sure to examine its meaning in other contexts, to learn about the 

range of possible meanings. 
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A song unsung is no melody at all! 
With Logos 4, you have a new tool to help you discover amazing illustrations and applications. However, what I am 

about to show you, is not like your typical illustration or application. We are going to use Hymns to enhance your 

presentation of the truth. 

Good hymns are theologically in alignment with the Scriptures while bad hymns are not theologically accurate. So 

beware! But more importantly, the lyric of hymns are incredible word pictures that are concise in form. You won’t tell a 

story with these illustrations; instead they will serve you better as an opening to a point, closing a point, or help 

strengthen a point. 

Let me demonstrate. 

HOW TO:  

 Go to the main menu and click Guides > Passage Guide 

 

 Enter the passage John 3:16 in the Bible Reference Box 
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 Click on the section title Media Resources to expand this section and then click on the first hymn you see. 

 

 You may need to maximize the window for easier viewing. Notice the lyrics at the right. 

 

 Read all the lyrics and see which lyric is the most appropriate for your lesson. 

Note: Feel free to modernize the language of the hymn for your audience 
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Visiting Jerusalem! 
If you have the Baker Encyclopedia of the Bible or books with images then you can do an amazing search with Logos 4. 

HOW TO:  

 First, let’s open Baker Encyclopedia of the Bible by clicking on the Book icon, labeled Library. 

 

 In the find box, type the following: baker encyclopedia and click on the book title: Baker Encyclopedia of the Bible 

  

 Next, click the search icon. 

 

 Click on the book selection menu and type “Baker in the Search in” box 

 

Note: You don’t have to have the book opened in your workspace/layout to find it in the search box. The search box can 

access you whole library. 

 Next type the following in the search box: title:Jerusalem and press enter 

logosres:bkrencbib;art=title
logosres:bkrencbib;art=title
logosres:bkrencbib;art=title
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Now you may be wondering, what is a special search field? These “fields” help you find unique information in a 

resource/book more easily or help narrow your search results.   

If you are wondering what kind of fields you can search, you need to know that every book is different. In fact, some 

books have a lot of search fields while others have very few.  

Where can you find these fields? Let me show you: 

HOW TO:  

 Locate the information button at the far, top, right of your book. It looks like a circle with the letter “i" inside. 

 

 Scroll down to the Search Fields section. Click Done (at the top, right corner) when you are finished viewing. 

Note: These are the fields you can search inside the Baker Encyclopedia of the Bible. 

 

  

logosres:bkrencbib;art=title
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 Let’s search! Type in the search box title:Jerusalem and then press enter. 

 

 Examine your search results.  

 

 Let’s click the first image 
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Foundations of Evangelical Theology 
Meet Bruce Demarest and John Feinberg. These two theologians will give you the insight you 

need to understand the two most important doctrines in the Bible – God and Salvation. 

John Feinberg authored No One Like Him (879 pages) and Bruce Demarest authored The Cross 

and Salvation (544 pages).  These books are in-depth studies providing you clear explanations, 

great cross references, and arm you with the knowledge to understand and defend these truths. 

TABLE OF CONTENTS 

No One Like Him 

 

The Cross and Salvation 

 
 

SAMPLE PAGES 

  
 

PRICE:  

No One Like Him: The Doctrine of God $20 

The Cross and Salvation: The Doctrine of Salvation $15 

http://www.logos.com/product/2900/no-one-like-him-the-doctrine-of-god
http://www.logos.com/product/2952/the-cross-and-salvation-the-doctrine-of-salvation
http://www.logos.com/product/2900/no-one-like-him-the-doctrine-of-god
http://www.logos.com/product/2952/the-cross-and-salvation-the-doctrine-of-salvation
http://www.logos.com/product/2900/no-one-like-him-the-doctrine-of-god
http://www.logos.com/product/2952/the-cross-and-salvation-the-doctrine-of-salvation
http://www.logos.com/product/2900/no-one-like-him-the-doctrine-of-god
http://www.logos.com/product/2952/the-cross-and-salvation-the-doctrine-of-salvation
http://www.logos.com/product/2900/no-one-like-him-the-doctrine-of-god
http://www.logos.com/product/2952/the-cross-and-salvation-the-doctrine-of-salvation
http://www.logos.com/product/2900/no-one-like-him-the-doctrine-of-god
http://www.logos.com/product/2952/the-cross-and-salvation-the-doctrine-of-salvation
http://www.logos.com/product/2900/no-one-like-him-the-doctrine-of-god
http://www.logos.com/product/2952/the-cross-and-salvation-the-doctrine-of-salvation
http://www.logos.com/product/2900/no-one-like-him-the-doctrine-of-god
http://www.logos.com/product/2952/the-cross-and-salvation-the-doctrine-of-salvation
http://www.logos.com/product/2900/no-one-like-him-the-doctrine-of-god
http://www.logos.com/product/2952/the-cross-and-salvation-the-doctrine-of-salvation
http://www.logos.com/product/2900/no-one-like-him-the-doctrine-of-god
http://www.logos.com/product/2952/the-cross-and-salvation-the-doctrine-of-salvation
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Finding Bible Cross References 
If you can think of the scriptures as a giant chain, where each verse is connected like one chain link to another then you 

can appreciate the importance of finding the appropriate Bible cross reference.  

So how do you find the best cross reference? I am so glad you asked!  

Primer (Brief Introduction): There are three basic types of cross references you can make from any particular passage.  

#1) Cross Reference by Word: “Propitiation” 

Note: Here we searched on the word “Propitiation” and found a total of 4 places where this word is used and explained.  

 

#2) Cross Reference by Phrase: “Once for all” 

Note: Here we searched on the phrase “once for all” in reference to Jesus’ death and found 7 results, but only the first 

five speak of Jesus; “once for all” sacrifice, whereas Jude 3 & 5 are in reference to a completely different topic. 

 

#3) Cross Reference by Topic: “Martyrdom” 

Hebrews 11:37 They were stoned, they were sawn in two, they were tempted, they were put to death with the sword; 

they went about in sheepskins, in goatskins, being destitute, afflicted, ill-treated 

Key cross Reference: 1 Kings 21:10, Luke 13:34, Jn 10:31-33, Acts 7:58 

Note: These are the hardest to find because they are related topically. Use Treasury of Scripture Knowledge for to 

discover these relationships. 

 

Conclusion: When you want to introduce a Bible cross reference, always ask yourself which type of cross reference you 

want to make: word, phrase, or topic.  

Warning: Never introduce a new idea with a cross reference, always repeat the idea, or expand the idea to be clearer. 

logosres:nasb95;ref=BibleNASB95.1Ki21.10
logosres:nasb95;ref=BibleNASB95.Lk13.34
logosres:nasb95;ref=BibleNASB95.Jn10.31-33
logosres:nasb95;ref=BibleNASB95.Ac7.58
logosres:tsk2008;ref=Bible.Heb11.37
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R.E.F.L.E.C.T. ON THE GLORY OF PRAYER, Part 3 
Two weeks ago we introduced the prayer acronym R.E.F.L.E.C.T. to help explore and enhance your prayer life. We began 

with Remember the Glories of God and then explored Examine Your Motives and Manner. This week we will look at “F” 

for Face Life through Scriptures 

Remember the Glories of God 

Examine Your Motives and Manner 

Face Life through Scriptures 

Love God 

Experience the Sovereignty of God 

Concern Yourself with the Kingdom 

Take Every Opportunity 

One of the most important disciplines in the Christian life is to study the word of God and to apply it in any and every 

circumstance. This is what I mean by “Facing Life through the Scriptures”. Truly there are no circumstances in your life 

that the Word of God cannot bear itself upon. As Paul tells us in 2 Timothy 3:16, All Scripture is inspired by God and 

profitable for teaching, for reproof, for correction, for training in righteousness 17 so that the man of God may be 

adequate, equipped for every good work.  

Now you may be wondering, “John, how do I apply the scriptures to my life?” I have found help by studying the 

circumstances of the people of the Bible. I look at their obedient and disobedient behavior and learn from their life 

experience. Listed below are some amazing people with amazing circumstances as well as key passage to meditate upon 

during your prayer time this week as you: 

#3 Face Life through Scriptures 

A.     Hannah (1 Samuel 1:4-2:10) 

B.     Daniel (Daniel 2:12-23) 

C.     Hezekiah (2 Kings 22:8-23:4) 

D.     Right Thinking (Philippians 4:8) 

E.      Right Actions (Philippians 4:9-12) 

F.      Trusting (1 John 5:14) 

G.     Understanding (Hebrews 4:15) 

H.     Help (1 Corinthians 10:13) 

Note: For more on prayer, purchase my training CDs. See the ad at the right, or CTRL+Click to learn more, or visit 

www.LearnLogos.com. 

http://www.learnlogos.com/index.php?option=com_content&view=article&id=84
http://www.learnlogos.com/index.php?option=com_content&view=article&id=84
http://www.learnlogos.com/index.php?option=com_content&view=article&id=84
logosres:nasb95;ref=BibleNASB95.1Sa1.4-2.10
logosres:nasb95;ref=BibleNASB95.Da2.12-23
logosres:nasb95;ref=BibleNASB95.2Ki22.8-23.4
logosres:nasb95;ref=BibleNASB95.Php4.8
logosres:nasb95;ref=BibleNASB95.Php4.9-12
logosres:nasb95;ref=BibleNASB95.1Jn5.14
logosres:nasb95;ref=BibleNASB95.Heb4.15
logosres:nasb95;ref=BibleNASB95.1Co10.13
http://www.learnlogos.com/
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The Best Outline is the memorable outline! 
This is a true statement, but it must also be an accurate outline. In general, there are only two major types of 

Preaching/Teaching outlines: Explanation and Application. Others outlines combines these two basic forms. 

First is the “Explanation Outline”. These outlines explain the text and depending on the detail, could very well stand 

alone and need no further explanation.  These are the outlines you will find in most commentaries. Here is an example 

of the outline for Jude from the Bible Knowledge Commentary: 

I. Salutation (vv. 1-2) 
II. Warnings concerning Apostates (vv. 3-4) 
III. Warnings concerning the Peril of Apostasy (vv. 5-16) 

A. Examples of apostates in the past (vv. 5-7) 
1. Egypt (v. 5) 
2. Angels (v. 6) 
3. Sodom and Gomorrah (v. 7) 

B. Actions of apostates in the present (vv. 8-16) 
1. Rejecting authority (vv. 8-10) 
2. Walking in error (v. 11) 
3. Leading falsely (vv. 12-13) 
4. Pleasing self (vv. 14-16) 

IV. Guidelines for Avoiding Apostasy (vv. 17-23) 
A. Remembering the teaching of the apostles (vv. 17-19) 
B. Nurturing themselves (vv. 20-21) 
C. Being merciful to others (vv. 22-23) 

V. Victory over Apostasy (vv. 24-25)1 
 

The second type of outline is an “Application/Exhortation Outline”. These outlines call you to respond to the text and 

require the preacher/teacher to connect the Biblical text to the application. Here is an “Application” example modified 

from the Life Application Bible Commentary.  

 

1. Beware of False Teachers (1–16) 

2. Fight for God’s truth (17–25)2 

 

Now how do you choose between these two styles? First, always create the “Explanation” outline first. This is the easiest 

to create, and should you later decide to create an “Application” outline, you have a clearer understanding of the text 

and can properly connect the application to the text. 

                                                            
1 John F. Walvoord, Roy B. Zuck and Dallas Theological Seminary, vol. 2, The Bible Knowledge Commentary : An 

Exposition of the Scriptures (Wheaton, IL: Victor Books, 1983-), 918-19. 

2 Bruce B. Barton, 1 Peter, 2 Peter, Jude, Life application Bible commentary (Wheaton, Ill.: Tyndale House Pub., 1995), 

233. 
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Adobe flash Player Security 
Question:  John, how do I remove Adobe’s Security Warning when I play your videos 

Answer:  Change Adobe’s security setting 

 Click the button labeled “Settings” (You must be connected to the internet)  
 

 

 A web page will open with this image, click the circle labeled “Always Allow” 

 

Note: You may need to reboot your computer. 

Email me your questions, and maybe you will be in the next newsletter! 

tips@learnlogos.com 
 

mailto:tips@learnlogos.com
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Welcome to 2011! 
With a New Year comes new trials and triumphs! May you apprehend the grace and peace from God our Father and the 

Lord Jesus Christ!  

On the home front, our family has adopted 3 cats from the local shelter. You can imagine the excitement of our 3 kids!  

    

  

Note: You can click on the colored links below and it will take you to LearnLogos.com to learn more about these training 

products. There are other types of links in this document: book links, Scripture links, and more. Click on them too! 

Thanks! And Enjoy! 

John Fallahee, President/CEO LearnLogos.com 

#1 Just Released…Session 2 & 3 Webinars for Download 
Session 2 Webinars (Only $ 4.99) Session 3 Webinars (Only $ 4.99) 

How to Study the Bible with Logos 4, Session 2  How to Study the Bible with Logos 4, Session 3  

Preparing Sermons with Logos 4, Session 2  Preparing Sermons with Logos 4, Session 3 (Jan 24) 
Inductive Bible Study with Logos 4, Session 2  Inductive Bible Study with Logos 4, Session 3  

#2 Session 1 Webinars for Download:  
 Preparing Sermons with Logos 4, Session 1 Only $ 4.99 

 Inductive Bible Study with Logos 4, Session 1 Only $ 4.99 

#3 Training CDs – You can now download this training immediately! 
50% Off Logos 4 Training Bundle Only $39.99  

#4 Upcoming Live Webinars – NOTE: SCHEDULE CHANGE – See New Schedule 
 Mon, Jan. 24, 9-10 PM (ET) Preparing Sermons with Logos 4, Session 3  

o Click to Signup: Theology for Teaching/Preaching, Build Theological Library, Q&A 

 Mon, Feb. 7, 9-10 PM (ET) Inductive Bible Study with Logos 4, Session 4 

o Click to Signup: Marking up the text, Part 1, Using theology rightly, Q & A 

 Mon, Feb. 24, 9-10 PM (ET) Studying the Bible with Logos 4, Session 4 

o Click to Signup: Performing Theological Analysis/Build theological Library, Q&A 

January 2011 
Volume 4, Issue 1/2 

John Fallahee, M.B.A., M.Div.  
Your Personal Training Assistant! 
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3 Free Books for Logos 4 from www.Logos.com  

The Scripture Alphabet of Animals 

http://www.logos.com/product/365/the-scripture-alphabet-of-animals 
 

The Love Affairs of a Bibliomaniac 

http://www.logos.com/product/583/the-love-affairs-of-a-bibliomaniac 
 

Memoir and Remains of the Rev. Robert Murray McCheyne 

http://www.logos.com/mccheyne 
 

 

 

 
Click One, Click Both!  

50% Off 

Learn at 
Your Pace 
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Along those lines… 
You may have noticed lines to the right of your books. These lines inform you where you have searched, where you have 

marked your favorite locations, and places you have visited. I have marked them below in Figure 1.  Additionally, if you 

float your mouse over these lines, you can get a snapshot of the content at the bookmark, see Figure 2. 

Figure 1 

 

Figure 2 

 

(float your mouse on the line) 
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These lines can be a little distracting. So how do you turn them off?  

HOW TO:  

 Go to the main menu, and choose Tools > Program Settings 

 

 Locate Show Auto and Favorite Bookmarks and click the circle labeled No 

 

 Locate Show Search Bookmarks and click the circle labeled No  
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Biblical Cross References for Prayer Topic 
As a new believer I used this book all the time, but as the years of study passed I used it less and less. However, I was 

reminded this week how helpful of a resource New Nave’s Topical Bible still is for Bible study. 

See the sample page below from the book. Notice the table of contents at the left. But more 

importantly, look at all the Biblical cross references! Look at all the individuals listed as well.  

There are two quick ways to check this book and see if it is useful for your study. 

#1) Enter your topic in the topic box on the home page. If this book is part of the search results, 

click and read.  

 

#2 Use the Basic Search Engine and type in a bible verse or a keyword and search specifically New Nave’s Topical Bible. 

  

 

 

 

Note: <bible ~ matthew 6:9> is a special way to search for Bible verses. It will look to see if Matthew 6:9 is mentioned by 

itself and if Matthew 6:9 is mentioned within a verse range, i.e. Matthew 6:8-13 

 

logosres:newnaves;hw=Prayer
logosres:newnaves;hw=Prayer
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Where in the world? GPS for Bible Study! 

If you are like me, you have come to rely more and more on your GPS to find your way around a strange town. When we 

moved to Chattanooga, TN our GPS made the transition so easy to find my work, a place of worship, and where to eat. 

With the map feature in Logos, it’s like having a GPS to help you find those unfamiliar Biblical locations. 

HOW TO:  

 Tools > Biblical Places 

 

 

  

Other Important map features & shortcuts: 

 Measuring Distance: Hold the Ctrl key down (Win) or Cmd key down (Mac), then click on any location in the map, then 

drag your mouse to another location to display the distance between the two places. 

 Zoom In: Ctl +  Zoom Out: Ctrl – (note: scroll button works to zoom in/out) 

 Guides > Passage Guide > Enter Passage > Press enter to find maps related to a passage 
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Alliteration: al•lit•er•a•tion \ə-ˌli-tə-ˈrā-shən\ noun  (Phonetics, Part 1) 

The repetition of consonant sounds in two or more neighboring words or syllables 

After you have created your outline, it may be necessary to refine it further. One popular change to an outline is to 

alliterate. Let me you give you an example according to the definition above from James Rosscup’s Exposition on Prayer 

(click to open if you have Logos 4 and this book). I exaggerated the size and colored the alliterated letter “S” in red so 

you can more easily see the alliteration. 

I. Principles of Prayer 

a. Showcasing that is out of place (Matthew 6:5) 

b. Secrecy (Matthew 6:6) 

c. Simplicity (Matthew 6:7) 

d. Separateness (Matthew 6:8a) 

e. Sureness (Matthew 6:8b) 

This can be a tremendous aid to help your readers and listeners remember, recall and write down your outline : ) 

HOW TO:  

 So how can you easily do this in Logos 4? First, select books that can help you find words.  

There are two main books I use: 

 Webster’s Dictionary (Click this link if you have Logos 4 and this book) 

 Webster’s Thesaurus (Click this link if you have Logos 4 and this book) 

 Determine which word and consonant you will be alliterating. Let’s use a preliminary outline from Matthew 28:19 – 

the “Great Commission” 

I. Matthew 28:19-20 

o Make Disciples 

 Go 

 Baptize 

 Teach 

Let’s take the word “go” and change the word to Evangelize and let’s alliterate with the letter “E”. Note: We could have 

kept “Go” and alliterated on “G”. 

 The next step is the hardest, because we have to now find words that capture the idea behind “baptize” and “teach”. 

Let’s go to Webster’s Thesaurus and look for other word ideas. 

logosres:expprayrosscup;ref=Bible.Mt6.5;off=-565
logosres:nasb95;ref=BibleNASB95.Mt6.5
logosres:nasb95;ref=BibleNASB95.Mt6.6
logosres:nasb95;ref=BibleNASB95.Mt6.7
logosres:nasb95;ref=BibleNASB95.Mt6.8
logosres:nasb95;ref=BibleNASB95.Mt6.8
logosres:mwdict11;hw=alliteration
logosres:mwthes;hw=Bible
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 I opened the thesaurus to “baptize” and read all the entries. I see an entry for “call”. 

 

 So then I look up “call” in the thesaurus and look through all those entries. 
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 Now with a little inspiration and meditation you will think of a word, in this case let’s go with the Word “Enroll” 

How did I come up with that word? Well, the words “assemble, collect, gather, round-up, bid, invite” caught my 

attention. In this exercise, we are not only looking for words in the thesaurus but I am also thinking of words I know. I 

told you this at times can be difficult. But let’s do an easy one. (Note: See the “search section” below for an extra tip) 

 Next, we will repeat this process for “teach”. So let’s look at the entry in Webster’s Thesaurus: 

 

 This one is a lot easier, because the word is given to us, “educate”. 

So our outline is refined: 

II. Matthew 28:19-20 

o Make Disciples 

 Go Evangelize 

 Baptize Enroll 

 Teach Educate 

Remember, use this in moderation and try to avoid wasting time in making this work. Let me encourage you that if you 

practice this, it does get a whole lot easier! 
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Who will you obey? Finding all of God’s Commands easily in the Bible 
 

The mark of a disciple of Christ is seen in their fruit, in their allegiance to Christ and His Word. To follow Christ is to 

simply follow His commands. So finding, studying, and obeying His commands is key! In Logos 4, this can easily be done 

in a few steps. Let’s learn to follow Christ! 

HOW TO:  

 Go to Matthew 28:19 in your Bible and right click on the word disciples. I chose this word because it is a command. 

 Next, choose from the menu at the right Morph and then choose from the menu at the left morph search. 

  

  

logosres:nasb95;ref=BibleNASB95.Mt28.19
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 Now the search engine opens, and automatically selects Morph and performs our search. 

 

 To find all the commands of Jesus, we need to modify this search string as follows: 

1. Remove the Greek word  

2. Change the code following the @ to V??M (you can type this or only select Verb and Imperative from the list 

that may appear below. 

 

3. Let’s change which Bible books we will search. Let’s search the Gospels (Matthew – John) 

 

 

 So above we can see our search string. Press enter or click the white arrow in the blue circle to begin the search. 

Click here to run this search automatically in your Logos 4 program. 

Note: Now we have a list of all commands in the text. Go ahead and read each context carefully. 

Note:  By the way, now that you know this technique, you can simply go directly to Morph Search and type the code. 

logos4:Search;kind=Morph;q=@V$3F$3FM;match=stem
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What are some resources focused primarily on Application? 
 

There are two primary resources that organize application verse by verse. They are as follows.  

 

http://www.logos.com/product/8649/the-jon-courson-essential-bible-study-library 

 

http://www.logos.com/product/5762/the-life-application-bible-commentary 

Note:  You can learn more about these books and 130+ others on The Best Practices Training Videos. 

ORDER TODAY! 

 

 

 

 

 

So why choose these two resources?  

Let’s take a closer look (see next page) 

 

 

http://www.learnlogos.com/index.php?option=com_content&view=article&id=84
http://www.logos.com/product/8649/the-jon-courson-essential-bible-study-library
http://www.logos.com/product/5762/the-life-application-bible-commentary
http://www.learnlogos.com/index.php?option=com_content&view=article&id=84
http://www.logos.com/product/8649/the-jon-courson-essential-bible-study-library
http://www.logos.com/product/5762/the-life-application-bible-commentary
http://www.learnlogos.com/index.php?option=com_content&view=article&id=84
http://www.logos.com/product/8649/the-jon-courson-essential-bible-study-library
http://www.logos.com/product/5762/the-life-application-bible-commentary
http://www.logos.com/product/8649/the-jon-courson-essential-bible-study-library
http://www.logos.com/product/5762/the-life-application-bible-commentary
http://www.learnlogos.com/index.php?option=com_content&view=article&id=84
http://www.logos.com/product/8649/the-jon-courson-essential-bible-study-library
http://www.logos.com/product/5762/the-life-application-bible-commentary
http://www.learnlogos.com/index.php?option=com_content&view=article&id=84
http://www.logos.com/product/8649/the-jon-courson-essential-bible-study-library
http://www.logos.com/product/5762/the-life-application-bible-commentary
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 Jon Courson 

 

 Life Application Commentary 

 

 Of course there are a multitude of resources that have application such as sermon based resources like John Piper. 

 

  

http://www.logos.com/product/8601/the-john-piper-sermon-manuscript-library
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Searching by the Sounds of the Words, for beginners (Phonetics, Part 2) 

Picking up from the “Outlining Section” there is another strategy to find words for alliterating. Let’s use the Basic Search 

Engine with Webster’s phonetic spelling. 

HOW TO:  

 Choose from the main menu Search > Basic Search 

 

 Next, let’s open Webster’s Dictionary to the word “confusion”.  

 

 Next, right click on “zhən” and choose “selection”, then choose “Search this resource” 
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 Examine the search results and notice you have found every word in the dictionary that uses “tion” sound 

Note: looking at the results you may have noticed the different spellings: “sian”, “tion”, “cion”, “sion”, “ine”, etc… 

That is the power of searching “phonetically”! 

 

Now you might be asking, hey John, how do I find all the words that start with a particular sound and end with a 

particular sound or some other combination?  I am so glad you asked! But you will need to go to the Q & A Section for 

the answer. 

If you have Logos 4, click to see the Pronunciation guide in Webster for other spellings. 

 
 

 

  

logosres:mwdict11;art=pronunciationsymbols
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Study Bibles – What are they, which do you use and recommend? 
 

I did a search at www.Logos.com and here are some of the most notable Study Bibles.  

Note: you can click on each book image to learn more about each book at www.Logos.com.  

 What is a Study Bible? Answer: Many of these resources have the following in common: 

1. Concise Commentary of the whole Bible or majority of passages in scripture 

2. Background information for each book 

3. Outlines for each book 

4. Application 

5. Maps 

 Why do you use these books? Answer: They provide quick answers and insights to guide your Bible reading. 

 Which do you recommend? Answer: (1) MacArthur Study Bible (2) ESV Study Bible (3) Net Bible (4) Tom Constable 

Expository Notes on the Bible (5) Apologetics Study Bible 

     

     

     

 

 

http://www.logos.com/product/1298/the-macarthur-study-bible
http://www.logos.com/product/1187/believers-study-bible
http://www.logos.com/product/1203/nelson-study-bible
http://www.logos.com/product/1229/womans-study-bible
http://www.logos.com/product/5255/esv-study-bible-notes
http://www.logos.com/product/7683/the-reformation-study-bible
http://www.logos.com/product/6398/the-lutheran-study-bible
http://www.logos.com/product/7276/apologetics-study-bible
http://www.logos.com/product/1198/king-james-version-study-bible
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The Study Funnel 
An important concept in studying the Bible is to begin with the Bible. Before you ever open up a commentary, study 

Bible, or any other resources with the comments of men, it is crucial to commence, to begin with the Bible alone. 

But as you study, questions will arise, and having books by men and women who have studied the scriptures and have 

articulated what the Holy Spirit has illuminated to them is most helpful for you and me to glean all that we can from the 

Bible. 

Therefore, I recommend the “Study Funnel”. So what does this entail? There are two key concepts. 

First, you want to study from as few key resources as possible.  

Second, you want to move from books/resources that are concise to books/resources that are in-depth, detailed, 

thorough and academic. 

Let me give you an example in the area of word studies.  

 

 

 

Do you see that I only have a handful of key resources for doing Word Studies? Additionally, let me show you how these 

resources move from concise to in-depth in content. Here are some screen shots of excerpts from the dictionary entries 

for the word “World”:  
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As you can see, each dictionary progressively gives you more and more in-depth information.  By moving from concise to 

in-depth, it becomes easier for you to work through new and unfamiliar material. The concise resources give you an 

introductory and elemental understanding, whereas the in-depth resources provide greater detail and introduce other 

historically related information and raise interpretative issues. 

One more point, before we wrap up this section. When I first started studying the Bible, I did not know about this 

concept. I jumped into commentaries and other academic resources to soon. The result…I could not easily determine 

which commentaries where right and which were wrong. In other words, I had no anchor of truth, by which I could judge 

the new information. I needed a filter, I needed a funnel! 

So remember, choose your resources wisely, and arrange them from concise to in-depth! Study in the Funnel! 
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R.E.F.L.E.C.T. ON THE GLORY OF PRAYER, Part 4 
Three weeks ago we introduced the prayer acronym R.E.F.L.E.C.T. to help explore and enhance your prayer life. We 

began with Remember the Glories of God, Examine Your Motives and Manner, Face Life through Scriptures, and this 

week we will explore “L” for Love God. 

Remember the Glories of God 

Examine Your Motives and Manner 

Face Life through Scriptures 

Love God 

Experience the Sovereignty of God 

Concern Yourself with the Kingdom 

Take Every Opportunity 

Do you love God? How do you show it? How would you prove it? Imagine if tomorrow you were placed on the witness 

stand for the entire world to see and you had to prove you loved God! What evidence would you call forth? What 

evidence would they call forth? 

Look at the way you spend your thoughts, look at the issues you discuss, the way you spend your money and your time. 

Look at the way you pleasure or entertain yourself! This is in reality what you love.  

I don’t know if you have ever thought about what are the parts of a genuine loving relationship between you and God? 

Therefore, I have included some verses to help you love God. Keep in mind these verses are not exhaustive. 

#4 Love God 
A. Loving Truth 

a. Psalm 119:97 

b. Psalm 119:113 

c. Psalm 119:163 

B. Loving Sacrificially 

a. Romans 5:1-8 

b. Romans 8:38-39 

C. Failure to Love God 

a. Revelation 2:1-5 

D. Test: Loving Others 

a. 1 John 3:17    

E. Love toward the Body of Christ Note: For more on prayer, purchase my training CDs. See the ad above,  

a. Galatians 5:13   or CTRL+Click on the image to learn more, or visit LearnLogos.com. 

b. 2 Thessalonians 1:3 

c. Hebrews 13:1 

d. 1 Peter 1:22 

e. 1 John 3:16 

http://www.learnlogos.com/index.php?option=com_content&view=article&id=84
http://www.learnlogos.com/index.php?option=com_content&view=article&id=84
http://www.learnlogos.com/index.php?option=com_content&view=article&id=84
http://www.learnlogos.com/


 

 
21 

 

 

 

Preaching Outlines: The Expository Outline, Part 1/4 
In the next few eNewsletters we will be exploring the different structures a sermon can use to communicate the text. If 

you are preaching through an epistle with a doctrinal emphasis then I recommend the Expository Outline. 

Standard Expository Structure 

I. Introduction (Illustration, review) 

II. Proposition 

III. Overview Outline 

IV. Body 

a. Point 1 

i. Illustration or i. explanation 

ii. Explanation  ii. illustration 

iii. Application  iii. Application 

iv. Transition  iv. Transition 

b. Point 2 

c. Point 3 

V. Conclusion 

a. Review the Outline 

b. Review the proposition 

c. Final Illustration and/or Final Application 

Now an expository outline can simply review and unfold the text so that the audience is informed like a commentary, 

filling in details as you go. Another way is to “argue” your way through the text where you are proving your points with a 

final conclusion at the end. There can be theological emphasis as well as application emphasis as you journey through 

the Biblical text. 

If you are looking for examples of this structure here are some written and audio examples: 

John MacArthur 

Mark Dever 

John Piper 

http://www.gty.org/Resources/Sermons/47-39_15-Words-of-Hope
http://www.capitolhillbaptist.org/audio/2010/12/whats-most-valuable-mark-1241-44/
http://www.desiringgod.org/resource-library/sermons/gods-great-mercy-and-our-new-birth
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Searching by Sounds, Advanced techniques: (Phonetics, Part 3) 

 

Q: John, How do I search for two or more sounds? For example, let’s say I am looking for words that begin with the “K” 

sound and end with the “tion” sound? Also, how do I search on other sound combinations, like the “K” sound in the 

middle? 

A: This is a most excellent question. To do this we will have to use the “Collins Diction” instead of Webster’s Dictionary. 

For the life of me, I could not get this search to work for multiple sounds with Webster’s Dictionary. 

Here is a link for Collins Dictionary to buy from Logos. This is a “Fallahee Recommend eBook”. 

HOW TO:  

 Open the book from “My Library”. Type “Collins” in the find box and click on the book “Collins English Dictionary” 

 

 Let’s type “confusion” in the word reference box 

 

(float your mouse on the line) 

http://www.logos.com/product/3427/collins-english-dictionary-complete-and-unabridged
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 Right click on the phonetic spelling (kǝnˈfjuːʒǝn) and choose “Search this resource” 

 

 Now your results should only be your word. However, if the word you chose is part of another word you would get 

more than one result. Next, we want to delete the “phonetic” spelling we won’t search on. So in this example, let’s 

delete everything but “ʒǝn”. See image below. 

 

 Now let’s look for any word that begins with the “k” sound and end in the “tion” sound. To do this we need add the 

“k” phonetic spelling. Even though our word “confusion” begins with “c”, it’s phonetic spelling is “K”.  

Note: if you don’t know the phonetic spelling, just look up a word in the dictionary with that particular sound and 

examine the phonetic spelling. 

 So let’s type in the search box the following: k*ʒǝn and press enter or the white arrow in the blue circle. 

See below or “click here” to have me run the search in your Logos 4 program. (you need the Collins English Dictionary) 

Note: The * is called a wild card and tell the Logos search engine to find any word with 0 or more characters between 

the “K” sound and the “tion” sound. 

 

logos4:Search;kind=Basic;q=k*$CA$92$C7$9Dn;match=stem
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 Let’s examine the search results. Wow! We got back 14 results! This kind of search will really help you find 

“alliterations”.  
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 As you can imagine, the combinations of sounds you can search on are limited only by your imagination and the 

English language. 

Note: This can make rhyming real easy! Here is a result of a crazy search: words that rhyme with “ic” and “ent” sound 

from “predicament” 

 

aliquant, anticoagulant, anticonvulsant, applicant, asphyxiant, communicant, consequent, consequently, desiccant, 

excipient, excitement, expectant, expectorant, expedient, expellant, experiment, exponent, extinguishant, extravagant, 

fabricant, inconsequential, indicant, inexpedient, insignificant, intoxicant, liquefacient, lubricant, medicament, 

mendicant, microenvironment, microfilament, micronutrient, micropayment, obsequent, predicant, significant, 

subsequent, supplicant, sycophant, toxicant, urticate, vacant, vesicant 

 

Email me your questions, and maybe you will be in the next newsletter! 

tips@learnlogos.com 
 

logos4:Search;kind=Basic;q=*$C9$AAk*$C7$9Dnt*_OR_*$C7$9Dnt*$C9$AAk*;match=stem
mailto:tips@learnlogos.com


Welcome! More than a Manual… 
This issue includes 3 times more content for each section than previous eNewsletters! If you were to try each item once 

per day, you have 36 days of content! So let’s get ready to LearnLogos! 

Note: You can click on the colored links above and it will take you to LearnLogos.com to learn more about all available 

training products. There are other types of links in this document: book links, Scripture links, and more. Click on them 

too! 

Thanks! And Enjoy! 

John Fallahee, President/CEO LearnLogos.com 

RECENT NEWS 

#1 More Webinars Released! Only $ 9.99 $ 4.99 for each download. 
 Click for Details 

o Inductive Bible Study for Logos 4 – 6 Webinars Available 

o Studying the Bible with Logos 4 – 5 Webinars Available 

o Preparing Sermons with Logos 4 – 5 Webinars Available 

Note: Most webinars are 1 ½ hours in length! Amazing value! Click here to 

buy now. 

#2 Training CDs – You can now download this training 

immediately! 
50% Off Logos 4 Training Bundle Only $39.99  

#3 Upcoming Live Webinars 

NOTE: SCHEDULE CHANGE – See New Schedule 
 Mon, April 18th, 9-10:30 PM (ET) Studying the Bible with Logos 4, Session 6 

o Click to Signup: Performing Effective Word Studies, Part 2, Q&A 

 Mon, April 25, 9-10:30 PM (ET) Preparing Sermons with Logos 4, Session 6  

o Click to Signup: Performing Effective Word Studies, Part 2, Q&A 

 Mon, May 2, 9-10:30 PM (ET) Inductive Bible Study with Logos 4, Session 7 

o Click to Signup: Find cross references/Checking with Commentaries, Q &A 

Volume 5, Issue 1/2 John Fallahee, M.B.A., M.Div.  
Your Personal Training Assistant! 
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 FREE BOOK PREVIEW  
If you have Logos for your iPad, iPhone, or iPod Touch than you can get free book views. You can view the entire book 

for a limited time.  

Check it out: http://www.freebookpreview.com/ 

The Abridged Brown-Driver-Briggs Hebrew-English Lexicon of the Old Testament 
http://www.logos.com/product/677/the-abridged-brown-driver-briggs-hebrew-english-lexicon-of-the-old-testament 

 

Book of Common Prayer (1979) Sunday Lectionary 
http://www.logos.com/product/8647/book-of-common-prayer-1979-sunday-lectionary 

 

Book of Common Prayer (1979) Daily Office Lectionary 
http://www.logos.com/product/8648/book-of-common-prayer-1979-daily-office-lectionary 

 

 

 

 
Click One, Click Both!  

50% Off 

Learn at 
Your Pace 
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http://www.learnlogos.com/index.php?option=com_content&view=article&id=78:distant-education-class-outline&catid=65
http://www.freebookpreview.com/
http://www.logos.com/product/677/the-abridged-brown-driver-briggs-hebrew-english-lexicon-of-the-old-testament
http://www.logos.com/product/8647/book-of-common-prayer-1979-sunday-lectionary
http://www.logos.com/product/8648/book-of-common-prayer-1979-daily-office-lectionary
http://www.learnlogos.com/index.php?option=com_content&view=article&id=84
http://www.learnlogos.com/index.php?option=com_content&view=article&id=78:distant-education-class-outline&catid=65
http://www.learnlogos.com/index.php?option=com_content&view=article&id=84
http://www.learnlogos.com/index.php?option=com_content&view=article&id=78:distant-education-class-outline&catid=65
http://www.learnlogos.com/index.php?option=com_content&view=article&id=84
http://www.learnlogos.com/index.php?option=com_content&view=article&id=78:distant-education-class-outline&catid=65
http://www.learnlogos.com/index.php?option=com_content&view=article&id=84
http://www.learnlogos.com/index.php?option=com_content&view=article&id=78:distant-education-class-outline&catid=65
http://www.learnlogos.com/index.php?option=com_content&view=article&id=84
http://www.learnlogos.com/index.php?option=com_content&view=article&id=78:distant-education-class-outline&catid=65
http://www.learnlogos.com/index.php?option=com_content&view=article&id=84
http://www.learnlogos.com/index.php?option=com_content&view=article&id=78:distant-education-class-outline&catid=65
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      SHORTCUTS 

Shortcuts are a great way to save time and get around more quickly in the Logos program. I recommend printing this 

page out and use this as a reference sheet. 

 PC MAC 

Opens Help F1 Shift + Command + / 

Cut Ctrl + X Command + X 

Copy Ctrl + C Command + C 

Paste Ctrl + V Command + V 

Print Ctrl + P Command + P 

Undo Ctrl + Z Command + Z 

Quick Text Compare F7 F7 or FN+F7 

Quit Logos Ctrl + Q Command + Q 

Open the Find Search Box Ctrl + F Command + F 

Show Table of Contents Ctrl + Shift + C Shift + Command + C 
Show Locator Bar Ctrl + Shift + L Shift + Command + L 

Open Search Window Ctrl + Shift + S Shift + Command + S 

Open Home Page (on/off) Alt + Home Shift + Command + H 

Advanced Shortcuts 
 PC MAC 
Add Current Location to Favorites Ctrl + D Command + D 

Set Book Mark #1 (Change #) Ctrl + Shift + 1 Option + Shift + Command + 1 

Apply Highlight (select text first) Ctrl + K Command + K 

Remove Highlight (select text first) Ctrl + Shift + K Command + Shift + K 

Go to Bible Reference Box Ctrl + G Command + G 
Open Copy Verses Window Ctrl + Alt + B Option + Command + B 

Close all Panels Ctrl + W Option + Command + W 

Forward & Back  Alt + Left Arrow   |  Right Arrow Command + [     |    Command + ] 

Unique Shortcuts 
 PC MAC 

Show Library Ctrl + L Command + L 

Read Text Aloud (Start/Stop)  Ctrl + R Command + R 

Draw on Screen F8 NOT AVAILABLE 

Reading View (on/off) F11 F11 or FN+F11 
Show History Ctrl + H Command + H 

Create Reading Columns Ctrl + Shift + P Command + Shift + P 

Open Interlinear Bottom Window Ctrl + Shift + R Command + Shift + R 
 

Note: Normally (PC’s Alt = MAC’s Option, PC’s Ctrl = MAC’s Command) 
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      STILL RUNNING LOGOS 3? LEARN HOW TO IMPORT YOUR PRAYERS AND MORE! 
 

HOW TO:  

 Click inside the “command box”  

 Type the following: import all 

 Press the enter key or select “import all” from the drop down menu 

 

Note:  You have to have Logos 3 on your computer. This will import prayer lists, notes, highlighting, and favorites as well. 

Additional Commands: import delete all - deletes imported document from Logos 4 
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ARE YOU RESPONSIBLE FOR THE “PRAYER LIST”?  

PRINT OR EMAIL TO SAVE TIME! 
If you are part of a small Bible study group, Sunday school class, prayer chain, or ministry and are responsible to keep 

everyone up to date with prayer requests and praises, then utilizing Logos 4 prayer feature is a must. Let’s learn how to 

keep everyone up to date, the easy way! 

Let’s presume you read the earlier newsletters or have watched my training videos to learn how to create a prayer list 

and have entered prayers.  

Let’s organize those prayers and get them ready to print or export. I have a sample prayer list below. 

Now this particular list is my personal prayer journal. You could create one just for your small Bible study group. 

 

 

 HOW TO:  

 Press Ctrl + P (PC) or Command + P (Mac) 
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 At the right, choose your preferred options 

Note: You can print it out or you can choose to “copy to clipboard” or even save it to a document and email that as well. 
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WHAT ARE ALL THE HEBREW /GREEK WORDS ASSOCIATED 

WITH THE ENGLISH WORD “PRAY”? 
To thoroughly study prayer, it is important to know that there are several different words in the original language that 

illustrate different aspects of prayer. Years ago this task would have taken a lot of time to find the information and a lot 

of money to purchase the right kinds of books. But with Logos 4 and the Bible Word study report you can do this quickly 

and easily. Let’s learn how! 

 Open your favorite Bible to a passage that mentions prayer. For this example I will use the familiar passage on the 

Disciple’s Prayer Matthew 6:9 from the ESV translation. 

 Right mouse click on the word “pray” 

 Choose from the menu at the right “Selection            Pray” 

Note: By choosing the English word, Logos will discover all the related Hebrew & Greek Words associated with 

the English word “Prayer” 

 Choose from the menu at the left “Bible Word Study” 

 

 

 

 

logosres:esv;ref=BibleESV.Mt6.9;off=4
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 Expand the sections labeled “Hebrew Words” and “Greek Words” 

 

 Now you can click on the English word “pray” in the center and Logos will generate a comprehensive list of verses 

that mention prayer. 
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 You can also click on the other Hebrew or Greek words to generate a smaller list of verses. 

Note: Notice how the “piece of the pie” expands out. 
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BOOK REVIEW: BIBLE STUDY 
 

 
Price: $ 53.99 

 
Part of the 

Explorer’s Bible 
Study: Adult 
Curriculum  

(14 courses) 
$ 329 

 

Explorer's Bible Study on Psalms of Prayer and Praise by Burrus, Deborah is a 
30 Lesson, Comprehensive Inductive Study, guiding you through all 150 Psalms. 
113 Pages, 5 Days of work per lesson. 
 
This is a helpful resource to introduce you to the Psalms with the added benefit of helping you 
pray and praise. 
 
Introduction 

Lesson 1 Book 1 – The Genesis Section (Psalms 1–41)  

Lesson 2 Psalms 7–12 

Lesson 3 Psalms 13–18  

Lesson 4 Psalms 19–22  

Lesson 5 Psalms 23–27  

Lesson 6 Psalms 28–33  

Lesson 7 Psalms 34–37  

Lesson 8 Psalms 38–41  

Lesson 9 Book 2 – The Exodus Section (Psalms 42–72)  

Lesson 10 Psalms 48–51  

Lesson 11 Psalms 52–55  

Lesson 12 Psalms 56–59  

Lesson 13 Psalms 60–63  

Lesson 14 Psalms 64–68  

Lesson 15 Psalms 69–72  

Lesson 16 Book 3 – The Leviticus Section (Psalms 73–89)  

Lesson 17 Psalms 78–80  

Lesson 18 Psalms 81–86  

Lesson 19 Psalms 87–89  

Lesson 20 Book 4 – The Numbers Section (Psalms 90–106) Psalms 90–95  

Lesson 21 Psalms 

Lesson 22 Psalms 102–106  

Lesson 23 Book 5 – The Deuteronomy Section (Psalms 107–150) Psalms 107–110  

Lesson 24 Psalms 111–118  

Lesson 25 Psalms 119:1–64  

Lesson 26 Psalms 119:65–176  

Lesson 27 Psalms 120–134  

Lesson 28 Psalms 135–139  

Lesson 29 Psalms 140–150 

Lesson 30 Miscellaneous 

 

http://www.logos.com/product/3510/explorers-bible-study-on-psalms-of-prayer-and-praise
http://www.logos.com/product/3510/explorers-bible-study-on-psalms-of-prayer-and-praise
http://www.logos.com/product/3510/explorers-bible-study-on-psalms-of-prayer-and-praise
http://www.logos.com/product/7873/explorers-bible-study-adult-curriculum
http://www.logos.com/product/7873/explorers-bible-study-adult-curriculum
http://www.logos.com/product/7873/explorers-bible-study-adult-curriculum
http://www.logos.com/product/7873/explorers-bible-study-adult-curriculum
http://www.logos.com/Products/search?Author=Burrus%2c+Deborah
http://www.logos.com/product/3510/explorers-bible-study-on-psalms-of-prayer-and-praise
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SAMPLE PAGE 

Lesson 11, Day 1 Only 
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        THIS, THAT, AND OTHER BIBLICAL THINGS! 
When performing a background study it is so crucial not to fail to observe the smallest of facts. 

One way to prevent this is to utilize the Passage Guide, specifically the section titled, Biblical Things. 

Let’s take a look at Mark 11:12–14 in the passage guide.  

Note: If you click the verse link above, it will start the passage guide report. 

Now, the report shows us the fig tree. Let’s learn historical information about the fig tree. 

 Click on the word Fig Tree 

 

 

 

 

 

  

 

logos4:Guide;t=Passage_Guide;ref=Bible.Mk11.12-14
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 Let’s click on a dictionary link to learn about fig trees. 

Note: Mark 11:12-14 took place shortly before the Passover in the month of April. 

  

 

 Read through your dictionary and look for information about the month of March. You should observe that during 

this time a fig tree should be producing leaves. But if you look more closely, you will learn that “new leaf buds” or “tiny 

figs” are produced by the fig tree at this time. These are the size of a cherry and can be eaten. Then in April, leaves are 

produced. With this background information, we can understand why Jesus expected figs, because the leaves follow the 

fruit. What an amazing illustration for the disciples considering the previous context of the triumphant entry of the palm 

leaves. There were leaves but no fruit! 

Historical Background Principle: Keep in mind the time of the event. Additionally, study to understand any object that 

may be mentioned in the text. 

 

 

 

 



 
 

 
14 

 

 

 

HOW DID WE GET HERE? LEARNING ABOUT THOSE WHO GOT BIBLE  

DOCTRINES RIGHT AND WRONG! 
Believe it or not, it can be important to know how teachers in the past have interpreted the scriptures. Many of the 

theological debates we have today have happened before. Additionally, and in many cases, the older arguments are 

more thorough and articulate than those being used presently. This can help you understand the foundations, 

implications and frankly, the arguments better by reviewing resources like these. 

 

Title: The Dictionary of Historical Theology 
Editor: Trevor Hart 
Publisher: Paternoster 
Publication Date: 2000 
Pages: 599 
 
Here is what Logos says about this book: 
The Dictionary of Historical Theology is a major reference work designed for anyone 
interested in the history and development of Christian theology. Featuring 314 articles on 
the key figures, theological movements, and significant texts that have shaped Christian 
thought, Dictionary of Historical Theology traces the doctrinal development of Christianity 
from the early church to the present. Varying in length from 500 to 15,000 words, these 
entries treat the intellectual antecedents and descendants of the figures or schools of 
thought covered as well as their influence on the wider development of the Christian 
tradition. 
 
The 173 contributors to this dictionary are, without exception, proven experts on the 
subjects they address. Drawn from international and interdenominational circles, they tell 
the story of Christianity from a wide variety of perspectives, successfully capturing the 
great diversity of traditions that make up the Christian community today. 
 
Comprehensive in scope yet concisely written, Dictionary of Historical Theology is one of 
the most accessible and reliable single-volume compendium of Christian thought available. 

 
 

 

 
 
Baker Encyclopedia of Christian Apologetics 
Note: Not available as a stand-alone book. Click here to learn more. 
Author: Norman L. Geisler 
Publisher: Baker 
Publication Date: 1999 
Pages: 820 
 
The opus magnum of a popular Christian apologist and based on a lifetime of study, this 
comprehensive reference covers everything in apologetics from Anselm to Zen. 

 

 

http://www.logos.com/product/3072/the-dictionary-of-historical-theology
http://www.logos.com/product/8810/the-norman-l-geisler-apologetics-library
http://www.logos.com/product/3072/the-dictionary-of-historical-theology
http://www.logos.com/product/8810/the-norman-l-geisler-apologetics-library
http://www.logos.com/product/3072/the-dictionary-of-historical-theology
http://www.logos.com/product/8810/the-norman-l-geisler-apologetics-library
http://www.logos.com/product/8810/the-norman-l-geisler-apologetics-library
http://www.logos.com/product/3072/the-dictionary-of-historical-theology
http://www.logos.com/product/8810/the-norman-l-geisler-apologetics-library
http://www.logos.com/product/3072/the-dictionary-of-historical-theology
http://www.logos.com/product/8810/the-norman-l-geisler-apologetics-library
http://www.logos.com/product/3072/the-dictionary-of-historical-theology
http://www.logos.com/product/8810/the-norman-l-geisler-apologetics-library
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       TIMELINES – ANOTHER RESOURCE OFTEN OVERLOOKED. 
 

When you study any book of the Bible, it is real handy having a timeline to coincide with the events you are studying; 

especially when time and events and individuals are being mentioned rapidly or out of order. Logos 4 has several 

timeless you can access. Where are they? Let me show you! 

HOW TO:  

 Click on the library icon at the top of Logos 4 

 Type Timeline in the find box 

 Click on the timeline you are interested in viewing (I chose Old Testament Prophets) 

 

 If you click on the menu choice below, you can change the look/style of the timeline. 
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COMIC STYLE 

 

INFORMAL STYLE 

 
 

VIBRANT STYLE 
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      STRUCTURING YOUR OUTLINE AFTER YOU HAVE STUDIED YOUR PASSAGE 

I am committed to expository preaching and firmly believe that the clearest outline is an outline derived from the 

Biblical text. In my previous eNewsletters and in my CD training, I demonstrated how to determine the Biblical outline 

from the Biblical text. With that foundation, on occasion it may be appropriate to outline and organize the Biblical 

material to achieve a particular goal.  

The following book, I highly recommend for understanding your outlining options:  

 

Title: Choosing to Preach: A Comprehensive Introduction to Sermon Options and Structures 
Editor: Kenton C. Anderson 
Publisher: Zondervan 
Publication Date: 2006 
Pages: 288 
 
The author analyzes five sermon outline structures: 
    * Declarative—make an argument 
    * Pragmatic—solve a mystery 
    * Narrative—tell a story 
    * Visionary—paint a picture 
    * Integrative—sing a song 

 

 

 

 

 

  

http://www.logos.com/product/5431/choosing-to-preach
http://www.logos.com/product/5431/choosing-to-preach
http://www.logos.com/product/5431/choosing-to-preach
http://www.logos.com/product/5431/choosing-to-preach
http://www.logos.com/product/5431/choosing-to-preach
http://www.logos.com/product/5431/choosing-to-preach
http://www.logos.com/product/5431/choosing-to-preach
http://www.logos.com/product/5431/choosing-to-preach
http://www.logos.com/product/5431/choosing-to-preach
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HOW NOT TO STEAL ANOTHER’S OUTLINE  
For some reason in the Christian pulpit, Sunday school, or even small group Bible studies many, but not all use the work 

of others without giving credit publically as to the source of such information. There are diverse reasons arguing for and 

against such citations. Regardless where you stand on the issue, you can avoid the whole issue by being original in all 

that you do. However, this can be impractical at times, so how do you proceed? 

I recommend the following strategy: 

#1) First, give credit where credit is due. With Logos 4, it is real easy to compile with copying and pasting a list of 

citations. Additionally every book in Logos has the bibliographic information available within a few clicks. 

 Locate the information button at the right of any book 

 

 

 Click the copy button to capture the bibliographic information and paste into your document 

 

Note: I recommend creating a document of all your citations and posting on the web so others can see your sources. 
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HOW DO YOU CHECK YOUR OUTLINE WHEN IT IS FINISHED? 
After you have constructed your Bible outline for teaching and preaching, it is always a good idea to check multiple 

sources. Here is a list of resources from the Home Library through Platinum that have outlines you can check and refine 

against: 

Note: If you own the resources below, click the links to open the book. 

Let’s examine various outlines for Romans 4 

Note: The books below were selected because they had in-depth outlines compared to other resources 

Bible Knowledge Commentary 

Bible Reader’s Companion 

The Bible Exposition Commentary 

Holman New Testament Commentary: Romans 

The Pulpit Commentary: Romans 

Pillar Commentary: Romans 

Baker Exegetical Commentary on the NT: Romans 

Gingrich Bible Outlines on Romans 

Preaching the Word: R. Kent Hughes 

Word Biblical Commentary: Romans 

  

logosres:nasb95;ref=BibleNASB95.Ro4
logosres:bkc;ref=VolumePage.V_2,_p_438;off=902
logosres:brc;ref=Bible.Ro4.1-25
logosres:ntbec;ref=Bible.Ro4.1;off=1
logosres:hntc66ro;ref=Bible.Ro4.1-8
logosres:tpc43;art=tpc43.hom4
logosres:pntcrom;ref=Bible.Ro4.1-25
logosres:becnt66ro;ref=Bible.Ro4.1-25
logosres:gng66ro;ref=Bible.Ro3.21-5.21;off=9462
logosres:prwdrmns;ref=Page.p_89
logosres:wbc38a;ref=Bible.Ro4.25;off=6056
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        GRAMMATICAL RELATIONSHIPS: WHAT DID GOD CREATE? 
After reading Genesis Chapter 1, are you not awestruck by the amazing power and creative genius of our loving heavenly 

Father? During my reading I started to wonder what else God created and is mentioned in the scripture?  

Now you may be wondering, “How can I create a way to do this in Logos 4”! Well, this will not require a miracle nor 6 

days to accomplish, and yet you too will say “It is very good!” 

HOW TO:  

 Go to Genesis 1:1 in your favorite translation. I will use the NASB95. 

 Right click on the word created and choose lemma from the menu and then choose Bible Word Study 

 

  

logosres:nasb95;ref=BibleNASB95.Ge1.1
logosres:nasb95;ref=BibleNASB95.Ge1.1
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 Expand the section Grammatical Relationships by clicking on the black triangle at the left 

 

 The first section is titled With Subject… this list shows you every subject that is paired or connected to the word 

created. In the second section titled With Object we can see every object created. (Click more to see more of the list) 

 Let’s expand the sub-section labeled God by clicking on God.  Here we can see the Hebrew and the English and see 

what God created! 

 

Note: If you explore the list under With Object… you can learn about what was created!  
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WHEN GOD TALKS, PEOPLE LISTEN! 
You might recall, if you are old enough, the late 70’s and early 80’s advertising campaign “When E.F. Hutton speaks, 

people listen”.  This campaign was memorable, but it was not their last word. Later in their history there were scandals 

and fraud and this brokerage firm was eventually sold off.  

Well, thankfully we have a more sure word than E.F. Hutton, and with Logos we can hear again and again the Words of 

God spoken throughout the generations to guide us and encourage us today and in the days to come. 

To easily find the conversations of God, please follow along. 

HOW TO:  

 Go to Genesis 1:6 in your favorite translation. I will use the NASB95. 

 Right click on the word said and choose lemma from the menu and then choose Bible Word Study 

  

  

logosres:nasb95;ref=BibleNASB95.Ge1.6
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 Expand the section Grammatical Relationships by clicking on the black triangle at the left 

  

 In the first section titled With Subject… we see there are 612 places where God spoke and if we click more, we can 

explore further!  

Note:  You will need to explore the other words in the With Subject section in case another pronoun or other term is 

used as a substitute for Yahweh. 
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I SEARCH AND SEARCH, BUT I CAN’T FIND THE PASSAGE! HELP ME PLEASE! 
If you are like me, you have been exposed to multiple Bible translations over the years. And with the passage of time, 

memorized verses begin to fade and it becomes difficult to recall these truths precisely.  

So let me show you a great way to find that troublesome passage: 

HOW TO:  

 Go to the top of Logos, and click the magnifying glass (search button)  

 

 Choose you search criteria as pictured below and type “once for all” in the search box and press enter 

 

 Examine your search results. 

Legend: (1) Empty colored square = not found (2) Filled colored square = found (3)  do not symbol = no passage 

Note: WUESTNT is colored for multiple passages because the translation is not versified (the phrase is found RO 6:10) 
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BIBLICAL COUNSELING RESOURCES CAN BE A GREAT RESOURCE  

FOR PERSONAL GROWTH! 
There are several very practical resources in Logos Bible Software library that can guide you to a holier life, resulting in a 

more intimate relationship with God. 

One example is the Quick Scripture Reference for Counseling by John G. Kruis ($12.95 @ the Logos store) 

 

 

logosres:qsrfc;art=bitternessresentmenthate
http://www.logos.com/product/1502/quick-scripture-reference-for-counseling
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SEARCHING FOR ILLUSTRATIONS IS NOW WHOLE LOT EASIER! YEAH! 
Logos updated the passage guide to include a section titled “Illustrations”. 

HOW TO:  

 Go to the main menu > choose Guides > Passage Guide > Type Romans 8 in the Bible reference box > Press Enter and 

then locate the section below titled “Illustrations” 

 

Note: Be careful your Bible search range is not too narrow. Additionally, make sure you have a sufficient number of 

books with illustrations. 
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 Click this section to open and view the search results.  

 Let’s look at the top right of this window. There will see the default choice Tags. This is pictured below. 

 

 Let’s click on Cloud and view the image below 

Note: You can right click on this image to copy, save, or send to PowerPoint 
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 Let’s now click on List and view the results below 

 

Note:  Click on prayer to expand this section and see the links to your books 
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SEARCHING FOR APPLICATIONS IN SERMONS 
 

If you own the John Piper Sermon Collection, Charles Spurgeon Collection, Mark Driscol 10 Year Sermon Collection or 

others sermons then you have an untapped wealth of examples of preachers providing applications for the church. 

However, you might be thinking now, “Sure John, but I don’t have time to read every sermon! How can I find an 

application that is buried deep in a sermon quickly?”  

HOW TO:  

 Create a collection of all your sermons (Tools > Collections)  

*Note: We covered this in a previous eNewsletter.   

* You can also learn how with the LearnLogos.com Training CDs 

 

 Click on the Search Button at the top 

 
 Click the Basic search option 

 
 Choose your collection in the search criteria 

 
 Enter the following in the search box: <bible ~ john 4> WITHIN 30 WORDS appl* 

 

Let’s break down the search formula: 

<bible ~ john 4> This is the passage that you are studying and looking for an application 

WITHIN 30 WORDS This is your proximity criteria (try to keep this between 10 and 50) 

appl* This will tell Logos to find words that begin with appl, like apply, applying, application, etc. 

 

Conclusion: This search strategy helps us find an application in a sermon in the context of the passage you are studying. 

http://www.LearnLogos.com
http://www.LearnLogos.com
http://www.LearnLogos.com
http://www.logos.com/product/8601/the-john-piper-sermon-manuscript-library
http://www.logos.com/product/5838/the-complete-spurgeon-sermon-collection
http://www.logos.com/product/4925/mark-driscoll-sermon-archive
http://www.LearnLogos.com
http://www.LearnLogos.com
http://www.LearnLogos.com
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JUST SHOW ME! PAINT ME A PICTURE! WHAT DOES IT LOOK LIKE? 

In this day and age we have grown accustomed to seeing everything visually. But seeing through the eyes of the Biblical 

text is limited to the text, historical information, an artist, our imagination, and even the archeologist. But new to Logos 

4 is the capability to search for images. Let’s learn together how easy this can be! 

HOW TO:  

 Choose from the main menu Search > Basic Search 

 

 Next, please type #image in the find box and be sure to choose Entire Library as your collection to search 
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 Let’s examine the search results. 

 

Note: As you can see, there are too many results. Let’s narrow the search results. 
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 Next, please type #image ANDEQUALS genealogy in the find box and be sure to choose Entire Library as your 

collection to search 

 

Note: Your search results will be a whole lot less and vary depending on the resources in your library. 

 Let’s try one more. Please type #image ANDEQUALS <bible ~ matthew> in the find box and be sure to choose Entire 

Library as your collection to search 

 

Note: Here we find all images related to the book of Matthew. 

IMPORTANT: By now, you are probably wondering what other words can be used besides ‘genealogy’. Well, that’s a 

tough question because Logos offers no such list to refer to. My suggestion is to experiment, consult a Bible dictionary, 

or run the passage guide and examine the “biblical things” section for ideas. 
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                      SEARCHING FOR SCRIPTURE REFERENCES 
Learning to search for scripture references in your library, in specific collections, or even in specific books is a key skill 

you must acquire to leverage your digital library to its maximum potential.  Here is a list of different “scripture” searches 

you can perform with the Basic Search. 

HOW TO: 

Type this in the Search Box  Verse Search Results    Description  

<bible = Ephesians 2:8>  Eph. 2:8    Finds that exact passage Ephesians 2:8 

<bible = Ephesians 2:8-10> Eph. 2:8-10   Finds that exact passage Ephesians 2:8-10 

<bible ~ Ephesians 2:8-10>  Eph. 2:9, Eph. 2:1-8   Finds any passage that intersects with Eph. 2:8-10 

<bible intersect Ep 2:8-10>  Ep 2:8-3:3, Eph 1-3   Find references that intersect, especially large ranges 

<bible subset Eph 2:8-10>  Eph 2:9-10, Eph 2:8-9  All the verses found must be within the search range 

<bible superset Eph 2:8-10>  Eph 2:1-10, Eph 2:1-3  All verses found must include complete search range 

Note: The abbreviation <Ep 2:8-10> is shorthand for <bible ~ Eph 2:8-10> not <bible = Eph 2:8-10>. 
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LIST IT > SEARCH IT > FIND IT 
Here is a great way to search for a list of terms instead of using the Boolean operator ‘OR’.  

HOW TO: 

 Click Search 

 

 

 

 Click Bible at the top, right of the search window 

 

 

 

 In the find box, type (Jesus, Lord, Christ)    

Note: You could have typed the following: Jesus OR Lord OR Christ 

 
 In the find box, type (Jesus, Lord, Christ) AND believe  

Note:  You could have typed the following: (Jesus AND believe) OR (Lord and believe) OR (Christ and believe) 
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BIBLE HANDBOOKS: WHAT ARE THEY AND WHICH DO YOU USE AND 

RECOMMEND? 
 

I did a search at www.Logos.com for Bible Handbooks. Below is a list of the most notable ones.  

Note: You can click on each book image to learn more about each book at www.Logos.com.  

 What is a Bible Handbook?  

Answer: A companion resource for Bible study. They typically include the following information: 

1. Book Introduction and summary 

2. Outline of each book of the Bible 

3. Background on people, places, and events for each book of the Bible 

4. Significant teachings or doctrines found in each book of the Bible 

5. Maps and occasional charts 

 Why do you use these books? Answer: They provide quick summaries, overviews, and essential historical background 

information to grasp the very essentials of any book of the Bible. 

 Which do you recommend? Answer: (1) MacArthur Bible Handbook (2) Wilmington’s Bible Handbook (3) Holman 

Bible Handbook  

 How do Bible Handbooks differ from Study Bibles? The most significant difference between these two types of 

resources is a Bible handbook typically will not provide an expositional or verse by verse commentary.  

       

    

 

 

  

http://www.logos.com/product/1766/willmingtons-bible-handbook
http://www.logos.com/product/5437/halleys-bible-handbook
http://www.logos.com/product/1193/hayfords-bible-handbook
http://www.logos.com/product/2391/the-macarthur-bible-handbook
http://www.logos.com/product/7291/holman-bible-handbook
http://www.logos.com/product/4502/the-new-ungers-bible-handbook
http://www.logos.com/product/3093/everyday-understanding-your-bible-handbook
http://www.logos.com/product/1766/willmingtons-bible-handbook
http://www.logos.com/product/5437/halleys-bible-handbook
http://www.logos.com/product/1193/hayfords-bible-handbook
http://www.logos.com/product/2391/the-macarthur-bible-handbook
http://www.logos.com/product/7291/holman-bible-handbook
http://www.logos.com/product/4502/the-new-ungers-bible-handbook
http://www.logos.com/product/3093/everyday-understanding-your-bible-handbook
http://www.logos.com/
http://www.logos.com/
http://www.logos.com/product/1766/willmingtons-bible-handbook
http://www.logos.com/product/5437/halleys-bible-handbook
http://www.logos.com/product/1193/hayfords-bible-handbook
http://www.logos.com/product/2391/the-macarthur-bible-handbook
http://www.logos.com/product/7291/holman-bible-handbook
http://www.logos.com/product/4502/the-new-ungers-bible-handbook
http://www.logos.com/product/3093/everyday-understanding-your-bible-handbook
http://www.logos.com/product/1766/willmingtons-bible-handbook
http://www.logos.com/product/5437/halleys-bible-handbook
http://www.logos.com/product/1193/hayfords-bible-handbook
http://www.logos.com/product/2391/the-macarthur-bible-handbook
http://www.logos.com/product/7291/holman-bible-handbook
http://www.logos.com/product/4502/the-new-ungers-bible-handbook
http://www.logos.com/product/3093/everyday-understanding-your-bible-handbook
http://www.logos.com/product/1766/willmingtons-bible-handbook
http://www.logos.com/product/5437/halleys-bible-handbook
http://www.logos.com/product/1193/hayfords-bible-handbook
http://www.logos.com/product/2391/the-macarthur-bible-handbook
http://www.logos.com/product/7291/holman-bible-handbook
http://www.logos.com/product/4502/the-new-ungers-bible-handbook
http://www.logos.com/product/3093/everyday-understanding-your-bible-handbook
http://www.logos.com/product/1766/willmingtons-bible-handbook
http://www.logos.com/product/5437/halleys-bible-handbook
http://www.logos.com/product/1193/hayfords-bible-handbook
http://www.logos.com/product/2391/the-macarthur-bible-handbook
http://www.logos.com/product/7291/holman-bible-handbook
http://www.logos.com/product/4502/the-new-ungers-bible-handbook
http://www.logos.com/product/3093/everyday-understanding-your-bible-handbook
http://www.logos.com/product/1766/willmingtons-bible-handbook
http://www.logos.com/product/5437/halleys-bible-handbook
http://www.logos.com/product/1193/hayfords-bible-handbook
http://www.logos.com/product/2391/the-macarthur-bible-handbook
http://www.logos.com/product/7291/holman-bible-handbook
http://www.logos.com/product/4502/the-new-ungers-bible-handbook
http://www.logos.com/product/3093/everyday-understanding-your-bible-handbook
http://www.logos.com/product/1766/willmingtons-bible-handbook
http://www.logos.com/product/5437/halleys-bible-handbook
http://www.logos.com/product/1193/hayfords-bible-handbook
http://www.logos.com/product/2391/the-macarthur-bible-handbook
http://www.logos.com/product/7291/holman-bible-handbook
http://www.logos.com/product/4502/the-new-ungers-bible-handbook
http://www.logos.com/product/3093/everyday-understanding-your-bible-handbook
http://www.logos.com/product/1766/willmingtons-bible-handbook
http://www.logos.com/product/5437/halleys-bible-handbook
http://www.logos.com/product/1193/hayfords-bible-handbook
http://www.logos.com/product/2391/the-macarthur-bible-handbook
http://www.logos.com/product/7291/holman-bible-handbook
http://www.logos.com/product/4502/the-new-ungers-bible-handbook
http://www.logos.com/product/3093/everyday-understanding-your-bible-handbook
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LXX/SEPTUAGINT: 3 OPTIONS FOR YOUR HEBREW-GREEK STUDIES 
In Logos 4, you have access to several LXX/Septuagint Bibles. If you are not familiar with these terms (LXX/Septuagint), 

the LXX and Septuagint refer to the same book which is the complete Old Testament translated from Hebrew to Greek.  

 
 

Septuaginta : With Morphology. Stuttgart: Deutsche Bibelgesellschaft, 1996. 
Data Included: Greek Text, Greek Morphology 
 
SAMPLE:  

1 Ἐν ἀρχῇ ἐποίησεν ὁ θεὸς τὸν οὐρανὸν καὶ τὴν γῆν.  

 

Septuaginta : With Morphology. electronic ed. Stuttgart: Deutsche Bibelgesellschaft, 1979. 
Data Included: Greek Text, Hebrew Manuscript Text, Hebrew Transliteration, Hebrew Lemma Text, 
Hebrew Lemma Transliteration, Morphology, Strong’s #s 
 
SAMPLE:  

 
1   Ἐν   ἀρχῇ   ἐποίησεν   ὁ   θεὸς   • τὸν   οὐρανὸν   καὶ   • τὴν   γῆν . 

   1 ב     
 2

ית  רֵאשִׁ  
 3 בָרָא   

 
→ 

 4 ים  אֱלֹהִׁ  
 5 אֵת   6 הַ    

 7 ם  שָמַיִׁ  
 8 ו     

 9 אֵת   10 הָ    
 11 אָרֶץ   

 

   
b 

 
rē(ʾ)·šîṯ 

 
bā·rā(ʾ) 

 
  

 
ʾ
ě
lō·hîm 

 
ʾēṯ hǎ 

 
šā·mǎ·yim 

 
w 

 
ʾēṯ hā 

 
ʾā·rěṣ 

 

   
 ב

 
 ראשית

 
1 ברא   

 
  

 
 אלהים

 
1 אות   1 ה   

 
 שמים

 
 ו

 
1 אות   1 ה   

 
 ארץ

 

   
b 

 
rʾšyt 

 
brʾ 1 

 
  

 
ʾlhym 

 
ʾwt 1 h 1 

 
šmym 

 
w 

 
ʾwt 1 h 1 

 
ʾrṣ 

 

   
PB 

 
NCcSFC 

 
VqAsSM3 

 
  

 
NPDSMN 

 
PA XD 

 
NCcDMNH 

 
CC 

 
PA XD 

 
NCcSFPH 

 

   
  

 
7225 

 
1254 

 
  

 
430 

 
853   

 
8064 

 
  

 
853   

 
776 

  

 
 

 

 
 
Tan, Randall, David A. deSilva and Logos Bible Software. The Lexham Greek-English Interlinear 
Septuagint, Logos Bible Software, 2009. 
Data Included: Greek Text, Greek Transliteration, Greek Lemma Text, Greek Lemma Transliteration, 
Morphology, English glosses, English Translation. 
 
SAMPLE: 

 
Ge 1:1        

  
Ἐν   ἀρχῇ   ἐποίησεν   ὁ   θεὸς   τὸν   οὐρανὸν   καὶ   τὴν   γῆν .  

     
En 

 
archē 

 
epoiēsen 

 
ho 

 
theos 

 
ton 

 
ouranon 

 
kai 

 
tēn 

 
gēn 

 
     

ἐν 
 

ἀρχή 
 

ποιέω 
 

ὁ 
 
θεός 

 
ὁ 

 
οὐρανός 

 
καί 

 
ὁ 

 
γῆ 

 
     

en 
 

archē 
 

poieō 
 

ho 
 

theos 
 

ho 
 

ouranos 
 

kai 
 

ho 
 

gē 
 

     
P 

 
NDSF 

 
VAAI3S 

 
DNSM 

 
NNSM 

 
DASM 

 
NASM 

 
P 

 
DASF 

 
NASF 

 
     

in 
 

beginning 
 
to make, do 

 
the 

 
God 

 
the 

 
heaven 

 
and 

 
the 

 
earth, land 

 
     

In 
 
the beginning 

 
made 2 

 
— 

 
God 1 

 
the 

 
heaven 

 
and 

 
the 

 
earth. 
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BDAG: THE ELEMENTS OF AN EXCELLENT GREEK DICTIONARY 

 
If you own the BDAG lexicon (Greek Dictionary) then you have already experienced this amazing dictionary and have 

benefited immensely from its scholarship for doing Greek word studies. If you have not heard or even seen this book up 

close then look below for more information. 

Retail in Print: Amazon $ 128 CBD $ 164 

Logos Stand Alone Price: $ 150 

Logos Bundle Price with HALOT: $ 274 

Note: Included with Platinum Collection 

 

Note: If you are looking for an excellent resource for Greek Word studies, than BDAG is a must have! 

Lemma 

Various forms 

Extended 

Definition 

Formal 

Equivalent 

(glossary) 

Detail Word use 

Biblical 

References 

Non-Biblical 

Source (Greek & 

English 

Translation) 

 

 

 

http://www.amazon.com/Greek-English-Lexicon-Testament-Christian-Literature/dp/0226039331/ref=sr_1_1?ie=UTF8&qid=1301711858&sr=8-1
http://www.christianbook.com/english-lexicon-testament-early-christian-literature/walter-bauer/9780226039336/pd/39331?item_code=WW&netp_id=150720&event=ESRCN&view=details
http://www.logos.com/product/3878/a-greek-english-lexicon-of-the-new-testament-and-other-early-christian-literature-3rd-ed
http://www.logos.com/product/5228/bdag-halot-bundle
http://www.logos.com/product/3878/a-greek-english-lexicon-of-the-new-testament-and-other-early-christian-literature-3rd-ed
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WHAT WOULD YOU RECOMMEND? 
I get a lot of questions as to what are the best resources for studying. On the surface this seems like a simple question, 

however, when you take into account someone’s theological preferences, their level of biblical training, and goal in 

studying you can begin to understand that this requires a thoughtful answer. Therefore, in upcoming eNewsletters we 

will explore each book of the Bible and list for you the various books available to you in the Logos Bible software format. 

In the meantime, let me assist you in your book selection process by recommend the following resources: 

 

 

These books include lists, descriptions and comments on a variety of books for Bible study and can be a great help in 

your book buying process. 

Here is a sample: 

Commentaries for Biblical Expositors by Jim Rosscup 

 

http://www.logos.com/product/6259/commentaries-for-biblical-expositors
http://www.logos.com/product/2832/an-introductory-bibliography-for-the-study-of-scripture
http://www.logos.com/product/5105/multipurpose-tools-for-bible-study
http://www.logos.com/product/5382/a-basic-bibliographic-guide-for-new-testament-exegesis-2nd-ed
http://www.logos.com/product/7351/tools-for-preaching-and-teaching-the-bible-2nd-ed
http://www.logos.com/product/6259/commentaries-for-biblical-expositors
http://www.logos.com/product/2832/an-introductory-bibliography-for-the-study-of-scripture
http://www.logos.com/product/5105/multipurpose-tools-for-bible-study
http://www.logos.com/product/5382/a-basic-bibliographic-guide-for-new-testament-exegesis-2nd-ed
http://www.logos.com/product/7351/tools-for-preaching-and-teaching-the-bible-2nd-ed
http://www.logos.com/product/6259/commentaries-for-biblical-expositors
http://www.logos.com/product/2832/an-introductory-bibliography-for-the-study-of-scripture
http://www.logos.com/product/5105/multipurpose-tools-for-bible-study
http://www.logos.com/product/5382/a-basic-bibliographic-guide-for-new-testament-exegesis-2nd-ed
http://www.logos.com/product/7351/tools-for-preaching-and-teaching-the-bible-2nd-ed
http://www.logos.com/product/6259/commentaries-for-biblical-expositors
http://www.logos.com/product/2832/an-introductory-bibliography-for-the-study-of-scripture
http://www.logos.com/product/5105/multipurpose-tools-for-bible-study
http://www.logos.com/product/5382/a-basic-bibliographic-guide-for-new-testament-exegesis-2nd-ed
http://www.logos.com/product/7351/tools-for-preaching-and-teaching-the-bible-2nd-ed
http://www.logos.com/product/6259/commentaries-for-biblical-expositors
http://www.logos.com/product/2832/an-introductory-bibliography-for-the-study-of-scripture
http://www.logos.com/product/5105/multipurpose-tools-for-bible-study
http://www.logos.com/product/5382/a-basic-bibliographic-guide-for-new-testament-exegesis-2nd-ed
http://www.logos.com/product/7351/tools-for-preaching-and-teaching-the-bible-2nd-ed
http://www.logos.com/product/6259/commentaries-for-biblical-expositors
http://www.logos.com/product/2832/an-introductory-bibliography-for-the-study-of-scripture
http://www.logos.com/product/5105/multipurpose-tools-for-bible-study
http://www.logos.com/product/5382/a-basic-bibliographic-guide-for-new-testament-exegesis-2nd-ed
http://www.logos.com/product/7351/tools-for-preaching-and-teaching-the-bible-2nd-ed
http://www.logos.com/product/6259/commentaries-for-biblical-expositors
http://www.logos.com/product/2832/an-introductory-bibliography-for-the-study-of-scripture
http://www.logos.com/product/5105/multipurpose-tools-for-bible-study
http://www.logos.com/product/5382/a-basic-bibliographic-guide-for-new-testament-exegesis-2nd-ed
http://www.logos.com/product/7351/tools-for-preaching-and-teaching-the-bible-2nd-ed
http://www.logos.com/product/6259/commentaries-for-biblical-expositors
http://www.logos.com/product/2832/an-introductory-bibliography-for-the-study-of-scripture
http://www.logos.com/product/5105/multipurpose-tools-for-bible-study
http://www.logos.com/product/5382/a-basic-bibliographic-guide-for-new-testament-exegesis-2nd-ed
http://www.logos.com/product/7351/tools-for-preaching-and-teaching-the-bible-2nd-ed
http://www.logos.com/product/6259/commentaries-for-biblical-expositors
http://www.logos.com/product/2832/an-introductory-bibliography-for-the-study-of-scripture
http://www.logos.com/product/5105/multipurpose-tools-for-bible-study
http://www.logos.com/product/5382/a-basic-bibliographic-guide-for-new-testament-exegesis-2nd-ed
http://www.logos.com/product/7351/tools-for-preaching-and-teaching-the-bible-2nd-ed


 
 

 
39 

 

Tools for Teaching and Preaching the Bible by Stewart Custer 

-  

Introductory Bibliography for Studying the of Scripture by Joseph Fitzmyer 
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GENESIS: WHAT RESOURCES WOULD YOU RECOMMEND? 
Note: This list is by no means exhaustive, but is intended as a guide to some of the resources available in Logos Bible 

Software. Some resources can be purchased separately while others can only be purchased with the full commentary 

set. 

Exegetical Commentaries: 

Word Biblical Commentary, Vol 1 (chapters 1-15) 

Word Biblical Commentary, Vol 2 (chapters 16-50) 

New International Commentary on the OT (chapters 1-17) 

New International Commentary on the OT (chapters 18-50) 

ICC – Genesis  

 

Expositional Commentaries: 

New American Commentary, Vol 1 (chapters 1-11) 

New American Commentary, Vol 2 (chapter 12-50) 

Preaching the Word Series: Genesis 

Pulpit Commentary: Genesis  

 

Introductory Commentaries: 

Warren Weirsbe (Be Series) Be Basic (Genesis 1-11), Be Obedient (Genesis 12-25), Be Authentic (Genesis 26-50) 

 

Create a collection of your Genesis Commentaries: 

Collection Name: Genesis Resources 

Collection Rule: subject:genesis 

Note: To create a collection: Tools > Collection 

 

 

 

 

http://www.logos.com/product/1328/word-biblical-commentary-volume-1-genesis-1-15
http://www.logos.com/product/1329/word-biblical-commentary-volume-2-genesis-16-50
http://www.logos.com/product/5185/the-new-international-commentary-on-the-old-and-new-testament#001
http://www.logos.com/product/5185/the-new-international-commentary-on-the-old-and-new-testament#001
http://www.logos.com/product/4102/a-critical-and-exegetical-commentary-on-genesis
http://www.logos.com/product/2036/the-new-american-commentary-genesis-1-11-26
http://www.logos.com/product/3323/new-american-commentary-genesis-11-27-50-26
http://www.logos.com/product/3167/genesis-beginning-and-blessing
http://www.logos.com/product/5768/the-pulpit-commentary
http://www.logos.com/product/2553/be-basic
http://www.logos.com/product/121/be-obedient
http://www.logos.com/product/2554/be-authentic
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THE GOSPELS: 4 IN 1 
Whenever you study one book of the Gospels, it is vital that you check and see if that narrative is mentioned in the other 

Gospel narratives. There are several ways to do this. 

HOW TO: 

 First, is to see if your Bible mentions the other passages. For example, the New King James Version does this: 

 

 Second, check a Harmony of the Gospel or Synopsis of the Four Gospels type of books: 

  

 

 

 

  

http://www.logos.com/product/7295/harmony-of-the-gospels
http://www.logos.com/product/7295/harmony-of-the-gospels
http://www.logos.com/product/7295/harmony-of-the-gospels
http://www.logos.com/product/7295/harmony-of-the-gospels
http://www.logos.com/product/7295/harmony-of-the-gospels
http://www.logos.com/product/7295/harmony-of-the-gospels
http://www.logos.com/product/7295/harmony-of-the-gospels
http://www.logos.com/product/7295/harmony-of-the-gospels
http://www.logos.com/product/7295/harmony-of-the-gospels
http://www.logos.com/product/7295/harmony-of-the-gospels
http://www.logos.com/product/7295/harmony-of-the-gospels
http://www.logos.com/product/7295/harmony-of-the-gospels


 
 

 
42 

 Finally, check your passage guide, specifically the Parallel Passage section 
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R.E.F.L.E.C.T. ON THE GLORY OF PRAYER, PART 5 

 
We have been working through our prayer acronym R.E.F.L.E.C.T. to help you explore and enhance your prayer life. We 

began with Remember the Glories of God, Examine Your Motives and Manner, Face Life through Scriptures, Love God 

and in this eNewsletter we will explore “E” for Experience the Sovereignty of God. 

Remember the Glories of God 

Examine Your Motives and Manner 

Face Life through Scriptures 

Love God 

Experience the Sovereignty of God 

Concern Yourself with the Kingdom 

Take Every Opportunity 

You don’t have to look far to see that the world is in trouble. Sin is wreaking havoc in the lives of those outside the 

church, and yes, even in the lives of individuals in the church. Besides trials that we can cause because of our own sin, 

there are those troubles/trials that come to each of us, those difficult seasons in life beyond our control such as disease, 

death, and various hardships that are not our fault. What can we personally do whether we are in the situation or 

someone else we love is? We persevere, we push forward, and yes we pray!  

How do we experience the sovereignty of God in prayer? Consider those who have walked before men and with God in 
circumstances that may be similar or different to your own. 
 
#5 Experience the Sovereignty of God 

A. Martyrdom: Stephen (Acts 7:54-60) 
B. Trials: Paul (2 Corinthians 11:22-33)  

C. Persecution: Loving Your Enemies (Matthew 5:44-48) 

D. War: Hezekiah facing (2 Chronicles 32:14-21)  

E. Government: Shadrach, Meshach & Abed-nego (Daniel 3:12-30) 

F. Laying Down Your Life: Christ (Matthew 26:36-44) 

G. Fear: Silent Prayer of Nehemiah (Nehemiah 1:11-2:4) 

H. Loss: Job (Job 1-2) 

Other verses to consider explore: Acts 16:25, Romans 8:28-39, 1 Corinthians 10:13, 

1 Corinthians 10:31. 

Note: For more on prayer, purchase my training CDs. See the ad above, or CTRL+Click on the image to learn more, or 

visit LearnLogos.com. 

 

http://www.LearnLogos.com
http://www.LearnLogos.com
http://www.LearnLogos.com
logosres:nasb95;ref=BibleNASB95.Ac7.54-60
logosres:nasb95;ref=BibleNASB95.2Co11.22-33
logosres:nasb95;ref=BibleNASB95.Mt5.44-48
logosres:nasb95;ref=BibleNASB95.2Ch32.14-21
logosres:nasb95;ref=BibleNASB95.Da3.12-30
logosres:nasb95;ref=BibleNASB95.Mt26.36-44
logosres:nasb95;ref=BibleNASB95.Ne1.11-2.4
logosres:nasb95;ref=BibleNASB95.Job
logosres:nasb95;ref=BibleNASB95.Ac16.25
logosres:nasb95;ref=BibleNASB95.Ro8.28-39
logosres:nasb95;ref=BibleNASB95.1Co10.13
logosres:nasb95;ref=BibleNASB95.1Co10.31
http://www.learnlogos.com/
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R.E.F.L.E.C.T. ON THE GLORY OF PRAYER, PART 6 
We have been working through our prayer acronym R.E.F.L.E.C.T. to help you explore and enhance your prayer life. We 

began with Remember the Glories of God, Examine Your Motives and Manner, Face Life through Scriptures, Love God, 

Experience the Sovereignty of God and now let’s explore “C” for Concern Yourself with the Kingdom. 

Remember the Glories of God 

Examine Your Motives and Manner 

Face Life through Scriptures 

Love God 

Experience the Sovereignty of God 

Concern Yourself with the Kingdom 

Take Every Opportunity 

Have you ever wondered why God has left you on earth after He saved you? There are many reasons, but the principle 
reason can be found in John 17, during Jesus’ prayer to the Father before His death. We have been “left behind” to be 
sent into the world to proclaim the Gospel. We can see this idea repeated in the Matthew 28:16-20 and again in Acts 
1:1-8. 
 
If in your prayer time, you neglect to concern yourself with the kingdom of God, then you have failed to focus on your 
primary mission. There are many ways to pray and participate in serving our Lord and His Kingdom, especially in prayer. 
May the following guide your prayers and endeavors for the greatest work of service with your time, talents, and 
treasures. 
 
#6 Experience the Sovereignty of God 

A. Kingdom’s Work - Opening Doors for the Gospel (Colossians 4:3, Ephesians 6:19) 
B. Kingdom’s Workers - (Romans 15:30-33, Acts 6:6) 
C. Intercessory Prayer - Jesus’ Example (Luke 22:31-32, John 17:1-26) 
D. Kingdom’s Enemies - (Acts 7:59-60, Matthew 5:44-48, Luke 23:34) 
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R.E.F.L.E.C.T. ON THE GLORY OF PRAYER, PART 6 
We have been working through are prayer acronym R.E.F.L.E.C.T. to help you explore and enhance your prayer life. We 

began with Remember the Glories of God, Examine Your Motives and Manner, Face Life through Scriptures, Love God, 

Experience the Sovereignty of God, Concern Yourself with the Kingdom and now let’s explore our last category “T” for 

Take Every Opportunity. 

Remember the Glories of God 

Examine Your Motives and Manner 

Face Life through Scriptures 

Love God 

Experience the Sovereignty of God 

Concern Yourself with the Kingdom 

Take Every Opportunity 

Bad habits are hard to break and can undermine your effectiveness, but righteous habits can help you grow and 
augment your service in the kingdom. As the old adage goes, “if it is worth doing, it’s worth doing it right!” 
And this seems a fitting way to end our short journey on the topic of prayer. It’s not enough to pray now and then nor 
even pray for certain seasons of our life, but to pray without ceasing! Yes that is our goal. May this last discussion 
encourage you to take every opportunity to pray to the Father! 
 
#6 Experience the Sovereignty of God 

A. Pray without Ceasing - (1 Thessalonians 5:16-17) 
B. Persevere in Prayer- (Ephesians 6:18-19, 1 Thessalonians 5:14) 
C. Future: Hope in Christ (Jude 1:20-21) 
D. Present: Remembering your days are Short & Limited- (James 4:14-15, Job 14:5) 
E. Past: Remember the Cross (2 Corinthians 2:14-17, 2 Corinthians 5:21) 

 
In closing, these 7 principles are not exhaustive, but they can provide a helpful framework for 
Glorifying God through prayer! What an amazing opportunity we have! May your prayers be a sweet aroma to our 
Lord and Savior! May you R.E.F.L.E.C.T. often in prayer, reflecting God’s Word’s, Reflecting Christ thoughts, Reflecting 
God’s Character, and Reflecting His ways! 
 
In the days ahead, think about the significance of prayer… Consider what it would be like without prayer? What if Moses 
never prayed for sinning Israel for 40 years? What if Hannah had not prayed for a son and there was no Samuel? What if 
Stephen did not pray before Saul? What if Christ did not pray for Peter when Satan wanted to sift Peter? What if Christ 
did not pray for the Church? But these prayers were prayed and we can see the glory of God on display! May you be 
unwavering in your prayer! May you pray noble and bold great prayers that will glorify God! 
 
Conclusion: God will use us, that much is certain, may He use our obedience rather than our disobedience…may we be 
found solemnly praying rather than sinfully playing. 
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HOW TO INVOLVE THE FIVE SENSES IN YOUR TEACHING  

AND PREACHING OUTLINES 
Preaching and teaching before an audience requires giftedness, skill, and practice. In this day and age our audience has 

blue-ray, CD quality audio, iMax movie screens, 3D movies, computer animation and special effects that blur the lines 

between reality and fantasy. How can any teacher of God’s truth compete against such technology and Hollywood 

budgets in the millions and the staff of thousands! 

First, we must remember that God’s Word is not dependent on any of these man made contrivances. Second, the Holy 

Spirit can reach a place where neither man nor technology can access, the spirit of the man, the very thoughts and 

intentions of his heart. Therefore, when building outlines for teaching and preaching don’t rely on the aforementioned 

devices but employ the shared experience of you and your audience from the Biblical text.  

Let’s review the five senses: See  Touch  Taste  Hear  Smell 

Example of a Sensory Outline  

1. Arriving at the Praetorium (Matthew 27:27-28) [See] 

2. Piercing Crown of Thorns (Matthew 27:29a) [Touch] 

3. Shouting & Mocking (Matthew 27:29b) [Hear] 

4. The Humiliating Spitting and Beating (Matthew 27:30) [Smell & Taste] 

Finally, when using the five senses, attempt to stir and conjure up their imagination with their memories, their life 

experiences, their real emotions, and their thoughts using these five senses.  
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PREACHING OUTLINES: THE APPLICATION OUTLINE, PART 2/4 
We are continuing our exploration of preaching outlines and the various structures one can employ for a sermon. In this 

eNewsletter I would like to explore the application outline. The purpose of this outline is to build an outline where the 

goal is action. 

Standard Application Outline Structure 

I. Introduction – Set the Stage for the Problem (Can be in the form of a question) 

II. State the Problem: Man-Made Solutions and how they fall short 

III. State the Solution: God’s Solution(s) and how they work (Good Exegesis, no proof texting allowed)  

IV. State the Principle (Make the concept transferable and applicable to the widest audience possible) 

a. Provide a Scriptural Example of Victory in Obedience 

b. Provide a Scriptural Example of Defeat in Disobedience  

V. Conclusion by Encouragement & Prayer 

It is important to note, that application must first be built on the foundation of good Bible study and exegesis. To exhort 

your audience without first proving that God has actually commanded such an action is inappropriate! So guard yourself 

against being too legalistic saying too much or saying too little and being too liberal. 

If you are looking for examples of this structure, Rick Warren is the most notable preacher using this format. 

  

  

http://www.pastors.com/groups/tools_and_resources/pages/rick-s-free-sermons.aspx#3
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PREACHING OUTLINES: THE STORY OUTLINE, PART 3/4 
Most of the Bible follows a story structure. There is a plot, a good character, an evil character, trials, redemption and so 

much more! Most likely your favorite section in the Bible is part of a greater story. In this section, let me introduce you 

to the Story Outline preaching template. The purpose of this outline is to build an outline where the goal is 

communicate God’s truth through a story structure.  

By the way, it is very important to remember that when the Biblical text has a story structure, it is advantageous to 

follow that story structure in the pulpit. It is not recommended that you take every passage, for example, an epistle of 

Paul and turn that into a story every time. Consider this template as another tool in the tool box of preaching options. 

Standard Application Outline Structure 

I. Title and Subtitle  
Note: Very important to make it sound like a story, consider browsing through Amazon for titling ideas. Additionally, be 
mindful that the title is to draw interest and not spoil the story. 

II. The Scene 
Note: Fill in the details, establish a background, prepare the audience by utilizing the five senses, and ready them for the 
introduction of the main character and the plot. 

III. The Major Character(s)  
Note: Provide enough information to understand who they are, how the audience can relate to them, and identify their 
purpose in the story. 

IV. The Plot  
Note: This may be 1 - [wo]man vs. nature, 2 - [wo]man vs. man, 3 - [wo]man vs. the environment, 4 - [wo]man vs. 
machines/technology, 5 - [wo]man vs. the supernatural, 6 - [wo]man vs. self, 7 - [wo]man vs. god/religion 

V. The Climax 
Note: This is a conflict where tension is created and demands a solution. Furthermore, the climax should reveal the sin 
of man and his foolish thinking. 

VI. The Solution 
Note: Here we show the reward for faithful, holy obedience to God and the punishment for sin and disobedience. It’s 
important to show grace, forgiveness, and other important themes of the Bible. 

VI. The Close 

Note: Provide an opportunity to exhort or offer a life principle rooted in the scriptures so that the audience can 
remember the story and the life lesson. Make it memorable! 

There are two preachers that really have mastered this structure: Eugene Lowry and Calvin Miller. 

Finally, here are some additional links to help you dig deeper into story telling.  

http://www.musik-therapie.at/PederHill/Structure&Plot.htm 

http://en.wikipedia.org/wiki/Dramatic_structure 

 

http://www.ehow.com/how_4859774_sermon-eugene-lowrys-plot-loop.html
http://www.calvinmillerauthor.com/
http://www.musik-therapie.at/PederHill/Structure&Plot.htm
http://en.wikipedia.org/wiki/Dramatic_structure
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       “ONE IS THE LONELIEST NUMBER” SAYS SONGWRITER GEORGE JONES… 

Q1: John, what is a “Hapax Legomenon” 

A1: This is a technical term to describe the phenomenon when a word only appears once in an author’s writing. If you 

are doing a word study and you come across one of these, your job just got really difficult. You will need to work even 

harder to determine its meaning and may even have to go outside the Bible to determine how the word has been 

traditionally used and understood. 

Q2: Is there a way to search for “hapax legomenons” in the NT? 

A2: Not directly. But I do have one suggestion. (If you know a better way, please email me at tips@learnlogos.com) 

HOW TO:  

 If you open the Greek Lexcicon BDAG and use the basic search to engine to search for the word hapax you will find 

most, but not all of the NT “hapax legomenons”. 

 

Q3: Is there a way to search for “hapax legomenons” in the OT? 

A3: Not directly. But let me offer this suggestion (If you know a better way, please email me at tips@learnlogos.com) 

HOW TO:  

 If you open the Hebrew Lexicon HALOT and use the basic search to engine to search for the word hapax you will find 

 

 

mailto:tips@learnlogos.com
logosres:bdag;hw=$CF$83$CF$85$CE$BD$CE$B4$CE$B9$CE$B4$CE$B1$CF$83$CE$BA$CE$B1$CE$BB$CE$B9$CC$81$CF$84$CE$B7$CF$82
mailto:tips@learnlogos.com
logosres:hal;hw=$D7$A2$D6$B2$D7$99$D6$B8$D7$9D
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Q3: Is there a way to back up Logos 4 and avoid the huge download? 

A3: Yes, there are some limitations and some downloading will be necessary. 

HOW TO:  

 PC: http://wiki.logos.com/Quick_Installation_onto_multiple_computers 

 MAC: http://wiki.logos.com/Quick_Installation_onto_Multiple_Macs 

 

Email me your questions, and maybe you will be in the next newsletter! tips@learnlogos.com 
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Welcome! More than a Manual… 
If you like this eNewsletter let us know – Click  

Now let’s get ready to LearnLogos! 

Note: You can click on the colored links above and it will take you to LearnLogos.com to learn more about all available 

training products. There are other types of links in this document: book links, Scripture links, and more. Click on them 

too! 

Thanks and Enjoy! 

John Fallahee, President/CEO LearnLogos.com 

RECENT NEWS 

#1 More Webinars Released! Only $ 9.99 $ 4.99 for each download. 
 Click for Details 

o Inductive Bible Study for Logos 4 (6 Webinars Available) 

o Studying the Bible with Logos 4 (6 Webinars Available) 

o Preparing Sermons with Logos 4 (5 Webinars Available) 

Note: Most webinars are 1 ½ hours in length! Amazing value! Click here to 

buy now. 

#2 Training CDs – You can now download this training 

immediately! 
50% Off Logos 4 Training Bundle Only $39.99  

#3 Upcoming Live Webinars 

NOTE: SCHEDULE CHANGE – See New Schedule 
 Mon, April 25, 9-10:30 PM (ET) Preparing Sermons with Logos 4, Session 6  

o Click to Signup: Performing Effective Word Studies, Part 2, Q&A 

 Mon, May 2, 9-10:30 PM (ET) Inductive Bible Study with Logos 4, Session 7 

o Click to Signup: Find cross references/Checking with Commentaries, Q &A 

 Mon, May 16th, 9-10:30 PM (ET) Studying the Bible with Logos 4, Session 7 

o Click to Signup: Find cross references/Checking with Commentaries, Q &A 
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 FREE BOOK PREVIEW  
If you own an ESV Bible then you might enjoy some extra books. Click here to find out more from ESV: 

http://www.gnpcb.org/freecd/ 

See the list below of free resources included in the install. (This will be a Logos 3 installation) 

Note: To install these in Logos 4, go to the command box and type: Scan C:\Program Files (x86)\Libronix DLS\Resources 

 

 

 

 

 

 

http://www.gnpcb.org/freecd/
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      PROGRAM SETTINGS 

 

Program Settings is an often overlooked tool than can help optimize your Logos 4 experience.  Here are my recommend 

settings: 

  

 

  

 Pick a time after you go to bed.  

Note: Be sure your computer and Logos 4 are left on. 

 In School? Choose your citation style. 

 Keep those footnotes from appearing at the bottom 

 Keep Logos quiet when you start the program 

 These are not that necessary 
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      WHO PRAYED IN THE OT - USING SYNTAX 
 

HOW TO:  

 Let’s go to Genesis 20:7  

 Right click on the word “pray” 

 Choose “copy” from the menu at the left.  

 

 Choose “Search” 

 

 Choose “Syntax” 

 

 Choose the following: 
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 Choose “verb (Andersen-Forbes)” 

 

 Right click on the box labeled verb and choose “Paste” from the menu 

 

 Choose “pray” from the menu 

 

 Click “Go” 

 

 

 

 

 

 

 

http://www.LearnLogos.com
http://www.LearnLogos.com
http://www.LearnLogos.com
http://www.LearnLogos.com
http://www.LearnLogos.com
http://www.LearnLogos.com
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Let’s examine the search results. You have found every verse with a subject that has the verb “pray”. 

 

 

 
Click One, Click Both! 

  

50% Off 

Learn at 
Your Pace 

http://www.learnlogos.com/index.php?option=com_content&view=article&id=84
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http://www.learnlogos.com/index.php?option=com_content&view=article&id=84
http://www.learnlogos.com/index.php?option=com_content&view=article&id=78:distant-education-class-outline&catid=65
http://www.learnlogos.com/index.php?option=com_content&view=article&id=84
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        THE RESURRECTION: SEARCHING APOLOGETIC RESOURCES 
 

Apologetic resources can be a great way to research historical and theological backgrounds for the passage you are 

studying. Let’s create and search a collection and find background information on the resurrection. 

HOW TO:  

 Let’s create a collection 

 Choose from the main menu Tools and then choose Collections 

 

 Let’s name the collection Apologetics and use the following rule: subject:apologetic 

See below for more information. 

 

Note: See the end of this section for my list of recommended books on apologetics.  

 Now let’s click “Search” 
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 Type the following phrase in the search box “resurrection evidence” OR “evidence for resurrection”  

 Press the enter key or click the white arrow in the blue circle at the right and examine your search results. 

 

Here is my bibliography of apologetic resources 

Recommended Apologetic Books for Logos Bible Software 4 

Answering Islam: The Crescent in Light of the Cross 
Geisler, Norman L. and Abdul Saleeb. Answering Islam : The Crescent in Light of the Cross. 2nd ed. Grand Rapids, Mich.: Baker Books, 
2002. 

Answers to Tough Questions 
McDowell, Josh and Don Douglas Stewart. Answers to Tough Questions. Nashville: T. Nelson Publishers, 1993. 

Apologetics 
Van Til, Cornelius and William Edgar. Christian Apologetics. 2nd ed. The Presbyterian and Reformed Publishing Company: 
Phillipsburg, NJ, 2003. 

The Apologetics Study Bible: Real Questions, Straight Answers, Stronger Faith 
Cabal, Ted, Chad Owen Brand, E. Ray Clendenen et al. The Apologetics Study Bible: Real Questions, Straight Answers, Stronger Faith. 
Nashville, TN: Holman Bible Publishers, 2007. 

The Articles of Cornelius Van Til 
Van Til, Cornelius and Eric H. Sigward. The Articles of Cornelius Van Til. Electronic ed. Labels Army Company: New York, 1997. 

Baker Encyclopedia of Christian Apologetics 
Geisler, Norman L. Baker Encyclopedia of Christian Apologetics. Baker reference library. Grand Rapids, Mich.: Baker Books, 1999. 

The Bridge of History Over the Gulf of Time 
Cooper, Thomas. The Bridge of History Over the Gulf of Time. 2d ed. London: Hodder and Stoughton, 1871. 

Choosing My Religion 
Sproul, R.C. Choosing My Religion. electronic ed. Grand Rapids: Baker Books, 2000. 

Christian History Magazine—Issue 75: G.K. Chesterton: Prolific Writer & Apologist 
Christian History Magazine-Issue 75: G.K. Chesterton: Prolific Writer & Apologist. Carol Stream, IL: Christianity Today. 

Christian History Magazine—Issue 88: C.S. Lewis: Pointing People to Reality 
Christian History Magazine-Issue 88: C.S. Lewis: Pointing People to Reality. Carol Stream, IL: Christianity Today, 2005. 

Christian History Magazine—Issue 96: The Gnostic Hunger for Secret Knowledge 
Christian History Magazine-Issue 96: The Gnostic Hunger for Secret Knowledge. Carol Stream, IL: Christianity Today, 2007. 

A Christian Theory of Knowledge 
Van Til, Cornelius. A Christian Theory of Knowledge. The Presbyterian and Reformed Publishing Company: Phillipsburg, NJ, 1969. 

 
 

logosres:ansislam
logosres:answertq
logosres:cvtapolog
logosres:aplgstdybbl
logosres:cvtarticles
logosres:encycchap
logosres:bhogt
logosres:rcschoos
logosres:ch75
logosres:ch88
logosres:ch96
logosres:cvtchrthknw
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Christianity on the Offense 
Story, Dan. Christianity on the Offense : Responding to the Beliefs and Assumptions of Spiritual Seekers. Grand Rapids, MI: Kregel 
Publications, 1998. 

The Cornelius Van Til Audio Library 
Van Til, Cornelius and Eric H. Sigward. The Cornelius Van Til Audio Library. Electronic ed. Labels Army Company: New York, 1997. 

Defending Your Faith 
Story, Dan. Defending Your Faith. Grand Rapids, MI: Kregel Publications, 1997. 

The Defense of the Faith—Abridged Edition 
Van Til, Cornelius. The Defense of the Faith. The Presbyterian and Reformed Publishing Company: Philadelphia, 1955. 

The Defense of the Faith—First Edition 
Van Til, Cornelius. The Defense of the Faith. The Presbyterian and Reformed Publishing Company: Philadelphia, 1955. 

The Dutch Articles of Cornelius Van Til 
Van Til, Cornelius and Eric H. Sigward. The Dutch Articles of Cornelius Van Til. Electronic ed. Labels Army Company: New York, 1997. 

Engaging the Closed Minded 
Story, Dan. Engaging the Closed Minded : Presenting Your Faith to the Confirmed Unbeliever. Grand Rapids, MI: Kregel Publications, 
1999. 

Evidence and Truth 
Morgan, Robert J. Evidence and Truth : Foundations for Christian Truth. Biblical essentials series. Wheaton, IL: Crossway Books, 2003. 

Exploring the Attributes of God 
Exploring the Attributes of God. Iowa Falls, IA: World Bible Publishers, Inc., 1989-. 

The Genesis Factor 
Helm, David R. and Jon M. Dennis. The Genesis Factor : Probing Life's Big Questions. Wheaton, Ill.: Crossway Books, 2001. 

The God of Hope—Sermons and Addresses 
Van Til, Cornelius. The Hope of God-Sermons and Addresses. The Presbyterian and Reformed Publishing Company: Phillipsburg, NJ, 
1978. 

Handbook of Christian Apologetics 
Kreeft, Peter and Ronald K. Tacelli. Handbook of Christian Apologetics : Hundreds of Answers to Crucial Questions. Downers Grove, 
Ill.: InterVarsity Press, 1994. 

I Don’t Have Enough Faith to Be an Atheist 
Geisler, Norman L. and Frank Turek. I Don't Have Enough Faith to Be an Atheist. Wheaton, Ill.: Crossway Books, 2004. 

If There’s a God, Why Are There Atheists? 
Sproul, R.C. (Robert Charles). If There's a God, Why Are There Atheists? : Why Atheists Believe in Unbelief. Revised edition of the 
book The psychology of Atheism. Wheaton, IL: Tyndale House Publishers, 1978. 

Josh McDowell's Handbook on Apologetics 
McDowell, Josh. Josh McDowell's Handbook on Apologetics. electronic ed. Nashville: Thomas Nelson, 1997. 

Lifeviews: Make a Christian Impact on Culture and Society 
Sproul, R.C. Lifeviews : Understanding the Ideas That Shape Society Today. electronic ed. Old Tappan, NJ: F.H. Revell, 2000. 

Orthodoxy 
Chesterton, G. K. Orthodoxy. Bellingham, WA: Logos Research Systems, Inc., 2010. 

The Pamphlets, Tracts, and Offprints of Cornelius Van Til 
Van Til, Cornelius and Eric H. Sigward. The Pamphlets, Tracts, and Offprints of Cornelius Van Til. Electronic ed. Labels Army Company: 
New York, 1997. 

 

logosres:chroffense
logosres:cvtaudio
logosres:dfndfaith
logosres:cvtdeffthab
logosres:cvtdeffaith
logosres:cvtdutch
logosres:engclsmind
logosres:evdnctrth
logosres:explattrgod
logosres:genfactor
logosres:cvtgodhope
logosres:hca
logosres:faithathst
logosres:rcsunbel
logosres:5quest
logosres:rcslifev
logosres:orthodoxy
logosres:cvtpmphlts
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The Protestant Doctrine of Scripture 
Van Til, Cornelius. The Protestant Doctrine of Scripture. The Presbyterian and Reformed Publishing Company: Phillipsburg, NJ, 1967. 

Reasonable Faith 
Craig, William Lane. Reasonable Faith : Christian Truth and Apologetics. Rev. ed. Wheaton, Ill.: Crossway Books, 1994. 

The Reformed Pastor and the Defense of Christianity & My Credo 
Van Til, Cornelius. The Reformed Pastor and the Defense of Christianity and My Credo. The Presbyterian and Reformed Publishing 
Company: Phillipsburg, NJ, 1980. 

Reincarnation and Christianity 
Morey, Robert A. Reincarnation and Christianity. Minneapolis, Minn.: Bethany Fellowship, 1980. 

Reviews by Cornelius Van Til 
Van Til, Cornelius and Eric H. Sigward. Reviews by Cornelius Van Til. Electronic ed. Labels Army Company: New York, 1997. 

The School of Biblical Evangelism 
Cameron, Kirk and Ray Comfort. The School of Biblical Evangelism : 101 Lessons : How to Share Your Faith Simply, Effectively, 
Biblically-- the Way Jesus Did. Gainesville, Fla.: Bridge-Logos Publishers, 2004. 

Semper Reformandum: Studies in Honour of Clark H. Pinnock 
Porter, Stanley E. and Anthony R. Cross. Semper Reformandum : Studies in Honour of Clark H. Pinnock. Milton Keynes, UK: 
Paternoster, 2003. 

The Sermons and Addresses of Cornelius Van Til 
Van Til, Cornelius and Eric H. Sigward. The Sermons and Addresses of Cornelius Van Til. Electronic ed. Labels Army Company: New 
York, 1997. 

A Survey of Christian Epistemology 
Van Til, Cornelius. A Survey of Christian Epistemology. The Presbyterian and Reformed Publishing Company: Phillipsburg, NJ, 1969. 

The Truth about Worldviews 
Eckman, James P. The Truth About Worldviews : A Biblical Understanding of Worldview Alternatives. Wheaton Ill.: Crossway Books, 
2004. 

Unpublished Manuscripts of Cornelius Van Til 
Van Til, Cornelius and Eric H. Sigward. Unpublished Manuscripts of Cornelius Van Til. Electronic ed. Labels Army Company: New York, 
1997. 

When Cultists Ask: A Popular Handbook on Cultic Misinterpretations 
Geisler, Norman L. and Ron Rhodes. When Cultists Ask : A Popular Handbook on Cultic Misinterpretations. Grand Rapids, Mich.: 
Baker Books, 1997. 

When Skeptics Ask: A Handbook on Christian Evidences 
Geisler, Norman L. and Ronald M. Brooks. When Skeptics Ask. Wheaton, Ill.: Victor Books, 1990. 

Who Do You Say That I Am? 
Van Til, Cornelius. Who Do You Say That I Am?. Phillipsburg, NJ: The Presbyterian and Reformed Publishing Company, 1975. 

Why I Am a Christian: Leading Thinkers Explain Why They Believe 
Geisler, Norman L. and Paul K. Hoffman. Why I Am a Christian : Leading Thinkers Explain Why They Believe. Grand Rapids, Mich.: 
Baker Books, 2001. 

Why One Way? Defending an Exclusive Claim in an Inclusive World 
MacArthur, John. Why One Way? : Defending an Exclusive Claim in an Inclusive World. Nashville: W Pub. Group, 2002. 
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logosres:trthwrldvw
logosres:cvtmnscrpts
logosres:wcultask
logosres:wskeptask
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      CHIASM: “Winners never quit and quitters never win” 

If you have spent any time in the Psalms, you have most likely have seen and read a Psalm with a “Chiastic” structure. 

Although, this word can be hard to pronounce, it is important to observe to determine an important interpretative point 

in a passage. The best definition I have seen defines chiasm as follows: An inverted parallelism between two or more 

(synonymously or antithetically) corresponding words, phrases, or units of thought.
1
 Let’s look at the example above: 

Winners (A) 

 Never Quit (B) 

 Quitters (B1) 

Never Win (A1) 

 

In this example, we have opposites contrasted or antithetical examples. Here we have contrasted winners and quitters. 

Chiastic structure can take place at the sentence level, paragraph level, or even chapter level!  Let’s look at Psalm 29: 

1 Ascribe to the LORD, O sons of the mighty, Ascribe to the LORD glory and strength.  
2 Ascribe to the LORD the glory due to His name; Worship the LORD in holy array.  

3 The voice of the LORD is upon the waters; The God of glory thunders, The LORD is over many waters.  
4 The voice of the LORD is powerful, The voice of the LORD is majestic.  

5 The voice of the LORD breaks the cedars;  
Yes, the LORD breaks in pieces the cedars of Lebanon.  

6 He makes Lebanon skip like a calf,  
And Sirion like a young wild ox.  

7 The voice of the LORD hews out flames of fire.  
8 The voice of the LORD shakes the wilderness;  
The LORD shakes the wilderness of Kadesh.  

9 The voice of the LORD makes the deer to calve  
And strips the forests bare;  

And in His temple everything says, “Glory!”  
10 The LORD sat as King at the flood;  

Yes, the LORD sits as King forever.  
11 The LORD will give strength to His people; The LORD will bless His people with peace.  
 
Note: Notice the use of Lord 4x in verses 1-2, 10-11 
 
By discovering a chiastic structure, you can parallel ideas to help you interpret. To learn more about chiastic structures, 

check out the following article in the Theological Journals: 

(1) Chiastic Psalms: A Study In The Mechanics Of Semitic Poetry In Psalms 1-50 

(2) Chiastic Psalms: A Study In The Mechanics Of Semitic Poetry In Psalms 51-100 

(3) Chiastic Psalms: A Study In The Mechanics Of Semitic Poetry In Psalms 101-150 

                                                           
1 Chafer Theological Seminary Journal Volume 9, 2 (Fountain Valley, CA: Chafer Theological Seminary, 2003), 19. 

logosres:gs-jets-17;ref=VolumeNumberPage.V_17,_N_1,_p_10;off=1400
logosres:gs-jets-19;ref=VolumeNumberPage.V_19,_N_3,_p_190;off=2434
logosres:gs-jets-21;ref=VolumeNumberPage.V_21,_N_3,_p_198;off=981
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        MORPHOLOGY & MOOD: DEGREES OF DOUBT 
 

If you attended any of the Session 5 webinars, we overviewed an important concept “morphological mood” and 

“degrees of doubt”. Here is a handy chart to refresh your memory: 

NO DOUBT   SOME DOUBT  A LOT OF DOUBT NO DOUBT 

(ACTION DID OCCUR)        (ACTION DID NOT OCCUR) 

Indicative   Subjunctive  Optative  Imperative (command) 

 

As you can see in the chart above, as we move from the indicative mood toward the optative mood, our doubt increases 

whether the action occurred. In fact, when we get to the imperative, there is no doubt the action did not occur. If you 

have Wallace’s Grammar (I highly recommend this book), there is an excellent discussion on this topic. He add three 

important concepts: 

Mood is the morphological feature of a verb that a speaker uses to portray his or her affirmation as to the 

certainty of the verbal action or state (whether an actuality or potentiality). The key elements in this definition 

are that mood (a) does not necessarily correspond to reality, (b) does not indicate even a speaker’s perception of 

reality, but (c) does indicate a speaker’s portrayal or representation.
2 

With this chart and Wallace’s thoughts handy, let’s search on these moods and see how these words are translated and 

examine their context. 

HOW TO:  

  Go to the main menu at the top and click “Search” 

 

 Click Morph at the right 

 

 Choose the following search criteria 

 

 

                                                           
2 Daniel B. Wallace, Greek Grammar Beyond the Basics - Exegetical Syntax of the New Testament (Zondervan Publishing 

House and Galaxie Software, 1999; 2002), 445. 

http://www.learnlogos.com/webinar
http://www.logos.com/product/8286/greek-grammar-beyond-the-basics
logosres:gs-ggbtb;art=div443
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 In the search box, type @ to open the morphological menu, then click verb, optative, and click the white arrow at the 

right. 

 

 Let’s examine the search results. As you can see, Daniel Wallace’s additional insights can help us make sense of these 

verbal moods, especially in the case of the optative. For example, in Mark 11:14, because Jesus cursed the vine and it 

withered, there is extreme doubt anyone will eat from that vine. 

 

 

 

 

  

http://www.learnlogos.com
http://www.learnlogos.com
http://www.learnlogos.com
http://www.learnlogos.com
http://www.learnlogos.com
http://www.learnlogos.com
http://www.learnlogos.com
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                   THAT’S A GREAT QUOTE! WHO SAID THAT? 
One of the best ways to enhance your teaching, preaching, and evangelizing efforts is to find great quotes, sayings, or 

expressions. With Logos 4 and the special search technique described below, you will be finding and utilizing great 

quotes in no time! 

Before we search we need to create a collection of great quotes, sayings, and expressions. 

HOW TO:  

 Let’s create a collection 

 Choose from the main menu Tools and then choose Collections 

 

 Let’s name the collection Great Quotes and use the following rule: subject:illustration OR subject:quotations OR 

subject:sayings OR subject:sermon OR subject:devotional 

See below for more information. 
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 Now let’s click “Search” 

 

 Choose Basic search option at the right 

  

 Next, let’s choose our search criteria. Click on Entire Library, in the “Search In” box, type great quotes and press enter 

 

 Let’s search for great quotes regarding the resurrection.  Enter the following search phrase and press the enter key: 

<bible ~ 1 cor 15:20> WITHIN 30 WORDS resurrection 

 

 Examine your search results and pick one that you like. I like this one from Spurgeon’s Morning and Evening 

“Our risen bodies shall not be capable of decay, much less of death. There are no graves in glory” - Spurgeon 

Note: The ~ allows for a greater range of verses to be found, compared to using the = symbol. 
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WILD SEARCHING! 

Actually, this won’t be wild in the sense of the jungle or something that is out of control. Instead, I would like to 

introduce you to “wild card” searching.  

“Wild Card” searching gives you precise control over the words you are searching. 

For example, what if you want to find all the various forms of love in the Bible (loved, loving, loveless, lovingkindness, 

loves, lovely, lovesick, lovers)? 

HOW TO:  

 First, you must ask the following question, “What do the words have in common?”  

In our example, they all use “lov”.  

 Next, you add the “Wild Card” to this phrase lov*  

Note:  The star/asterisk is a symbol that tells the Logos 4 program to find anything that follows “lov”, 

 

Let’s do another type of “wild card” search, but this time let’s use a question mark instead of a star/asterisk. 

HOW TO:  

The question mark only searches for one character, whereas the star/asterisk searches for unlimited number of 

characters. Note: the star/asterisk will also find words with no characters as well. 

 First, you must ask the following question, “What letter(s) am I searching for?”  

Using our previous example, let’s search for all words that have have “l ve” in common. (live and love) 

 Next, you add the “Wild Card” to this phrase l?ve.   
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CATECHISMS: A THING OF THE PAST OR STILL RELEVANT FOR TODAY? 
 

Question…Answer...Question…Answer  

The very foundation of learning begins with the question and is followed by the answer. Catechisms traditionally have 

been accomplished through an oral examination. However, they can also be written down and in the case of the famous 

Westminster Catechism, we have this document not only in print but in Logos 4.  This Q&A dates back to 1646! Wow 

that is 365 years old! There are 196 key questions and answer couplets with plenty of cross references. 

Here is a sample: 

 

As you can see, there is no simpler way to grow your Biblical knowledge than with Bible questions followed by Bible 

answers with Biblical cross references. I highly recommend reviewing this to grow your knowledge of The Faith. 

You can get this at www.logos.com for $19.95 

  

Learn more about the Westminster Confession at wikipedia. 

  

http://www.logos.com/product/410/westminster-confession-of-faith-including-the-larger-and-shorter-catechisms
http://www.logos.com/product/410/westminster-confession-of-faith-including-the-larger-and-shorter-catechisms
http://www.logos.com/
http://en.wikipedia.org/wiki/Westminster_Confession_of_Faith
http://www.logos.com/product/410/westminster-confession-of-faith-including-the-larger-and-shorter-catechisms
http://www.logos.com/product/410/westminster-confession-of-faith-including-the-larger-and-shorter-catechisms
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EXODUS: WHAT RESOURCES WOULD YOU RECOMMEND? 
 

Exegetical Commentaries 

Word Biblical Commentary: Exodus 

A Commentary on the Holy Scriptures: Exodus by Lange, John Peter, Philip Schaff and Charles M. Mead 

 

Expositional Commentaries 

The New American Commentary: Exodus 

Preaching the Word: Exodus—Saved for God's Glory 

The Pulpit Commentary (3 Volumes) 

Believers Church Bible Commentary: Exodus 

A Handbook on Exodus (UBS) by Osborn, Noel D. and Howard Hatton 

Opening Up Exodus 

 

Introductory Commentaries 

Be Delivered:  Wiersbe, Warren W.  
 

Outlines 

The Book of Exodus by Gingrich, Roy 

 

Create a collection of your Exodus Commentaries 

Collection Name: Exodus Resources  

Collection Rule: subject:exodus 

Note: To create a collection: Tools > Collection 

 

 

http://www.logos.com/product/1323/word-biblical-commentary-volume-3-exodus
http://www.logos.com/product/5759/langes-commentary-on-the-holy-scriptures
http://www.logos.com/product/3324/new-american-commentary-exodus
http://www.logos.com/product/3168/exodus-saved-for-gods-glory
http://www.logos.com/product/5768/the-pulpit-commentary
http://www.logos.com/product/8895/exodus
http://www.logos.com/product/7842/the-united-bible-societies-old-testament-handbook-series
http://www.logos.com/product/7194/opening-up-exodus
http://www.logos.com/product/2555/be-delivered
http://www.logos.com/product/8287/the-book-of-exodus
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7 KEY PRINCIPLES OF JESUS PRAYER LIFE, Part 1/7 
 

The next few newsletters will be devoted to studying the prayer life of Jesus. You will be encouraged and challenged to 

pray like our Lord and Savior. I believe these principles are absolutely essential to learn and practice daily in your walk 

before God! Let’s get started with principle #1. 

Principle #1: Prayer was the Pattern of Jesus' Life 

A) Jesus’ Pattern of Prayer: Often 

Two of several passages from God’s Word that illuminate our understanding of the paradigm of Jesus’ prayer pattern are 

Luke 5:16 and Mark 1:35. In Luke 5:16, we read that Jesus would often slip away to the wilderness and pray, saturating 

His life with prayer. The tenses of the verbs are both imperfect periphrastics, which emphasize that this was a customary 

and habitual practice of Jesus 

B) Jesus’ Pattern of Prayer: All Times of a Day 

Because Jesus prayed often, we find Him praying at all times- before dawn, during daylight, and after sunset. For 

example, before dawn we read about Jesus praying in Mark 1:35. Even though it was still dark, Jesus got up, went to a 

secluded place during the last watch from three to six in the morning and prayed. The verb for praying is in the 

imperfect form showing us that Jesus was praying even until Peter and his companions would later find Him as 

mentioned in Mark 1:37.  

In Luke 11:1-13, while Jesus was praying during the day, one of the disciples asked Jesus how to pray whereby Jesus 

follows with instruction on how to pray giving us the “Disciple’s Prayer”. In Matthew 26:36-46 and its parallel accounts 

of Mark 14:32-42 and Luke 22:39-46 the sun had set, the disciples have fallen asleep but Jesus petitions God the Father 

three times. Therefore, one must conclude that regardless of the time or the circumstances Jesus prayed at all times in 

the Spirit, being alert with all perseverance and petition(Ephesians 6:18). 

  

logosres:nasb95;ref=BibleNASB95.Lk5.16
logosres:nasb95;ref=BibleNASB95.Mk1.35
logosres:nasb95;ref=BibleNASB95.Lk5.16
logosres:nasb95;ref=BibleNASB95.Mk1.35
logosres:nasb95;ref=BibleNASB95.Mk1.37
logosres:nasb95;ref=BibleNASB95.Lk11.1-13
logosres:nasb95;ref=BibleNASB95.Mt6.1
logosres:nasb95;ref=BibleNASB95.Mt26.36-46
logosres:nasb95;ref=BibleNASB95.Mk14.32-42
logosres:nasb95;ref=BibleNASB95.Lk22.39-46
logosres:nasb95;ref=BibleNASB95.Eph6.18
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PREACHING OUTLINES: THE SCENIC SERMON, PART 4/4 
 

If you have followed the emerging church of the last few years you will discover this method of preaching is very 

popular. However as Solomon said, there really is nothing new under the sun. In fact, if you were to go back as far as 

Origen (ca. 185-253) you would see a connection in his method of preaching with the preaching of the “emerging 

church”. The connection is for these preachers to take the Christian message and paint a picture as an artist would draw 

a drawing. Sometimes they employ the allegorical method where elements in the story are symbolic of great themes of 

the Bible.  

Additionally, the emerging church (Rob Bell and others) borrow many of the elements you would find in the story telling 

model (a model we discussed in the last newsletter). This allegorical feature is one of the main characteristics that 

separate the Scenic Sermon from the Story Outline. 

The scenic sermon draws upon grand themes of the Bible and universal types to generalize truths and to effect an 

emotion in the audience and to draw you into the big picture and provide a general direction, rather than clearly 

delineate the precise truths of scripture in an expositional manner.  I would liken these preachers to an impressionist 

painter. From afar you can look at the canvas of colors and shapes, it may be a flower, bowl of fruit, or even a house or 

person but as you move closer and closer the distinctiveness is lost, and you begin to lose clarity and the shapes are lost 

in an array of color and brush strokes. 

Scenic sermons are much the same way; they are not designed to articulate precise, verse by verse interpretations but 

instead are aiming to describe the scene at large. Another way to look at this is with the concept of a vision. Vision can 

provide a general direction or describe a goal to accomplish. The details of that goal will flesh themselves out over time. 

For example, God sends Abraham to a land he had never seen. The details to accomplish that goal were not given but 

were lived out daily along the way.  There are elements of this methodology that can certainly help connect with the 

audience and that is good, but remember, regardless of the methodology you employ; only clear explanations of the 

Biblical text can feed and help grow a Christian. Only through teaching precise truths rooted in the scripture can we be 

saved, know, love and serve God and each other and evangelize the lost.  

In closing, let me offer a strong word of caution against this methodology, without precision, meaning is lost, and truth is 

clouded. To analogize, truth no longer takes a precise shape but becomes an inkblot by which the viewer imagines what 

it may be! God never intended for us to be confused about who He is and What He has said in His Holy Word. However, 

Satan is the author of confusion, the father of lies, and the adversary to our souls. When you teach, teach the Bible, and 

teach what it clearly and plainly says. 

Scenic Sermon Temple 

Title/Subtitle 

 Like a painting, attention getting, general in nature 

 Not giving the details but instead inviting the listener to participate 
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The Main Topic 

 Using visual terms 

 Describe the single, main idea 

Main Character/Main Idea - Focus 

 Everything is connected to and anchored to the main character/main idea 

 In a painting, it can be a color, an object, or even an idea. 

Materials 

 To make an analogy, artists can employ various materials to convey their artwork: wood, marble, and 

even a canvas.  

 Each of these materials set the stage, tone, and expression. 

The Arrangement: 

 Here the main character/main idea and materials come into focus and reveal their relationship  

 Each is arranged with a purpose to convey the imagery to communicate the general truth. (typically 

using the story model) 

Mood: Using Color and Light 

 Color can create emotion and mood.  

 Dark scenes can be foreboding, mysterious, scary, or comforting 

 Scenes with light can be life threatening like a desert scene, renewing like a sunrise, or relaxing like a 

sunset 

 Here the teacher/preacher must identify the mood and utilize the proper images to direct the emotional 

response of the audience. 

Sketch: Lines and Shapes 

 Here the presenter will determine what will have focus and detail.  

 In a way, sketching with lines and shapes in drawings not only defines an object in a drawing but also, 

defines the relationships with the main idea, materials, and arrangement.  

 Some ideas can be subtle (less important but related), whereas other ideas can be bold and crucial and 

defined so that the connection is obvious to the audience. 

Audience Reaction 

 What do you hope will happen in the mind, heart and will of the audience?  

 How will their thinking, talking, and living be transformed by these truths? 
 

Here are several preachers than employ this methodology. (Note: This is not an endorsement of their teaching or their 

ministry) 

Rob Bell Brian MacLaren  Doug Pagitt 

 

http://marshill.org/teaching/
http://www.slideshare.net/brianmclaren/jan-adventure-1-6588834
http://www.dougpagittradio.com/NQRR/Previously/Previously.html
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“Pericope”? Sounds and looks like periscope…not quite! 

Q1: John, what is a “Pericope”? 

A1:  The first question might be how do you pronounce this word? Click this link to hear it pronounced (internet 

connection required) 

 Now that we know how to say this word, what does it mean? The simplest definition can be found in your Webster’s 

Dictionary in Logos 4, which states that it is a specific selection from a book.  

 Why is this important to know? For teaching and preaching, we need to know where a section begins and ends so 

that we teach/preach that section of truth. By sticking to one pericope at a time, we can focus on one truth at a time 

and this will keep your message clear, focused, and easy to follow. 

 Can Logos 4 help me find the pericope of a passage? Yes. Click here or go to the main menu and choose the following: 

Tools > Passage Analysis > Compare Pericope (at the bottom) > Choose Your Bible translations 

 

Email me your questions, and maybe you will be in the next newsletter! tips@learnlogos.com 
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Welcome! More than a Manual… 
If you like this eNewsletter let us know and tell others on Facebook! Now let’s get ready to LearnLogos! 

Note: You can click on the colored links above and it will take you to LearnLogos.com to learn more about all of the 

available training products. There are other types of links in this document: book links, Scripture links, and more. Click 

on them too! 

Thanks and Enjoy! 

John Fallahee, President/CEO & Video Trainer 

RECENT NEWS 

#1 More Webinars Released! Only $ 9.99 $ 4.99 for each download. 
 Click for Details 

o Inductive Bible Study for Logos 4 (7 Webinars Available) 

o Studying the Bible with Logos 4 (7 Webinars Available) 

o Preparing Sermons with Logos 4 (7 Webinars Available) 

Note: Most webinars are 1 ½ hours in length! Amazing value! Click to buy! 

#2 Training CDs – You can now download this training 

immediately! 
50% Off Logos 4 Training Bundle Only $39.99  

#3 Upcoming Live Webinars 

NOTE: SCHEDULE CHANGE – See New Schedule 
 Mon, June 6th, 9-10:00 PM (ET) Inductive Bible Study with Logos 4  

o Session 8: Click to Signup: Strategies to overcome a difficult passage (NT) 

 Mon, May 16th, 9-10:00 PM (ET) Studying the Bible with Logos 4 

o Session 8: Click to Signup: Strategies to overcome a difficult passage (OT) 

 Mon, June 25, 9-10:00 PM (ET) Preparing Sermons with Logos 4 

o Session 8: Click to Signup: Strategies to overcome a difficult passage (OT/NT) 

 

Volume 6, Issue 1/2 John Fallahee, M.B.A., M.Div.  
Your Personal Training Assistant! 
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 LOGOS HAS NOT RELEASED ANY NEW FREE BOOKS…WILL KEEP YOU POSTED… 
 

 If you own an iPad, iPhone, iPod touch you can get free book previews 

o Visit: http://www.freebookpreview.com/ to learn more 

 Logos recently launched an eReader and eBook site: http://vyrso.com/giveaway.php 

 

 

       LINKS TO OPEN PANELS 

 

Have you ever opened up a dictionary and found it difficult to locate the passage you are studying? A special feature 

called “link to open panels” can assist you in this matter. I recommend turning this on for all your dictionaries and any 

books you frequently use. 

HOW TO:  

 Open your preferred Bible. (Click Library Icon, then choose NASB). Go to the passage, Exodus 20:3. 

 

 Click the visual filters icon, then click the box labeled “Links to open panels” 

 

 

 

http://www.freebookpreview.com/
http://vyrso.com/giveaway.php
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 Now that we have our Bible set up, we need to link our dictionary.  Click Here to open the BDB dictionary. 

Note: You can open any book and apply this feature, so if you don’t own the BDB, try opening a different dictionary. 

 Just as we did in Step 2, click the “visual filters” icon, then click in the box labeled “Links to open panels” 

 

 So what does this “link to open panels” look like? See the highlighted scripture below. 

 

Note: As you can see, it is nicely highlighted. This is the easy way to spot your Bible passage among so many other 

scripture references! 

 

 
  

 

logosres:bdb;hw=$D7$94$D6$B8$D7$99$D6$B8$D7$94;off=19194
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      WHO PRAYED IN THE NT? … USING SYNTAX. 
 

HOW TO:  

 Let’s go to 1 Thessalonians 5:17 

 Right click on the word “pray” > choose Selection (at the right) Note: choose the English word 

 Choose “copy” from the menu at the left.  

 

 Choose “Search” 

 

 Choose “Syntax”  

 

 Choose OpenText > Choose Query 
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 Choose “Predicator (OpenText.org)” 

 

 Right click in the box labeled Predicator (OpenText.org) and choose “Paste” 

from the menu 

 

 Click “Go” 

 

 Let’s examine the search results. Note: You may need to add an English 

version to read the Biblical text since the search results are in Greek. 

 

 

 

 

http://www.LearnLogos.com
http://www.LearnLogos.com
http://www.LearnLogos.com
http://www.LearnLogos.com
http://www.LearnLogos.com
http://www.LearnLogos.com
http://www.LearnLogos.com
http://www.LearnLogos.com
http://www.LearnLogos.com
http://www.LearnLogos.com
http://www.LearnLogos.com
http://www.LearnLogos.com
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Click One, Click Both! 

 

          

 

        TWO WAYS TO ORGANIZE YOUR NOTES FOR THEOLOGICAL ANALYSIS 
 

If you are trying to discover the theological theme of a passage, you will need to plan ahead and determine how you will 

organize your research.  Let’s examine Ephesians 2:1-2 and identify all the possible theological themes and organize 

them two ways: Expositionally & Topically. 

The 12 Theological themes are as follows: 

1) Bible (Bibliology)    7) Man (Anthropology) 

2) God the Father (Theology)   8) Sin (Hamartiology) 

3) God the Son (Christology)   9) Salvation (Soteriology) 

4) God the Holy Spirit (Pneumatology)  10) Israel (Israelology)  

5) Angels (Angelology)    11) Church (Ecclesiology) 

6) Demons (Demonology)    12) Future Things (Eschatology) 

HOW TO:  

WAY #1: EXPOSITIONAL (VERSE BY VERSE) 

Note: Bolding, italicizing added for emphasis 

Ephesians 2:1 (VERSE) 

Theological Theme Key Phrase 

Man/Anthropology  And you 

Sin/Hamartiology  were dead in trespasses and sins 

 

50% Off 

Learn at 
Your Pace 

http://www.learnlogos.com/index.php?option=com_content&view=article&id=84
http://www.learnlogos.com/index.php?option=com_content&view=article&id=78:distant-education-class-outline&catid=65
http://www.learnlogos.com/index.php?option=com_content&view=article&id=84
http://www.learnlogos.com/index.php?option=com_content&view=article&id=78:distant-education-class-outline&catid=65
http://www.learnlogos.com/index.php?option=com_content&view=article&id=84
http://www.learnlogos.com/index.php?option=com_content&view=article&id=78:distant-education-class-outline&catid=65
http://www.learnlogos.com/index.php?option=com_content&view=article&id=84
http://www.learnlogos.com/index.php?option=com_content&view=article&id=78:distant-education-class-outline&catid=65
http://www.learnlogos.com/index.php?option=com_content&view=article&id=84
http://www.learnlogos.com/index.php?option=com_content&view=article&id=78:distant-education-class-outline&catid=65
http://www.learnlogos.com/index.php?option=com_content&view=article&id=84
http://www.learnlogos.com/index.php?option=com_content&view=article&id=78:distant-education-class-outline&catid=65
http://www.learnlogos.com/index.php?option=com_content&view=article&id=84
http://www.learnlogos.com/index.php?option=com_content&view=article&id=78:distant-education-class-outline&catid=65
http://www.learnlogos.com/index.php?option=com_content&view=article&id=84
http://www.learnlogos.com/index.php?option=com_content&view=article&id=78:distant-education-class-outline&catid=65
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Ephesians 2:2 (VERSE) 

Theological Theme Key Phrase 

Man/Anthropology  in which you 

Sin/Hamartiology  formerly walked according to the course of this world, 

Demons/Demonology  according to the prince of the power of the air, of the spirit that is now working in the sons of… 

WAY #2: THEOLOGICAL (TOPICAL) 

Man/Anthropology (THEOLOGICAL THEME) 

Verse Key Phrase 

2:1  and you 

2:2  in which you 

Sin/Hamartiology (THEOLOGICAL THEME) 

Verse Key Phrase 

2:1  were dead in trespasses and sins 

2:2  formerly walked according to the course of this world 

 

Demons/Demonology (THEOLOGICAL THEME) 

Verse Key Phrase 

 2:2  according to the prince of the power of the air, of the spirit that is now working in the sons of… 

Conclusion: 

As you can see by these two organizational schemes, you should be able to see the theological themes and determine 

which one to emphasize. By the way, you can store these in one note file, multiple note files, or even create a passage 

list titled with your theological theme. 
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      THE ACTIONABLE OUTLINE 

Using verbs in a teaching/preaching outline is one of the most effective ways to communicate the Biblical Text. The 

verbs of any Biblical text convey not only the action of the passage but they carry the main idea. However, simply 

throwing a lot of verbs at the audience won’t necessarily improve your communication skills. You need a strategy, you 

need an actionable outline! 

HOW TO:  

 Let’s choose a passage you are familiar with, Matthew 28:19-20. I will structure this passage and highlight the main 

and subordinates verbs. To get more training on this subject, purchase the Bundle training CD/Download where you 

learn about many more subjects related to Logos 4. I have colored the main verbs in red, the primary supporting verbs in 

green, and other supporting verbs in orange.  

 Structure the text and create a preliminary outline1 

 

The Preliminary Outline: 
 

I. Make Disciples 
a. Go 
b. Baptizing 
c. Teaching 

II. I am 
a. With you always 
b. To the end of the age 

 

 Next, we need to refine/convert our raw, preliminary outline based on the verbs of the passage to an actionable 

outline. (Note the verbs are italicized) 

I. Do you know the process of “Making Disciples”? 

a. Step 1: Evangelize by engaging the lost 

b. Step 2: Enlist by baptizing the repentant 

c. Step 3: Educate by teaching the Bible 

II. Are you relying on the person of Christ? 

a. Jesus will be with you always 

b. Jesus has pledged to finish the work of the Church 

                                                           
1 See Best Practices, Disc 2/2, Lesson 5 Observing the Text, Exercises 6 & 7 
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THE PERFECT CROSS REFERENCE: WORD STUDIES,  

  POWER LOOKUP, AND THE PASSAGE LIST 
 

Anybody reading the Bible can benefit from a few good cross references. In fact, cross referencing is an important skill 

for interpreting the Bible. For there is no better way to interpret the Bible than with the Bible! Fortunately, you have 

Logos 4. It was not that long ago where the only way to find good cross references was with the treasury of scripture 

knowledge or some academic commentaries. 

As we stated in the last newsletter, there are three types of cross-references: word, phrase and topic. 

To keep our cross references relevant we are going to combine three tools: the Bible Word Study Report, Power Lookup, 

and the passage list. 

HOW TO:  

  Click the Library icon at the top left 

 

 Type ESV in the find box 

 

  

logosres:tsk2008;ref=Bible.Mt28.19
logosres:tsk2008;ref=Bible.Mt28.19
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 Enter 1 Peter 1:2 in the Bible Reference Box, and press Enter 

 

 Right click on the word foreknowledge and choose Lemma from the menu, then choose Search this resource. 

Note:  You should get two search results (Acts 2:23, 1 Peter 1:2) 

 

 Click on the Resource Panel and choose Save as Passage List 

 

  

http://www.learnlogos.com
http://www.learnlogos.com
http://www.learnlogos.com
http://www.learnlogos.com
http://www.learnlogos.com
http://www.learnlogos.com
http://www.learnlogos.com
http://www.learnlogos.com
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 Click on the pencil icon and rename the passage list to foreknowledge 

Note: You now have saved both passages to your passage list from your concordance search 

 

 Once again, right click on the word foreknowledge and choose Lemma from the menu, then choose Bible Word 

Study 

 

 

 In the Lemma Section of the Bible Word Study Report, locate and click on DBL Greek 
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 Now that our dictionary is open, right click on the number 1.715 located next to the abbreviation TDNT, and choose 

TDNT from the list. 

Note: All we are trying to do is open the TDNT to the word we are studying. If TDNT is not in this list, than you may have 

to open the book through the Library. TDNT is available for Scholars collection and higher. 
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 With the TDNT open to our word, go to the main menu and choose Tools > Power Look up 

 

Note: The Power Lookup tool scans your book and displays the cross references. 

If you like the cross reference, then simply type it in the reference box to add it to your list of references. 
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                   3 QUESTIONS EVERY APPLICATION MUST ANSWER 
 

Many times teachers and preachers draw from their own experience for an application. This can be a good strategy now 

and then. A better strategy is to find Biblical examples of those who obeyed (examples to follow) as well as those who 

disobeyed (warnings not to follow). Not only will this help you grow in your familiarity with the Bible but it can show the 

consequences of obeying or disobeying. With this in mind, consider the following four questions to help you and others 

apply the Biblical text in your life. Every application should be run through this grid of questioning. 

Let’s explore a command from Jesus, Matthew 5:44, “Love your enemies” through this “grid of questioning”. 

Thinking: (James 3:13-18, Philippians 4:8) 

 What is the right/Christ-like way to think about this matter? 

 What is the wrong/Man-centered way to think about this matter? 

Speaking: (James 1:1-12, Colossians 4:6, Ephesians 4:29) 

 What should not be said? 

 What should be said? 

Doing - Put Off/Put On: (Colossians 3:8-17, Ephesians 4:17-32, 1 Peter 3:8-9, 2 Peter 2:5-11, Romans 12-15) 

 Look at Colossians 3:8-9, Ephesians 4:25-31 and examine these lists and see what needs to be Put Off/Laid Aside  

to “love your enemy” 

 Look to Colossians 3:10-17, Ephesians 4:32, etc. and examine these lists and see what needs to be Put On to 

“love your enemy”  

Here is a great search to discover “one another” passages in the NT: 

 Search > Morph Search > @v WITHIN 2 WORDS lemma:ἀλλήλων 

Click here to run the search 

Here is a great search to discover all the “commands” passages of the NT: 

Note: Keep in mind, this finds all commands so remember “context is king” to determine relevancy 

 @V??M2 -behold -lemma:ἰδού 

Click here to run the search 

 

  

logos4:Search;kind=Morph;q=@v_WITHIN_2_WORDS_lemma:$E1$BC$80$CE$BB$CE$BB$CE$AE$CE$BB$CF$89$CE$BD_;match=nostem
logos4:Search;kind=Morph;q=@V$3F$3FM2_-behold_-lemma:$E1$BC$B0$CE$B4$CE$BF$CF$8D;match=nostem
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SEARCH FIELDS: A FANTASTIC TREASURE TROVE FOR SAVVY SEARCHERS! 

To really supercharge your searches and find what you are looking for in your vast digital library, you need to get a 

handle on “Search Fields”. Search fields are specially tagged information that allow you to narrow your search and find 

specific information in a book. An example of a search field that you would recognize is the “Words of Christ”. As you 

can imagine, searching just the “Words of Christ” is easier than searching the whole Bible. 

Search fields can differ from book to book. So let me walk you through the process of field searching. 

HOW TO:  

  Let’s begin with a Bible. Click the Library icon at the top left 

 

 Type ESV in the find box 
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 At the far right, click the information button 

 

 Scroll down (using the vertical scroll bar at the right) to the bottom until you see the section labeled: Search Fields 

Note: Here are the Search Fields for the NASB95. As you can see there are quite a few. 

 

The next step is to create a search using these search fields. 

 Click on Search icon at the top left. 

 

 Choose Basic search 

 

  



 

 
17 

 Be sure you choose to search the book with the search fields, which in this case is the NASB95 

 

 Let’s search only the heading field. Type the following:  heading:seed and then press return 

Note: to search on the field, you need to simply type the name of the field, followed by a colon. 

 

Note: For phrases, place them in quotes. There is no need for a space after the colon. 

Example: heading:"parable of" 
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        MAPS & CHARTS BOOKS 

Nelson's Complete Book of Bible Maps and Charts Revised 
This book is packed full of visual aids to help you understand the Bible. Includes maps, charts, tables, and surveys.  

This book is 512 pages! In it you will find: 

 Reproducible maps and charts to help you visualize and teach the events, places, and people in the OT/NT 

 Easy-to-understand tables 

 Overviews 

 Maps 

 Surveys 

 Timelines  

 

 
Retail: $ 19.99 

 
It may also be found in: 
 

 
Retail: $ 29.99 (better value!) 

 

Here is a sample: 

 

 

 

 

 

 

 

 

 

http://www.logos.com/product/1206/nelsons-complete-book-of-bible-maps-and-charts-revised
http://rejoicesoftware.com/tnbsl_details.htm
http://www.logos.com/product/1206/nelsons-complete-book-of-bible-maps-and-charts-revised
http://rejoicesoftware.com/tnbsl_details.htm
http://www.logos.com/product/1206/nelsons-complete-book-of-bible-maps-and-charts-revised
http://rejoicesoftware.com/tnbsl_details.htm
http://www.logos.com/product/1206/nelsons-complete-book-of-bible-maps-and-charts-revised
http://rejoicesoftware.com/tnbsl_details.htm
http://www.logos.com/product/1206/nelsons-complete-book-of-bible-maps-and-charts-revised
http://rejoicesoftware.com/tnbsl_details.htm
http://www.logos.com/product/1206/nelsons-complete-book-of-bible-maps-and-charts-revised
http://rejoicesoftware.com/tnbsl_details.htm
http://www.logos.com/product/1206/nelsons-complete-book-of-bible-maps-and-charts-revised
http://rejoicesoftware.com/tnbsl_details.htm
http://www.logos.com/product/1206/nelsons-complete-book-of-bible-maps-and-charts-revised
http://rejoicesoftware.com/tnbsl_details.htm
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Note: With all 66 books of the Bible covered, this will help any Bible Study! 

 

 

NUMBERS: WHAT RESOURCES WOULD YOU RECOMMEND? 
 

Exegetical Commentaries 

Word Biblical Commentary: Numbers 

NICOT: The Book of Numbers 

ICC: A Critical and Exgetical Commentary on Numbers 

 

Expositional Commentaries 

The New American Commentary: Numbers 

Preaching the Word: Numbers – God’s Presence in the Wilderness 

The Pulpit Commentary: Numbers 

Lange’s Commentary: Numbers 

ITC: Journeying with God: Numbers 

JPS Torah Commentary: Numbers 

Introductory Commentaries 

Be Counted:  Wiersbe, Warren W. 
Wesley’s Notes: Numbers 

Outlines 

The Book of Numbers by Gingrich, Roy 

Create a collection of your Exodus Commentaries 

Collection Name: Numbers Resources  

Collection Rule: subject:numbers 

Note: To create a collection: Tools > Collection 

 

 

http://www.logos.com/product/1349/word-biblical-commentary-volume-5-numbers
http://www.logos.com/product/5185/the-new-international-commentary-on-the-old-and-new-testament
http://www.logos.com/product/4104/a-critical-and-exegetical-commentary-on-numbers
http://www.logos.com/product/2050/the-new-american-commentary-numbers
http://www.logos.com/product/3169/numbers-gods-presence-in-the-wilderness
http://www.logos.com/product/5768/the-pulpit-commentary
http://www.logos.com/product/5759/langes-commentary-on-the-holy-scriptures
http://www.logos.com/product/3385/journeying-with-god-a-commentary-on-the-book-of-numbers
http://www.logos.com/product/3932/the-jps-torah-commentary-numbers
http://www.logos.com/product/2556/be-counted
http://www.logos.com/product/9130/john-wesley-collection
http://www.logos.com/product/8290/the-book-of-numbers
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7 KEY PRINCIPLES OF JESUS PRAYER LIFE, Part 3/7 
 

PRINCIPLE #3 

Jesus demonstrates to us the need to seek guidance in prayer in anticipation of upcoming decisions and events.  Seeking 

God’s wisdom (James 1:5) and will in these matters through prayer and His Word, must not be neglected regardless of 

the activities that may be required to plan and prepare for ministering. 

A) Jesus Prayed Before Significant Decisions: Apostles Chosen.  

One of the more remarkable passages of prayer is Luke 6:12-16, the choosing of the twelve apostles.  Specifically in Luke 

6:12 are two points that need emphasizing.  First is the phrase ‘He spent the whole night’ and ‘prayer to God’.  Jesus 

spent the whole night watching and persevering in this vigil (Louis Godet, A Commentary on the Gospel of St. Luke, p. 

299) and coupled with ‘prayer to God’ which is an objective genitive not a subjective genitive (Daniel B. Wallace, Greek 

Grammar Beyond the Basics - Exegetical Syntax of the New Testament, p. 117).  Therefore, grammatically, we may 

conclude that Jesus communed with the Father in a specific prayer about the decision to choose the twelve apostles, 

setting aside the second priority of sleep. 

B) Jesus Prayed Before Significant Events: Betrayal, Arrest, & Cross.   

In one of the most revealing passages into the mind and heart of Christ regarding His death on the cross we see three 

prayers of petition by the Lord Jesus Christ in the garden of Gethsemane (Matthew 26:36-46, Mark 14:32–42; Luke 

22:40–46).  First, we have Jesus withdrawing with several close disciples, and then, secondly, withdrawing Himself from 

them to pray alone.  We see how Jesus prayed about His death on the cross that was about to take place and the sin 

bearing and resulting defilement from man’s iniquity. No doubt His agony is reflected in these prayers/petitions (John F. 

MacArthur, Matthew Commentary 24-28, p. 170).  Three supplications were offered and stand before us never to forget 

that in the face of any trial, difficulty, and/or decision, we must call upon the Lord in prayer. 

  

logosres:nasb95;ref=BibleNASB95.Jas1.5
logosres:nasb95;ref=BibleNASB95.Lk6.12-16
logosres:gs-ggbtb;ref=Page.p_116;off=1270
logosres:gs-ggbtb;ref=Page.p_116;off=1270
logosres:nasb95;ref=BibleNASB95.Mt26.36-46
logosres:nasb95;ref=BibleNASB95.Mk14.32-42
logosres:nasb95;ref=BibleNASB95.Lk22.40-46
logosres:nasb95;ref=BibleNASB95.Lk22.40-46
logosres:mattmntc;ref=Bible.Mt26.36;off=3409
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INTRODUCTIONS: SUGGESTIONS TO CAPTURE THE AUDIENCE’S ATTENTION 
 

Here are some ideas for your next introduction for teaching and preaching. 

 Place a familiar idea inside an unfamiliar setting 

 Employ a rhetorical question 

 Share a startling fact 

 Provide a provocative comment 

 Illustrate a Paradox 

 A touch of humor 

 Begin a story 

 Utilize a confrontive statement 

 Let the passage introduce 

Don’t forget that introductions should uncover and address a need (make it personal), introduce the sermon, overview 

the sermon points, connect it to the Biblical passage, and make it urgent/pressing. 

Don’t forget to check out and sign-up for Sermon Central’s Better Preaching eNewsletter.  

http://www.sermoncentral.com/?ShowNewsletterSignup=true&utm_source=newsletter&utm_medium=email&utm_campaign=BetterPreachingUpdate
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BIBLE CROSS-REFERENCING 
 

Q1: John, how do you personally use cross referencing in your sermons? 

A1: I use Biblical cross references in the following way: 

 Repeat the point: I am looking for another Bible verse that states the exact same idea. It may be a parallel passage or 

an OT quote in the NT, or vice versa. 

 Expand the point: In this instance I am looking to “fill out” the idea. You will want to provide additional cross 

references that deepens the understanding. For example, if I am talking about the topic of love for family, I might cross 

reference to Ruth. 

 Contrast the point: These kinds of cross references are important, especially if you want to make a strong point. Just 

look at the Book of Proverbs, they are filled with them! 

 Additionally, I use between two to three cross references 

 Lastly, I typically place my cross references after my explanation. However, on occasion I place them before or in the 

middle of my exposition. 

 

Email me your questions, and maybe you will be in the next newsletter! tips@learnlogos.com 
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Welcome! More than a Manual… 
If you like this eNewsletter let us know and tell others on Facebook! Now let’s get ready to LearnLogos! 

Note: You can click on the colored links above and it will take you to LearnLogos.com to learn more about all of the 

available training products. There are other types of links in this document: book links, Scripture links, and more. Click 

on them too! 

Thanks and Enjoy! 

John Fallahee, President/CEO & Video Trainer 

RECENT NEWS 
 Brand new website launched! Check it out LearnLogos.com  

 

 Update to Training CDs Released - 60 New Videos / 7 Hours of Training Released – Check it out, click here 

Download Only 

 
 

 More Webinars Released! Only $ 9.99 $ 4.99 for each download. 

 Click Here to learn more 

o Inductive Bible Study for Logos 4 (12 Webinars Available) 

o Studying the Bible with Logos 4 (12 Webinars Available) 

o Preparing Sermons with Logos 4 (12 Webinars Available) 

Note: Most webinars are 1 ½ hours in length! Amazing value! 

 

 36 New Webinars coming starting in November! 

Volume 6, Issue 2/2 John Fallahee, M.B.A., M.Div.  
Your Personal Training Assistant! 

http://www.learnlogos.com/index.php?option=com_content&view=article&id=84
http://www.learnlogos.com/index.php?option=com_content&view=article&id=77:webinar-schedule&catid=60
http://learnlogos.com/index.php?option=com_content&view=article&id=76:learn-more&catid=66
http://learnlogos.com/index.php?option=com_content&view=article&id=78:distant-education-class-outline&catid=65
http://learnlogos.com/index.php?option=com_content&view=article&id=81:personalized-training-overview&catid=64
http://learnlogos.com/index.php?option=com_content&view=article&id=82:tips-trick-and-help&catid=62
http://www.facebook.com/learnlogos
http://www.learnlogos.com/
http://www.learnlogos.com/Video_Updates_for_Overview_Best_Practices_Bundle_p/cd3.htm
http://www.learnlogos.com/category_s/1477.htm
http://www.learnlogos.com/Video_Updates_for_Overview_Best_Practices_Bundle_p/cd3.htm
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 The Pastor in Prayer by Spurgeon, Charles H. | 1893 

 Click Here for Free Book 

  

http://www.logos.com/product/6806/the-pastor-in-prayer


 

 
3 

 

 

THE GRID VIEW 

The grid view will help you see more books when you are viewing your library. In fact, you can double and nearly triple 

the number of books in your library view. 

HOW TO:  

 Go to the main toolbar and click the book icon labeled library 

 

 Go to the right of the find box and click View 

 

 Please note how you have more books in the library browser space. Here is a side by side comparison. 

        BEFORE: Your Original Library View  AFTER: Your Improved Library View 
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CHOOSING COLUMNS 

 

In the library view you can access additional information about a book, beyond just the title and author. This is especially 

important when trying to see ‘groups’ or ‘collections’ of books. 

HOW TO:  

 Go to the main toolbar and click the book icon labeled library 

 

 Right click on the column labeled “Title” 

Note: Here is a list of all the additional information associated with your books. The columns with the checkmark are 

viewable in your library browser view. The columns with no checkmark can be selected to be viewed. 
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 Click type or any unchecked item from the menu to add that column to your library browser view.  

Note: When you click an item from the list, the menu disappears. Therefore, you will have to repeat the steps 1-3 to 

select other items from the list. To remove a column, simply click an item from the list with a check mark. 

 

 If you scroll to the right with the horizontal scroll bar, you can view all the columns. 
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CHANGING THE ORDER OF THE COLUMNS 
 

Now that you have added all these new columns of information, over time, you will view some columns more than 

others. Therefore, it will be important to place the most frequently used columns to the left and the least frequently 

used columns to the right 

HOW TO:  

 Go to the main toolbar and click the book icon labeled library 

 

 Left click on a column name and drag it to your preferred position 

Note: The column name will go semi-transparent as you drag it to the left. A black line will appear between two 

columns to signify where the new column will be placed.  
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PRIORITIZING YOUR BOOKS 
 

Prioritizing your books in Logos 4 is an important step to take in optimizing your Logos experience. I don’t know about 

you, but there are so many reports and search results with links and information that I feel I am on a precipice ready to 

fall into the bottomless pit of “information overload”! Hence, the need to prioritize your books! 

Therefore, let’s identify and prioritize the most important and most frequently used books in your library. 

Categories 

Bibles: You need to choose five of your favorite 

Hebrew Dictionaries and Lexicons: Choose at least two (1 Concise, 1 in-depth) 

Greek Dictionaries and Lexicons: Choose at least two (1 Concise, 1 in-depth) 

Bible Dictionaries: Choose at least two (1 Concise, 1 in-depth) 

English Dictionaries: Choose one 

Commentaries: Choose one concise commentary  

Now you might be asking, “How do I prioritize my books?” I thought you would never ask. 

HOW TO: 

 Go to the main toolbar and click the book icon labeled library 

 

 At the far right of your Library browser/viewer, click prioritize. 
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 Using the find box in the library browser, type in the name of a book you wish to prioritize; say the NASB95 Bible. 

Once it appears in the library browser, drag it to the prioritize section. 

Note: I recommend left clicking on the title. When you drag, the book title will be a little transparent. Additionally, when 

you drag to the prioritize section at the right; you will see a black line, which signifies where the resource will be placed. 

 

Now you may be wondering what my priority list looks like, so I have included it below. Keep in mind, because every 

library is different, you may not have some of my resources listed below.  
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RIGHT CLICK ON A TITLE 
 

Hidden menus are powerful and usually a huge time saver, but they are not easy to find! One such hidden menu is found 

in the library browser view which makes adding and prioritizing a series a cinch! 

HOW TO: 

 Go to the main toolbar and click the book icon labeled library 

 

 In the find box, type the phrase opening up 

 

 Right click on the title of any one of the “opening up” titles in the library browser 
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 Choose from the menu Prioritize this series 

 

 Your “Opening Up” series has now been added to the end of your prioritization list 

Note:  You can now drag it to where you prefer in the list 
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PRAYERS IN THE PSALMS: Thanksgiving 
 

One of the most amazing books in the Bible is the book of Psalms. This book is rich for so many reasons: theology, 

types of prayers, heart of worship, the heights and depths of emotion, not to mention the prophecies of Christ and 

so much more! 

To know Psalms is not just to know David who penned the majority of this literature, but to know God! 

So let’s look at five types of prayers in Psalms: thanksgiving, lament, penitential, Messianic/Christ, and imprecatory 

prayer. For this exercise, let’s simply read the psalms, and take notes on what we learn. Let’s use this time to draw 

near to God. Don’t forget to click the link to the Psalm to have Logos open the Psalm for you. Additionally, I have 

added a link to the passage guide so that if you wish to study further, you can learn more about the Psalm through 

the Passage Guide and Exegetical Guide. By the way, some Psalms mix these themes and therefore, may repeat in 

the lists below. 

In your notes, use the outline in section  for  

observing the text and taking notes: 

HOW TO: 

 File > Notes 

  

 Rename the note file to Notes on Psalms by clicking on the pencil icon. 

 

 

 

 Click add note and begin taking notes 

http://www.LearnLogos.com
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 Here are five specific observational questions to get you started 

 

Bonus: Click Here to run a search that will find some psalms regarding prayers of thanksgiving in the NASB.  

 

Psalms of Thanksgiving: 

Psalm Passage Guide Exegetical Guide 
Psalm 8 Click Here Click Here 

Psalm 18 Click Here Click Here 
Psalm 19 Click Here Click Here 
Psalm 29 Click Here Click Here 
Psalm 30 Click Here Click Here 
Psalm 32 Click Here Click Here 
Psalm 33 Click Here Click Here 
Psalm 34 Click Here Click Here 
Psalm 40 Click Here Click Here 
Psalm 41 Click Here Click Here 
Psalm 66 Click Here Click Here 

Psalm 103 Click Here Click Here 
Psalm 104 Click Here Click Here 
Psalm 105 Click Here Click Here 
Psalm 106 Click Here Click Here 
Psalm 111 Click Here Click Here 

   
 

logos4:Search;kind=Basic;q=thanksgiving_WITHIN_10_WORDS_psalm;match=stem
logosref:Bible.Ps8
logos4:Guide;t=Passage_Guide;ref=BibleNASB95.Ps8.1-9
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps8
logosref:Bible.Ps18
logos4:Guide;t=Passage_Guide;ref=Bible.Ps18
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps18
logosref:Bible.Ps19
logos4:Guide;t=Passage_Guide;ref=Bible.Ps19
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps19
logosref:Bible.Ps29
logos4:Guide;t=Passage_Guide;ref=Bible.Ps29
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps29
logosref:Bible.Ps30
logos4:Guide;t=Passage_Guide;ref=Bible.Ps30
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps30
logosref:Bible.Ps32
logos4:Guide;t=Passage_Guide;ref=Bible.Ps32
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps32
logosref:Bible.Ps33
logos4:Guide;t=Passage_Guide;ref=Bible.Ps33
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps33
logosref:Bible.Ps34
logos4:Guide;t=Passage_Guide;ref=Bible.Ps34
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps34
logosref:Bible.Ps40
logos4:Guide;t=Passage_Guide;ref=Bible.Ps40
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps40
logosref:Bible.Ps41
logos4:Guide;t=Passage_Guide;ref=Bible.Ps41
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps41
logosref:Bible.Ps66
logos4:Guide;t=Passage_Guide;ref=Bible.Ps66
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps66
logosref:Bible.Ps103
logos4:Guide;t=Passage_Guide;ref=Bible.Ps103
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps103
logosref:Bible.Ps104
logos4:Guide;t=Passage_Guide;ref=Bible.Ps104
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps104
logosref:Bible.Ps105
logos4:Guide;t=Passage_Guide;ref=Bible.Ps105
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps105
logosref:Bible.Ps106
logos4:Guide;t=Passage_Guide;ref=Bible.Ps106
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps106
logosref:Bible.Ps111
logos4:Guide;t=Passage_Guide;ref=Bible.Ps111
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps111
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PRAYERS IN THE PSALMS: Lament  
 

HOW TO:  

 Here are five specific observational questions to get you started 

 

Bonus: Click Here to run a search that will find some psalms regarding prayers of lament in the NASB.  

 

Psalms of Lament: 

Psalm Passage Guide Exegetical Guide 
Psalm 3 Click Here Click Here 
Psalm 4 Click Here Click Here 
Psalm 5 Click Here Click Here 

Psalm 12 Click Here Click Here 
Psalm 13 Click Here Click Here 
Psalm 22 Click Here Click Here 
Psalm 35 Click Here Click Here 
Psalm 37 Click Here Click Here 
Psalm 38 Click Here Click Here 
Psalm 39 Click Here Click Here 
Psalm 40 Click Here Click Here 
Psalm 42  Click Here Click Here 
Psalm 43 Click Here Click Here 
Psalm 44 Click Here Click Here 
Psalm 54 Click Here Click Here 
Psalm 55 Click Here Click Here 

logos4:Search;kind=Basic;q=(rescue,_lament)_WITHIN_10_WORDS_psalm;match=stem
logosref:Bible.Ps3
logos4:Guide;t=Passage_Guide;ref=Bible.Ps3
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps3
logosref:Bible.Ps4
logos4:Guide;t=Passage_Guide;ref=Bible.Ps4
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps41
logosref:Bible.Ps5
logos4:Guide;t=Passage_Guide;ref=Bible.Ps5
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps5
logosref:Bible.Ps12
logos4:Guide;t=Passage_Guide;ref=Bible.Ps12
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps12
logosref:Bible.Ps13
logos4:Guide;t=Passage_Guide;ref=Bible.Ps13
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps13
logosref:Bible.Ps22
logos4:Guide;t=Passage_Guide;ref=Bible.Ps22
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps22
logosref:Bible.Ps35
logos4:Guide;t=Passage_Guide;ref=Bible.Ps35
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps35
logosref:Bible.Ps37
logos4:Guide;t=Passage_Guide;ref=Bible.Ps37
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps37
logosref:Bible.Ps38
logos4:Guide;t=Passage_Guide;ref=Bible.Ps38
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps38
logosref:Bible.Ps39
logos4:Guide;t=Passage_Guide;ref=Bible.Ps39
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps39
logosref:Bible.Ps40
logos4:Guide;t=Passage_Guide;ref=Bible.Ps40
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps40
logosref:Bible.Ps42
logos4:Guide;t=Passage_Guide;ref=Bible.Ps42
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps42
logosref:Bible.Ps43
logos4:Guide;t=Passage_Guide;ref=Bible.Ps43
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps43
logosref:Bible.Ps44
logos4:Guide;t=Passage_Guide;ref=Bible.Ps44
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps44
logosref:Bible.Ps54
logos4:Guide;t=Passage_Guide;ref=Bible.Ps54
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps54
logosref:Bible.Ps55
logos4:Guide;t=Passage_Guide;ref=Bible.Ps55
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps55
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Psalm 56 Click Here Click Here 
Psalm 57 Click Here Click Here 
Psalm 59 Click Here Click Here 
Psalm 60 Click Here Click Here 
Psalm 61 Click Here Click Here 
Psalm 63 Click Here Click Here 
Psalm 64 Click Here Click Here 
Psalm 69  Click Here Click Here 
Psalm 70 Click Here Click Here 
Psalm 71 Click Here Click Here 
Psalm 74 Click Here Click Here 
Psalm 79  Click Here Click Here 
Psalm 80  Click Here Click Here 
Psalm 83 Click Here Click Here 
Psalm 85  Click Here Click Here 
Psalm 86 Click Here Click Here 
Psalm 88  Click Here Click Here 
Psalm 90  Click Here Click Here 

Psalm 109 Click Here Click Here 
Psalm 120 Click Here Click Here 
Psalm 123  Click Here Click Here 
Psalm 140  Click Here Click Here 
Psalm 141 Click Here Click Here 
Psalm 142  Click Here Click Here 

 

 

 

 

 
Click One, Click Both! 

  

50% Off 

Learn at 
Your Pace 

logosref:Bible.Ps56
logos4:Guide;t=Passage_Guide;ref=Bible.Ps56
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps56
logosref:Bible.Ps57
logos4:Guide;t=Passage_Guide;ref=Bible.Ps57
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps57
logosref:Bible.Ps59
logos4:Guide;t=Passage_Guide;ref=Bible.Ps59
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps59
logosref:Bible.Ps60
logos4:Guide;t=Passage_Guide;ref=Bible.Ps60
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps60
logosref:Bible.Ps61
logos4:Guide;t=Passage_Guide;ref=Bible.Ps61
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps61
logosref:Bible.Ps63
logos4:Guide;t=Passage_Guide;ref=Bible.Ps63
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps63
logosref:Bible.Ps64
logos4:Guide;t=Passage_Guide;ref=Bible.Ps64
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps64
logosref:Bible.Ps69
logos4:Guide;t=Passage_Guide;ref=Bible.Ps69
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps69
logosref:Bible.Ps70
logos4:Guide;t=Passage_Guide;ref=Bible.Ps70
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps70
logosref:Bible.Ps71
logos4:Guide;t=Passage_Guide;ref=Bible.Ps71
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps71
logosref:Bible.Ps74
logos4:Guide;t=Passage_Guide;ref=Bible.Ps74
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps74
logosref:Bible.Ps79
logos4:Guide;t=Passage_Guide;ref=Bible.Ps79
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps79
logosref:Bible.Ps80
logos4:Guide;t=Passage_Guide;ref=Bible.Ps80
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps80
logosref:Bible.Ps83
logos4:Guide;t=Passage_Guide;ref=Bible.Ps83
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps83
logosref:Bible.Ps85
logos4:Guide;t=Passage_Guide;ref=Bible.Ps85
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps85
logosref:Bible.Ps86
logos4:Guide;t=Passage_Guide;ref=Bible.Ps86
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps86
logosref:Bible.Ps88
logos4:Guide;t=Passage_Guide;ref=Bible.Ps88
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps88
logosref:Bible.Ps90
logos4:Guide;t=Passage_Guide;ref=Bible.Ps90
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps90
logosref:Bible.Ps109
logos4:Guide;t=Passage_Guide;ref=Bible.Ps109
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps109
logosref:Bible.Ps120
logos4:Guide;t=Passage_Guide;ref=Bible.Ps120
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps120
logosref:Bible.Ps123
logos4:Guide;t=Passage_Guide;ref=Bible.Ps123
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps123
logosref:Bible.Ps140
logos4:Guide;t=Passage_Guide;ref=Bible.Ps140
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps140
logosref:Bible.Ps141
logos4:Guide;t=Passage_Guide;ref=Bible.Ps141
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps141
logosref:Bible.Ps142
logos4:Guide;t=Passage_Guide;ref=Bible.Ps142
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps142
http://www.learnlogos.com/index.php?option=com_content&view=article&id=84
http://www.learnlogos.com/index.php?option=com_content&view=article&id=78:distant-education-class-outline&catid=65


 

 
15 

 

 

PRAYERS IN THE PSALMS: Prayers of Repentance 
 

HOW TO:  

 Here are five specific observational questions to get you started 

 

Bonus: Click Here to run a search that will find some psalms regarding prayers of repentance in the NASB.  

 

Psalms of Lament: 

Psalm Passage Guide Exegetical Guide 
Psalm 6 Click Here Click Here 

Psalm 32  Click Here Click Here 
Psalm 38 Click Here Click Here 
Psalm 51 Click Here Click Here 

Psalm 102 Click Here Click Here 
Psalm 130 Click Here Click Here 
Psalm 143 Click Here Click Here 

 

  

logos4:Search;kind=Basic;q=(mercy,_sinner)_WITHIN_10_WORDS_psalm;match=stem
logosref:Bible.Ps6
logos4:Guide;t=Passage_Guide;ref=Bible.Ps6
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps6
logosref:Bible.Ps32
logos4:Guide;t=Passage_Guide;ref=Bible.Ps32
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps32
logosref:Bible.Ps38
logos4:Guide;t=Passage_Guide;ref=Bible.Ps38
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps38
logosref:Bible.Ps51
logos4:Guide;t=Passage_Guide;ref=Bible.Ps51
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps51
logosref:Bible.Ps102
logos4:Guide;t=Passage_Guide;ref=Bible.Ps102
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps102
logosref:Bible.Ps130
logos4:Guide;t=Passage_Guide;ref=Bible.Ps130
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps130
logosref:Bible.Ps143
logos4:Guide;t=Passage_Guide;ref=Bible.Ps143
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps143
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PRAYERS IN THE PSALMS: Messianic (Christ) 
 

HOW TO:  

 Here are five specific observational questions to get you started 

 

Bonus: Click Here to run a search that will find some Messianic psalms in the NASB.  

 

Messianic Psalms: 

Psalm Passage Guide Exegetical Guide 
Psalm 7 Click Here Click Here 

Psalm 35  Click Here Click Here 
Psalm 40 Click Here Click Here 
Psalm 55 Click Here Click Here 
Psalm 59 Click Here Click Here 

Psalm 110 Click Here Click Here 

 

  

logos4:Search;kind=Basic;q=(anointed,_king,_portion,_covenant)_WITHIN_10_WORDS_psalm;match=stem
logosref:Bible.Ps7
logos4:Guide;t=Passage_Guide;ref=Bible.Ps7
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps7
logosref:Bible.Ps35
logos4:Guide;t=Passage_Guide;ref=Bible.Ps35
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps35
logosref:Bible.Ps40
logos4:Guide;t=Passage_Guide;ref=Bible.Ps40
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps40
logosref:Bible.Ps55
logos4:Guide;t=Passage_Guide;ref=Bible.Ps55
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps55
logosref:Bible.Ps59
logos4:Guide;t=Passage_Guide;ref=Bible.Ps59
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps59
logosref:Bible.Ps110
logos4:Guide;t=Passage_Guide;ref=Bible.Ps110
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps110
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PRAYERS IN THE PSALMS: Imprecatory Prayer 
 

HOW TO:  

 Here are five specific observational questions to get you started 

 

Bonus: Click Here to run a search that will find some imprecatory psalms in the NASB.  

 

Imprecatory Psalms: 

Psalm Passage Guide Exegetical Guide 
Psalm 7 Click Here Click Here 

Psalm 35  Click Here Click Here 
Psalm 40 Click Here Click Here 
Psalm 55 Click Here Click Here 
Psalm 59 Click Here Click Here 
Psalm 69 Click Here Click Here 
Psalm 79 Click Here Click Here 

Psalm 109  Click Here Click Here 
Psalm 137 Click Here Click Here 
Psalm 139 Click Here Click Here 
Psalm 144 Click Here Click Here 

 
 

 

logos4:Search;kind=Basic;q=(vengeance,_enemy)_WITHIN_10_WORDS_psalm;match=stem
logosref:Bible.Ps7
logos4:Guide;t=Passage_Guide;ref=Bible.Ps7
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps7
logosref:Bible.Ps35
logos4:Guide;t=Passage_Guide;ref=Bible.Ps35
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps35
logosref:Bible.Ps40
logos4:Guide;t=Passage_Guide;ref=Bible.Ps40
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps40
logosref:Bible.Ps55
logos4:Guide;t=Passage_Guide;ref=Bible.Ps55
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps55
logosref:Bible.Ps59
logos4:Guide;t=Passage_Guide;ref=Bible.Ps59
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps59
logosref:Bible.Ps69
logos4:Guide;t=Passage_Guide;ref=Bible.Ps69
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps69
logosref:Bible.Ps79
logos4:Guide;t=Passage_Guide;ref=Bible.Ps79
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps79
logosref:Bible.Ps109
logos4:Guide;t=Passage_Guide;ref=Bible.Ps109
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps109
logosref:Bible.Ps137
logos4:Guide;t=Passage_Guide;ref=Bible.Ps137
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps137
logosref:Bible.Ps139
logos4:Guide;t=Passage_Guide;ref=Bible.Ps139
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps139
logosref:Bible.Ps144
logos4:Guide;t=Passage_Guide;ref=Bible.Ps144
logos4:Guide;t=Exegetical_Guide;ref=Bible.Ps144
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RESEARCHING FOR GENERAL HISTORICAL BACKGROUND 
 

Researching historical background can be a daunting task for any passage of Scripture. When you consider the limited 

amount of data we have and the distance between those events from our own time; it’s amazing we have any insights 

into the past. However, with Logos and some key resources we can gather at least a good sketch and sometimes even 

more to gain an interpretative insight. So before you set off on your next archeological adventure in Logos 4, be sure to 

pack with your travel gear a good collection of resources.   

HOW TO: (Create a Collection)  

 Go to the main menu, and choose Tools, then choose Collections. 

 

 Name the Rule Historical Background Resources 

 

 Copy and Paste the complete rule below into the rule box 

Note: Even though you may not have all the resources in this rule, it will still work correctly. The collection comprises of 

commentaries with historical background information, archaeological resources, surveys, handbooks, dictionaries, 

encyclopedias, and more. 

 

(See next page for the rule) 
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Rule:  

"bible knowledge commentary" OR "teacher's commentary" OR "bible exposition commentary" OR "holman Concise 

Bible Commentary" OR "Commentary Critical" OR "opening up" OR "the new american commentary" OR "Holman New 

Testament Commentary" OR "Holman Old Testament Commentary" OR "the pulpit commentary" OR "NIGTC"  OR "Keil" 

OR title:"a handbook on" OR "Baker exegetical" OR "baker new testament commentary" OR "Believers Church Bible 

Commentary" OR "Believer's Church Bible Commentary" OR  "CCGNT" OR "pillar new testament" OR "horae" OR 

"International Critical Commentary" OR "macarthur new testament" OR "word biblical commentary" OR "exploring the 

old testament" OR "exploring the new testament" OR "summarized bible" OR "survey of old testament" OR "old 

testament survey series" OR title:"bible handbook" OR "jensen's survey" OR author:"donald guthrie" OR title:"easton's 

bible" OR title:"harper's bible" OR "new bible dictionary" OR title:"holman bible atlas" OR title:"exhaustive dictionary of 

bible names" OR title:"dictionary of bible themes" OR title:"eerdmans bible dictionary" OR title:"eerdmans dictionary" 

OR title:"archaeological encyclopedia of the" OR title:"oxford dictionary" OR title:"baker encyclopedia of the bible" OR 

title:"encyclopedia of christianity" OR title:"encyclopaedia of judaism" OR title:"dictionary of deities" OR ISBE OR 

title:"wycliffe bible encyclopedia" OR title:"anchor yale" OR "images of the holy land" OR title:"holy land" OR 

title:"biblical archaeologist" OR title:"archaeology odyssey" OR "Biblical archaeology society" OR title:"Bible Review" OR 

title:"new testament introduction" OR title:"survey of old testament introduction" -"lectionary" -"when skeptics ask" -

"handbook on world views" 

 Click the “x” to close the collection tab. 

 

 You are now ready to search this collection. Go to the main menu and choose Search, then Basic Search 

 

 Choose your new collection Historical Background Resources and type your search criteria. Here is one example: 
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RESEARCHING FOR GENERAL THEOLOGICAL BACKGROUND 
 

Researching theological background can be as challenging as researching historical background. Therefore, let’s take the 

same approach. Let’s identify a set of resources to serve our research needs. 

HOW TO: (Create a Collection)  

 Go to the main menu, and choose Tools, then choose Collections. 

 

 Name the Rule Theological Background Resources 

 

 Copy and Paste the complete rule below into the rule box 

Note: Even though you may not have all the resources in this rule, it will still work correctly. The collection comprises of 

key resources associated with theology. 

 

Rule:  

subject:theology OR title:theology OR title:systematic OR subject:doctrine OR author:pink OR title:"the cross and 

salvation" OR title:"no one like him" 
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 Click the “x” to close the collection tab. 

 

 You are now ready to search this collection. Go to the main menu and choose Search, then Basic Search 

 

 Choose your new collection Theological Background Resources and type your search criteria. Here is one example: 

 

 

 

  

http://www.learnlogos.com/index.php?option=com_content&view=article&id=81:personalized-training-overview&catid=64&Itemid=71
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CHURCH HISTORY 
 

Church history is an important topic to be familiar with when it comes to Bible Study. For example, you can research 

various interpretations of the Scriptures and doctrines from different time periods. In fact, with the right set of 

collections and in some cases, you can trace a doctrine over the centuries and see its impact even today! Wow! How 

cool is that!  Therefore, like our two previous examples, let’s create a collection and identify a set of resources to serve 

our research needs. 

HOW TO: (Create a Collection)  

 Go to the main menu, and choose Tools, then choose Collections. 

 

 Name the Rule Church History 

 

 Copy and Paste the complete rule below into the rule box 

Note: Even though you may not have all the resources in this rule, it will still work correctly. The collection comprises of 

key resources associated with theology. 

 

Rule:  

subject:"church history" OR title:"church history" OR "early christianity" OR "first christians" OR "Christian Origins" 
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 Click the “x” to close the collection tab. 

 

 You are now ready to search this collection. Go to the main menu and choose Search, then Basic Search 

 

 Choose your new collection Church History and type your search criteria. Here is one example: 

 

  

http://www.learnlogos.com/index.php?option=com_content&view=article&id=77:webinar-schedule&catid=60&Itemid=71
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ESCHATOLOGY/END TIMES: Book Review - Prophecy Knowledge Handbook 
 

One of the most fascinating topics in Scripture is prophecy. I would suggest that fulfilled prophecy and yet-to-be-filled 

prophecy are equally exciting and valuable in the truths they contain. Furthermore, one of the reasons I believe that the 

Scriptures alone are from God is the amazing detail and accuracy of the prophetic details contained in the Word. 

Prophecy can be a difficult topic to study. However, if you have the Prophecy Knowledge Handbook by John Walvoord, 

then you have a great tool for studying this topic. Click the image below to buy from Logos. 

 

Here is a sample from the book: 

 

  

http://www.logos.com/product/600/the-prophecy-knowledge-handbook
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TWO UNIQUE AUTHORS FOR HISTORICAL BACKGROUND: Archer & Guthrie 
 

Gleason Archer and Dr. Donald Guthrie have produced two books that are essential for historical background 

research for any book of the OT and NT.  These resources are a wealth of information. Not only do they provide 

information about the authors and background of each book of the Bible, but they discuss interpretative issues, 

how the various texts came to be part of the canon, and much more. 

Gleason Archer’s Survey of the Old Testament is included in most Logos collections. 

 

Donald Guthrie’s New Testament Introduction is sold separately. 

 

 

 

  

logosres:sotintro;art=title
logosres:ntintro;art=title
http://www.logos.com/product/1157/a-survey-of-old-testament-introduction
http://www.logos.com/product/595/new-testament-introduction
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SURVEY OF BOOKS WITH OUTLINES 
 

Discovering the Biblical outline for a passage is important if you wish to understand and communicate the author’s 

intended meaning. However, determining the Biblical outline can be a difficult task; especially when you are working 

directly with the original language of the Bible. With Logos 4, the right mix of resources, that task can be made easy and 

you can more readily check your work.    

Over the years, the following types of resources have provided valuable for discovering and checking the Biblical outline. 

Please enjoy my recommended buy list of favorite outlines. 

Commentaries: Most commentaries have an outline at the beginning of the book. Outlines in commentaries tend to be 

descriptive, summarizing the important sections of the Biblical text. However, when you take a closer look, they can 

range from general to very detailed and therefore, no two outlines are alike. 

Sample Jude Outlines (Jude1-Jude 16):  

Bible Knowledge Commentary (Learn More)   Word Biblical Commentary (Learn More) 

 

 

 

 

 

 

  

logosres:bkc;ref=VolumePage.V_2,_p_918;off=3562
http://www.logos.com/product/133/the-bible-knowledge-commentary
logosres:wbc50;ref=Page.p_5;off=2192
http://www.logos.com/product/1316/word-biblical-commentary-volume-50-jude-2-peter


 

 
27 

Surveys and handbooks: These types of resources are helpful for quick summaries of individual books of the Bible. They 

provide a lot of information in a concise fashion. Outlines tend to be very basic. 

Sample Jude Outlines (Jude1-Jude 16):  

Nelson's Complete Book of Bible Maps & Charts (Learn More) 

 

Jensen’s Survey of the New Testament (Learn More) 

 

Willmington’s Bible Handbook (Learn More) 

 

 

 

 

  

logosres:bkmapcht;art=4.3.6.5
http://www.logos.com/product/1206/nelsons-complete-book-of-bible-maps-and-charts-revised
logosres:jensensurvnt;ref=Page.p_489;off=155
http://www.logos.com/product/4500/jensens-survey-of-the-old-and-new-testament
logosres:willhdbk;ref=Bible.Jud;off=2027
http://www.logos.com/product/1766/willmingtons-bible-handbook
http://www.learnlogos.com/index.php?option=com_content&view=article&id=78:distant-education-class-outline&catid=65&Itemid=71
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Specialized Resources: These types of resources are the most helpful for detailed outlines of individual books of the 

Bible. They are the most comprehensive outlines you can find. 

Sample Jude Outlines (Jude1-Jude 16):  

Outline Bible (Learn More) 

  

Roy Gingrich Bible Outlines (Learn More) 

 

logosres:outlnbbl;ref=Bible.Jud1-25
http://www.logos.com/product/1765/the-outline-bible
logosres:gng83jn;ref=Page.p_41
http://www.logos.com/product/3259/roy-gingrichs-commentaries-in-outline-form
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PART 1 – THE GRAMMATICAL DIAGRAM 
 

One of the challenges of using another person’s outline is determining its accuracy. Therefore, creating your own outline 

is of course the preferred way to go if you have the time, training, and tools.  One type of outline is the Grammatical 

Outline. This is created by analyzing the original language and creating an outline based from your research. 

There is an excellent resource that can teach you this method, if you can work with the Greek : ) 
Diagrammatical Analysis By Lee Kantenwein Lee. (Learn More) 
 

 
 
 

 
 
 
 

  

logosres:diaganalysis;ref=Page.p_75;off=287
http://www.logos.com/product/1794/diagrammatical-analysis
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PART 2 –THE BLOCK DIAGRAM     
 

The block diagram or structural analysis is a whole lot easier than the grammatical diagram. Additionally, it can be done 

in English or the original language. The resource Biblical Hermeneutics explains this process. Also, I have included a link 

to an excellent and straightforward set of instructions to block diagram from the English as well. Don’t forget to use the 

sentence diagram tool in Logos (File > Sentence Diagram).  

Biblical Hermeneutics (Learn More) 

http://rockvalleybiblechurch.org/ResourcesAndLinks/Block%20Diagramming.htm 

Sample Jude Outlines (Ephesians 1:3-6):  

 

The Lexham Clausal Outlines of the Greek New Testament is an excellent resource as well. 

 

 

Additional Video Training 
Best Practices – Lesson 5 
Webinar: Any Session #4 

 

 

logos4:SentenceDiagram;title=Untitled_Sentence_Diagram_(6)
logosres:bblherm2;ref=Page.p_13;off=2150
http://www.logos.com/product/3790/biblical-hermeneutics
http://rockvalleybiblechurch.org/ResourcesAndLinks/Block%20Diagramming.htm
logosres:clausalnt;ref=BibleNA27.Eph1.3
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THE OUTLINE MAP – EACH POINT IS A PART, THE WHOLE IS A PROCESS 
 

What makes an outline not only memorable but effective? Is it possible for an outline to communicate the author’s 

intended meaning and yet still be relatable to a modern audience? Can an outline be simple enough to be remembered 

throughout the week and yet still be anchored to the text? These are important questions that are answered in the 

affirmative, but you may be asking, How is this all possible?  

Let me suggest one technique that I believe can accomplish these lofty goals. I call it the Outline Map. Let me start with 

an example we all can relate to in order to illustrate how this works.  

Title: Outline of a Journey 

Point #1: Board the Plane 

Point #2: Departure 

Point #3: Journey to the destination 

Point #4: Arrival 

Point #5: Exit the Plane 

This over simplified example provides a structure for the Outline Map. First we have a title that is an Outline of a 

Journey; the journey will be through a Biblical passage. Point #1, is where we Board the Plane and get the audience on 

board with the text, providing the background and introductory material. Point #2, we Depart and get the audience 

ready for the main point of the passage by addressing some of the significant ideas of the passage. Point #3, we Journey 

to the Destination filling in some of the most significant details of where we are going. Point #4, we have Arrival and 

now the main point is made and the purpose of the sermon is revealed. Point #5, we Exit the Plane, and provide 

principles, wisdom, and guidance for application. This is the Outline Map.  

Now that you have an outline, let’s do this with a Biblical Passage, Ephesians 2:1-10. 

Title: Living with the Past 

Point #1: Introduction 

Point #2: I. We Were Ruined By Sin (Ephesians 2:1-3) 

Point #3: II. We Were Rescued by God (Ephesians 2:4-9) 

Point #4: III. We Were Redesigned for Service (Ephesians 2:10) 

Point #5: Conclusion 

Keep in mind not every passage lends itself to this kind of structure, so don’t force it. Never the less, it can be a great 

guide to a better outline. 
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REFINING AND REVIEWING OUTLINES THROUGH THE PASSAGE GUIDE 
 

Now after you have created your preliminary outline and studied your passage, you are ready to review and refine your 

outline. Logos makes this easy through the passage guide. Therefore, let’s run the passage guide and check our outline 

from Ephesians 2:1-10. 

HOW TO:  

 Go to the main menu and choose Guides > Passage Guide 

 

 Enter the passage Ephesians 2:1-10 in the Bible Reference box and Press Enter or the Go Button 

 

 Locate the section in the Passage Guide named SermonCentral.com (Click this section if it is not opened) 

 

 Click through each sermon and review the outlines for ways to refine your outline. 
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TRANSLITERATION: WHAT IS IT AND HOW CAN I FIND IT? 
 

Transliteration makes it possible to read and pronounce a foreign language. The way it works is to take the letters and 

their associated sounds from a foreign language and convert them to the alphabet and its corresponding language of 

another language. Let’s provide two examples, one from the Hebrew and one from the Greek. 

HEBREW:  

ENGLISH: [ʾelohiym /el·o·heem/] 

If you did not know Hebrew, you would immediately recognize from the English transliteration that this is one of the 

names of God. Let’s examine a Greek example. 

GREEK:  

ENGLISH:  [theos /theh·os/] 

Can you pronounce and recognize this word? That’s right; it’s the Greek word for God. 

Transliteration can sure help in growing your vocabulary and recognition of words in the original language. Furthermore, 

if you are trying to learn the Hebrew or Greek language, transliteration is a great tool to help you learn the sounds and 

letters more easily. 

Now you may be asking what is the easiest way to find the transliteration for the underlying Hebrew or Greek word? I 

thought you would never ask!  : ) 

HOW TO:  

  Open any interlinear Bible, let’s use the NASB. 

 Let’s go to Hebrews 4:4 by typing Hebrews 4:4 into the Bible reference box. 
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 Right click on the word Day > Choose from the right menu Greek Strong’s Number #2250 > then choose Enhanced 

Strong’s Lexicon from the left menu. 

  

 Examine the Strong’s Dictionary and locate the transliteration and try to pronounce. 

 

 

 

 

 

 



 

 
35 

 

 

EXEGETICAL GUIDE: PART 1 – THE APPARATUSES 

 
The Exegetical Guide is one of the easiest ways to complete your word study research. I use it when I have a lot of words 

to look up when they are in verse order. Now in this report there are several sections that you may not have explored 

such as: The Apparatuses, Grammars, Visualizations, and Word by Word. Let’s begin with the Apparatuses. 

Have you ever used an apparatus? If not, you are in good company. This tool is more often used by those who have had 

seminary or original language training. But you don’t have to go to school to use this tool (but it does help). 

So what is an apparatus? In the simplest terms, think of it as brief notes about individual words and phrases in the Bible. 

You see, the Bible is a compilation of many, many pieces of Scripture. Since we do not have the original manuscripts that 

the Biblical authors created, we have had to hunt and look for copies of their original texts. Now with all these copies 

(literally thousands of pieces and parts of the Biblical text) there was a need to connect the parts to the whole. In other 

words, we need an index that can show us which words from the Bible are coming from which piece of a text that was 

found hundreds of years ago. By the way, this is what Textual Criticism is all about: comparing texts and determining 

what was written in the original manuscript. 

 HOW TO:  

 Go to the main menu and choose Guides > Exegetical Guides 

 

 Enter the passage Ephesians 2:1-10 in the Bible reference box and press enter or the Go button 

 

  

logosres:mwdict11;hw=textual_criticism
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 Click on the section Apparatuses to expand the contents in case it is closed 

 

 Here is a sample page showing the verse, Greek Word, and links to the manuscripts/copies where the word may or 

may not be found. 

 

 Here is a list of Apparatuses that are available in Logos 4. Keep in mind some of these are add-ons. Here is a list of 

links to these resources. I have included the Hebrew ones as well. 

Note: Many of these apparatuses are part of larger collections. Click on the book covers to learn more at Logos.com 

Hebrew Apparatuses     Greek Apparatuses  

                                    

 

 

http://www.logos.com/product/8484/stuttgart-electronic-study-bible
http://www.logos.com/old/comparison
http://www.logos.com/product/2211/novum-testamentum-graece-apparatum-criticum
http://www.logos.com/product/8486/the-greek-new-testament-sbl-edition
http://www.logos.com/product/8484/stuttgart-electronic-study-bible
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EXEGETICAL GUIDE: PART 2 – GRAMMARS 
 

For most of us our native tongue is English, not Hebrew or Greek. When we write and speak we use grammar intuitively. 

And depending on your education and experience some better than others : ) 

But when it comes to studying the Bible, we all need assistance in getting a clear understanding of what the authors 

intended to say in the text and without rules of grammar we could misunderstand the writer, and since we are dealing 

with an inspired text, we could misunderstand God! Therefore, to avoid confusion it becomes imperative that we 

consult the Hebrew and Greek grammars to get a clear understanding of what the text is saying. 

HOW TO:  

 Go to the main menu and choose Guides > Exegetical Guides 

 

 Enter the passage Ephesians 2:1-10 in the Bible reference box and press enter or the Go button 

 

 Click on the section Grammars to expand the contents in case it is closed
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 By reading each article you will begin to learn rules of grammar that can help you interpret the text. 

 Here are two key grammar books that are a must buy! Click on the book covers to learn more at Logos.com 

                 

If you are looking for more grammar book suggestions, click the link below and explore the Logos store. 

Hebrew Grammar 

Greek Grammar 

                 

 

http://www.logos.com/products/search?q=hebrew+grammar
http://www.logos.com/products/search?q=Greek+Grammar
http://www.logos.com/product/4227/an-introduction-to-biblical-hebrew-syntax
http://www.logos.com/product/8286/greek-grammar-beyond-the-basics
http://www.learnlogos.com/store
http://www.learnlogos.com/store
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EXEGETICAL GUIDE: PART 3 – VISUALIZATIONS/SYNTAX 
 

The next section in our exegetical guide to be explored is visualizations. If you have looked at these resources and 

scratched your head asking, “What in the world is this and what do I do with it?”, you are repeating what many others 

have said before and certainly will say after you. 

But first, I have video training on this resource. See the Best Practices, Blue Disc 2/2 > Lesson 5 Observing the Text > 

Lesson 6 or check out any Session 4 Webinar (Inductive, Bible Study, or Preparing Sermons). In these videos, I show you 

how to use syntax to determine accurately the Biblical Outline for any passage in the Old Testament and New 

Testament. This is just one of the many applications for these tools. 

HOW TO:  

 Go to the main menu and choose Guides > Exegetical Guides 

 

 Enter the passage Ephesians 2:1-10 in the Bible reference box and press enter or the Go button 

 

 Click on the section Visualizations to expand the contents in case it is closed 

 

  



 
 

 
40 

 

 

EXEGETICAL GUIDE: PART 4 – WORD BY WORD  
 

This section is your “GO TO” tool for word studies. Everything you need to start your word studies has been aggregated 

here in an accessible, organized format. Let’s take a closer look. 

HOW TO:  

 Go to the main menu and choose Guides > Exegetical Guides 

 

 Enter the passage Ephesians 2:1-10 in the Bible reference box and press enter or the Go button 

 

  



 

 
41 

 Click on the section Visualizations to expand the contents in case it is closed 

 

Let’s take a closer look at each element in the Word Study section and learn how we can use this report to go deeper 

and more accurate with our word studies. 

 At the left is the original language text (NT) and at the right is your prioritized Bible. The words in grey have been 

ignored in the report. The words in black are the words that have been listed below this section. To access the 

definitions for the grey words, simply click the word and the definition will be listed below in word order. 
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 This is the Word section. First listed is the word being studied from the original language with its transliteration to its 

right to help you pronounce the word in case you can’t read Hebrew or Greek. To the right you can see the English word 

in it’s context. Below and to the left is the Lemma or root word. This is the word you will find in dictionaries and lexicons. 

The speaker icon, if clicked on, will pronounce the word so you can hear what the Lemma sounds like. To the right of the 

speaker you have a transliteration to pronounce the word. And to its right, is a translation of the word in English. Below 

this is the morphological information which will help you understand how the word functions in the text. For example, is 

it a verb or noun? Now below the morphological information are links to the dictionaries that can help you define what 

the word means. WOW! I told you this was a lot of information to help your word studies! So enjoy the easiest way to do 

word studies! 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.learnlogos.com/
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                   APPLICATION: HOW TO PRINCIPLIZE THE TEXT 
 

One of the more important elements of Bible study, teaching and preaching is the application, without application we 

cannot grow in grace and truth to maturity in Christ. However, care must be taken to derive the application from the 

Biblical text. For if it is not, you will be faced with several problematic issues. Your application could be man-centered 

rather than God-centered, and may run the risk of the application contradicting Scripture itself. Applications may be too 

narrow and very few could apply it to their lives, or it may be too general and be difficult to apply at all. Additionally, 

some applications from the Old Testament may no longer be applicable such as the dietary laws of the Mosaic Laws.  

So what should a Bible student do to avoid these issues? Principlize the text! But how you ask? Let me take you through 

a process that will help you anchor your applications in the text. Consider this quote: 

 

This quote reminds me of the importance to pursue the Scriptures and grow up in Christ. James reminds us in James 1:2, 

we will encounter various trials to test our faith; which should result in producing endurance in our life. Since life is 

fraught with tests, one needs to have wisdom to anticipate and respond early to what may lie ahead on the horizon. The 

easiest way to do this is with wisdom grounded and rooted in principles from the Scriptures. When situations arise, you 

seek the full counsel of the Scripture to determine your course, and that’s where the Biblical principle comes to assist 

you. So let’s learn to look at a Biblical text and glean a principle for everyday life. Let’s use the text from Philippians 2:1-

18. 

Principlizing the Text (Philipians 2:1-18) 

Pre-Work: It is presumed you have studied this passage and know what it means. 

Step 1: Identify the major theme of the passage 

When we read the Biblical text, we simply want to identify the theme or topic that stands out in our passage. In this 

example it is humility. 
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Step 2: identify the subject/topic of the passage (morphology can help sometimes) 

In this passage there are several subjects related to this topic of humility: Paul, Believers, Christ, and every creature in 

heaven, on the earth, and under the earth. However, one subject is the focus and that is Jesus Christ. 

Step 3: Identify the Action 

Here we look at the action in the passage. There are several verbs: have the same mind, regard one another as more 

important than yourselves, and more. But again if you consider the theme, the subject, the action that stands out is 

Christ humbled himself. 

Step 4: Identify the effect/result/purpose 

Now this step can be a little tricky. Here we look for effects, results, or purpose. Phrases like “therefore” or “so that” can 

be helpful pointers in the text. In this text, we have several, “for this reason”, “so then”, “so that”, etc. Therefore, when 

we step back from the text, we see not only God exalting Christ but we see the redemption and reconciliation of sinful 

man to Holy God. Let’s go with this last principle. 

Step 5: Choose the direction of the application (man to God, man to man) 

Of all the steps this is the easiest because there are only two choices. Does the principle direct man to his vertical 

relationship with God or does the text direct him to his horizontal relationship to his fellow man? For this passage let’s 

choose the horizontal relationship. 

Step 6: Create the application formula (subject + action + effect) 

Here we simply organize our research into the formula. Here is an example: 

Subject: Jesus Christ + Action: humbled Himself + Effect: reconciled sinful man to Holy God 

Step 7: Generalize the Subject, Action, effect/result/purpose from steps 2-4 

This step is the most difficult because not only do you have to generalize the ideas from the previous step, but you need 

to ensure that in this early stage of developing a principle it is Biblical and not heretical. Once again we will use the 

formula, generalizing for a horizontal application. 

Subject: You + Action: humbled Himself + Effect: reconciled man to man 

Note:   Do you see how I replaced ‘Christ’ with ‘you’ and reconcile man to man (not in the saving sense, but in the hman 

relation sense) 

Step 8: Write and refine the principle 

This step will take some practice and creativity. You may wish to write out several variations.  

Here is my example: Without humility there can be no reconciliation.  

Think about this principle for a second. If I am in conflict with another person, one of us must humble themselves in 

order for reconciliation to be possible. And if you consider the backdrop of the text, Christ who is without sin, humbling 

Himself on the cross for us sinners who were enemies. Furthermore, Christ is infinite God and we are finite man, that’s 



 

 
45 

the great divide only God can traverse. Yet, when we sin or are sinned against by another person, the gap between them 

and us is minor. Do you see why God is opposed to the proud? Why that’s an intense truth! But it’s also a great principle 

when faced with a conflict – so who’s ready to humble themselves in the spirit of Christ? 

Step 9: Two Important tests 

Now after you determine the principle, you need to test it.  

Test #1 is the doctrine test: Is the principle rooted in the Biblical text?  

Test #2 is the love test: Does the principle demonstrate sacrificial love?  

You see, if you have doctrine but no love, you are a noisy gong. And if you have love but no doctrine, you run the risk of 

disobeying God’s word in order to please another person and that can create all sorts of moral dilemmas.   

In closing, what tools do you have in Logos to guide you through the process? Consider the following suggestions: 

Resource 1: Using the Treasury of Scripture Knowledge: Cross Reference w/ Power Lookup 

Look for cross references to a text which may have a Biblical principle or command. 

Resource 2: Find a Proverb: Create & Search a collection or your entire library  

Look for books that mention your passage and a specific proverb 

Resource 3: Search a Collection of Devotions based on your passage: devotions and application commentaries 

 NIV Application Commentary and Jon Courson’s Commentary would be an excellent resource 

Step 4: Topic Search: Examine your topic results for additional ideas. i.e.  

 Search on “humility” from the home page. Click here to run the search on your computer. 

Step 5: Other Sermons: Sermon Audio, Sermon Central, Sermon.Logos.com 

 Run the passage guide and read through these resources. Click here to open your passage guide and search. 

On a Last note, let me suggest several additional thoughts: 

• Must follow directly after the exposition               Use “we” instead of “you” 

• Must be rooted and clearly anchored to the Biblical text    Distinguish between Unbeliever/Believer 

• Distinguish between justification/sanctification              Don’t moralize 

 

 

 

llogosres:ntsk;ref=Bible.Php2.1
logos4:Search;kind=Basic;q=$3Cbible_~_php_2:1-18$3E_WITHIN_10_WORDS_$3Cbible_~_proverbs$3E;match=stem
logosres:365devo;ref=DayOfYear.Nov_8
logosres:lifeappphpcolphm;ref=Bible.Php2.1
http://www.logos.com/products/search?q=%22NIV+Application+commentary%22
http://www.logos.com/products/search?q=%22Courson%27s+Application+Commentary%22
logos4:Search;kind=Basic;q=humility;match=stem
logos4:Guide;t=Passage_Guide;ref=BibleNASB95.Php2.1-18
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MARK DEVER & HIS LIST OF APPLICATIONS  
 

I recently attended the IX Marks Conference; which by the way I highly recommend. During one of these sessions Mark 

Dever discussed how during his sermon preparation he considers several areas of application. You can discover these for 

yourself by clicking the link below:  

Click here 

  

 

 

THE BUILT-IN APPLICATION: DISCOVERING THE COMMAND & ADDING A 

VISUAL FILTER – OLD TESTAMENT 
 

One application that you should never miss is a clear command in Scripture. Now keep in mind, context is king, and 

therefore some commands are no longer applicable to believers on this side of the cross, such as those commands 

specific to Israel.  But aside from these, you don’t want to miss commands. 

Well it turns out this can be very easy to do in Logos 4. Let’s walk through this process for the OT and NT. 

Old Testament Commands 

 Click here to search the Old Testament for all its commands 

 Next, click the Make Filter button to make this visually recognizable 

 

  

http://www.9marks.org/
http://involve.9marks.org/site/DocServer/9MarksDoc_Sample_Application_Grid.pdf?docID=842
http://involve.9marks.org/site/DocServer/9MarksDoc_Sample_Application_Grid.pdf?docID=842
logos4:Search;kind=Morph;q=@V$3F$3F$5BiI$5D;match=stem
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 Choose a highlighting Color, I recommend the Green Highlight 

 

 Rename this visual filter to OT Commands and close this window by clicking the X in the upper right corner 

 

 Check your Bible Text, which in our case is the NASB95 

 

Note: Why don’t you try this out with the Aramaic text 
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THE BUILT-IN APPLICATION: DISCOVERING THE COMMAND & ADDING A 

VISUAL FILTER – NEW TESTAMENT 

 

HOW TO: 

New Testament Commands 

 Click here to search the Old Testament for all its commands 

 Next, click the Make Filter button to make this visually recognizable 

 

 Choose a highlighting Color, I recommend the Green Highlight 

 

 Rename this visual filter to NT Commands and close this window by clicking the X in the upper right corner 

 

  

logos4:Search;kind=Morph;q=@V$3F$3FM;match=stem
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 Check your Bible Text, which in our case is the NASB95 
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THE BUILT-IN ILLUSTRATION: SEARCHING FOR PARABLES, STORIES, AND 

ILLUSTRATION IN THE BIBLE 
 

WHAT ILLUSTRATIONS SHOULD NEVER DO: 

Many times teachers and preachers draw from their own experience for an application. This can be a good strategy now 

and then. A better strategy is to find Biblical examples of those who obeyed (examples to follow) as well as those who 

disobeyed (warnings not to follow). Not only will this help you grow in your familiarity with the Bible but it can show the 

consequences of obeying or disobeying. With this in mind, consider the following four questions to help you and others 

apply the Biblical text in your life. Every application should be run through this grid of questioning. 

Let’s explore a command from Jesus, Matthew 5:44, “Love your enemies” through this “grid of questioning”. 

Thinking: (James 3:13-18, Philippians 4:8) 

 What is the right/Christ-like way to think about this matter? 

 What is the wrong/Man-centered way to think about this matter? 

Speaking: (James 1:1-12, Colossians 4:6, Ephesians 4:29) 

 What should not be said? 

 What should be said? 

Doing - Put Off/Put On: (Colossians 3:8-17, Ephesians 4:17-32, 1 Peter 3:8-9, 2 Peter 2:5-11, Romans 12-15) 

 Look at Colossians 3:8-9, Ephesians 4:25-31 and examine these lists and see what needs to be Put Off/Laid Aside  

to “love your enemy” 

 Look to Colossians 3:10-17, Ephesians 4:32, etc. and examine these lists and see what needs to be Put On to 

“love your enemy”  

Here is a great search to discover “one another” passages in the NT: 

 Search > Morph Search > @v WITHIN 2 WORDS lemma:ἀλλήλων 

Click here to run the search 

Here is a great search to discover all the “commands” passages of the NT: 

Note: Keep in mind, this finds all commands so remember “context is king” to determine relevancy 

 @V??M2 -behold -lemma:ἰδού 

Click here to run the search 

 

logos4:Search;kind=Morph;q=@v_WITHIN_2_WORDS_lemma:$E1$BC$80$CE$BB$CE$BB$CE$AE$CE$BB$CF$89$CE$BD_;match=nostem
logos4:Search;kind=Morph;q=@V$3F$3FM2_-behold_-lemma:$E1$BC$B0$CE$B4$CE$BF$CF$8D;match=nostem
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SEARCHING HEBREW ACCENTS 

Now this kind of search is not for everyone, but it reveals the power of Logos 4 search capabilities. Now you may be 

wondering, why even search for Hebrew accents? Hebrew accents can show you where a phrase begins and ends in the 

text and it can even help you pronounce the Hebrew words (if you can read Hebrew).  

If you want to learn more about Hebrew Accents click here to read the article from the Hebrew Bible Insert. 

Here is a list of the search criteria to search on various accents: 

ALL BOOKS, EXCEPT Psalms, Job, Proverbs  
 
DISJUNCTIVE  
1. Silluq /.*\u05bd.*/  
2. ’Athnach /.*\u0591.*/  
3. Segolta /.*\u0592.*/  
4. Shalsheleth /.*\u0593.*/  
5. Zaqeph /.*\u0594.*/  
6. Tiphchah /.*\u0596.*/  
7. Rebia‘ /.*\u0597.*/  
 
CONJUNCTIVE  
1. Munach /.*\u05a3.*/  
2. Mehuppakh /.*\u05a4.*/  
3. Merkha/.*\u05a5.*/  
4. Darga /.*\u05a7.*/  
5. ’Azla /.*\u05a8.*/  
 

ONLY Psalms, Job, Proverbs  
 
DISJUNCTIVE  
1. Silluq /.*\u05bd.*/  
2. ‘Oleh weyored /.*\u05ab.*/  
3. ’Athnach /.*\u0591.*/  
4. Rebia‘ gadol & mugrash /.*\u0597.*/  
 
CONJUNCTIVE  
1. Merkha/.*\u05a5.*/  
2. Munach /.*\u05a3.*/  
3. ‘Illuy /.*\u05ac.*/  
4. Tarcha /.*\u0596.*/  
5. Galgal /.*\u05aa.*/  
6. Mehuppakh /.*\u05a4.*/  
7. ’Azla /.*\u05a8.*/ 
 

 

Pre-requisites: BHS 4.2 

HOW TO:  

  Let’s begin with a Bible. Click the Library icon at the top left 

 

 Click Bible, Choose BHS 4.2, and then copy and paste one of the accent search criteria into the search box 

 

logosres:hbinsert;ref=Page.p_51
http://www.logos.com/product/689/hebrew-bible-insert-a-students-guide-to-the-syntax-of-biblical-hebrew
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 Click Add Versions and add your favorite English Bible Translation 

 

 Examine your search results 
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 FIND IT QUICK…FIND IT FAST  
 

If you are looking for a quick way to search for a word or phrase, than look no further than the Quick Find. 

HOW TO:  

  Let’s begin with a Bible. Click the Library icon at the top left 

 

 Type ESV in the find box 

 

 

 Press CTRL + F (PC) or COMMAND + F (MAC) and you will see a search box appear 
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 Type in the word love and press enter or the search buttons previous / next. 

 

 You will see your word highlighted 

 

Note: the ‘find’ search has one capability the other search engines do not; you can search for special characters like  

! ? .  ; “ ‘, etc.. 

IMPORTANT:  

If you want to find all the questions in the Bible this is one way to do it, of course, one question at a time. 

 

 

  



 

 
55 

 

 

SEARCHING FIELDS THE EASY WAY 
 

Now you may be wondering, “What is a field”? Fields is Logos’ special way of tagging information so you can search it 

exclusively. For example, you have a field called Words of Christ. When you read your Bible you read the red text for the 

word of Christ. With fields, you can search only the Words of Christ and not search any other part of the Biblical text. 

So field searching is a wonderful way to narrow your search. Now if you are wondering what the available fields to 

search are, let me show you the easy way to do this! 

HOW TO:  

  Let’s begin with a Bible. Click the Search icon at the top left 

 

 Choose Basic from the four choices 

 

 Choose Entire Library (You may need to type entire in the search box, and click Entire Library) 
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 Click All Text and then click the black triangle to the left of Search Fields to see all the searchable fields. 

 

Note: The search field list will differ based on the books in your library. Additionally, the list will differ based on the 

books you are searching. In this example, we are searching the entire library. If you were just searching Bibles, the list 

would display only those search fields available from the Bible you are searching. 

 Let’s check the box labeled Words of Christ 
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 Type the word love in the search box, press Enter, and examine your search results 
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SEARCH HISTORY (TWO WAYS) – DROP DOWN, HISTORY BUTTON 
 

When you open and close multiple books, and jump from one location to the next, it does not take long to forget where 

you have been. Now and then you will want to go back and find something you recently viewed. This is where search 

history comes in handy. Let’s learn how. 

HOW TO:  

 Click the Search icon at the top left 

 

 Choose Basic from the four choices 

 

 Click the black triangle to the right of the search box to access your search history 
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 The second way, to access your history is to click Tools on the main menu, then click History 

 

 Now examine your history by scrolling down 
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TOOLBAR: ADD AN IMPORTANT SEARCH SHORTCUT: SEARCH FAVORITE BIBLE  
 

Adding shortcuts to the toolbar is an important way to save time and make searching easy! 

HOW TO:  

  Let’s begin with a Bible. Click the Search icon at the top left 

 

 Choose Bible from the four search choices 

 

 Choose your search criteria with one Bible. Here are my settings: 

 

Note: Make sure there is nothing in the find box 

 Drag the search tab to the toolbar by left clicking on the tab, holding the mouse button down, and dragging onto the 

shortcut toolbar. 

 

Note: Notice that when you drag the search tab to the tool bar you will see a vertical line showing you where the icon 

will be placed. 

 

 Now you are just one click away from searching your Bible 
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FINDING BOOKS…IF THE PRICE IS RIGHT 

 

In this economy, no one wants to turn away from a good bargain! But each of us values a bargain differently. Therefore, 

I would like to show you a helpful way to shop at Logos.com’s store. Let’s learn how to search on a price that fits your 

budget.  

HOW TO:  

  Searching for Free Books ($ 0.00) 

http://www.logos.com/products/search?q=price:0 

  Searching for Books priced at $ 10.00 

http://www.logos.com/products/search?q=price:10 

 Searching for Books priced at $50 

http://www.logos.com/products/search?q=price:50 

 Edit the web address after you click the link and change the number to what you can afford 

 

Note: I was not able to figure out how to search a price range, so for now you can only search for the exact price. 

 

 

 

 

 

 

  

http://www.logos.com/products/search?q=price:0
http://www.logos.com/products/search?q=price:10
http://www.logos.com/products/search?q=price:50
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FLAVORS OF COMMENTARIES 

 

If you have had a chance to look at my Best Practices CD 1/2, you will see that I have overviewed over 130 books. In 

LESSON 3, I take a look at 48 titles alone! And this brings us to commentaries. Not all commentaries are built the same. 

When it comes to studying and buying books, having the right commentary can make all the difference to shedding light 

and insight on the passage you are studying. So let’s learn about the 4 major types of commentaries: 

Type 1: The Study Bible 

Typically they cover Genesis to Revelation, and you will find comments on nearly every passage of the Bible. They may 

comment on a single verse or a range of verses. Depending on the author(s) the comments can range in depth of 

scholarship. Additionally, some study Bibles have themes: apologetics, end times, new believers, women, etc. I 

recommend having several of these. These commentaries include maps, charts, and images. Here are my top two: 

The MacArthur Study Bible The ESV Study Bible Notes  

    

Here is an excerpt from the MacArthur Study Bible: 

 

Here is an excerpt from the ESV Study Bible: 

 

 

http://www.logos.com/product/1298/the-macarthur-study-bible
http://www.logos.com/product/5255/esv-study-bible-notes
http://www.logos.com/product/1298/the-macarthur-study-bible
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Type 2: The Introductory/Overview Commentary  

These come in several flavors. First, there are commentaries that are “whole-Bible”(Genesis-Revelation) sets that are 

five or less volumes. The best example of this is the Bible Knowledge Commentary (which most of you have). It is two 

volumes and covers nearly every passage of Scripture.  Wycliffe Bible Commentary  OT/NT, Believer’s Bible Commentary, 

and Matthew Henry would be good examples. These commentaries can also have special emphasis, like Roy Zuck’s 2 

Volume Theological Commentary for OT/NT, or John Walvoord’s Bible Prophecy Handbook. On a side note, Zuck and 

Walvoord  are organized by book of the Bible, but cannot be linked to a Bible, like an ordinary commentary and 

therefore have to be manually navigated to the passage of interest. 

My top recommendation: 

Bible Knowledge Commentary  

 

Here is an excerpt from the Bible Knowledge Commentary: 

 

Here is an excerpt from the Matthew Henry’s Concise Commentary: 

 

logosres:bkc;ref=Bible.Ro4.1
http://www.logos.com/product/419/the-wycliffe-bible-commentary-old-testament
http://www.logos.com/product/418/the-wycliffe-bible-commentary-new-testament
http://www.logos.com/product/1186/believers-bible-commentary
http://www.logos.com/product/291/matthew-henrys-commentary-on-the-bible
http://www.logos.com/product/718/a-biblical-theology-of-the-old-testament
http://www.logos.com/product/135/a-biblical-theology-of-the-new-testament
http://www.logos.com/product/600/the-prophecy-knowledge-handbook
http://www.logos.com/product/133/the-bible-knowledge-commentary
http://www.logos.com/product/133/the-bible-knowledge-commentary
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Another type of introductory commentary can focus on just one book of the Bible. Now these can come in sets of 10 or 

more. The best example is Warren Weirsbe’s “Be” Series. The Old Testament has 27 volumes. The New Testament has 

23 volumes.  There is no Hebrew or Greek, the comments are basic, getting the high points including illustrations and 

applications. 

Here is an excerpt from the “Be” Series: 

 

Type 3: The Expositional Commentary 

The goal of these commentaries is to explain the text, more in depth than the previously mentioned examples, but not 

overwhelm you with scholarly terminology or Hebrew and Greek. You will be exposed to word studies, theology, 

historical background and Biblical cross references. These sets are typically 20 or more volumes when they cover the 

whole Bible. Some good examples would be the New American Commentary (in Silver or higher), The MacArthur New 

Testament Commentary, Opening Up Commentary (included in most collections) 

My Top Recommendation: 

Preacher’s Commentary  (AMAZING $15 SALE @ Rejoice Software)  MacArthur New Testament Commentary 

      

http://www.logos.com/product/5784/warren-wiersbes-old-testament-be-series
http://www.logos.com/product/541/the-bible-exposition-commentary-an-exposition-of-the-new-testament-containing-the-entire-be-series
http://www.logos.com/product/7834/the-new-american-commentary-series
http://www.logos.com/product/8132/john-macarthur-bundle
http://www.logos.com/product/8132/john-macarthur-bundle
http://www.logos.com/product/3979/opening-up-commentary-collection
http://www.dxcart.com/cart/?id=8698&code=NLTPCEB
http://www.logos.com/product/8132/john-macarthur-bundle
http://www.logos.com/product/8579/the-preachers-commentary
http://www.logos.com/product/8132/john-macarthur-bundle
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Here is an excerpt from the Preacher’s Commentary: 

 

Here is an excerpt from the MacArthur New Testament Commentary: 

 

Type 4: The Exegetical Commentary 

These are the most expensive, technical, complicated, and yet, helpful resources for studying a passage. In these 

resources you can get so much information on a passage: Hebrew and Greek Word Studies, grammar, theological, 

historical and literary analysis, and even comments on other commentaries. Hands down these resources are the most 

helpful if you can steer through all the technical jargon. Keep in mind, these commentaries are especially biased in their 

theological views of Scripture, so buyer beware! In short, these types of commentaries are indispensable for deep study. 

Some examples would be the ICC, Heremenia, Word Biblical Commentary, Baker NT Commentary(AMAZING $50 ONLY 

through Rejoice Software), NICOT/NICNT and many more. 

 

 

http://www.logos.com/product/4099/international-critical-commentary
http://www.logos.com/product/8047/hermeneia-and-continental-commentaries
http://www.logos.com/product/8006/word-biblical-commentary
http://www.dxcart.com/cart/?id=8698&code=BKBKNTC
http://www.logos.com/product/5185/the-new-international-commentary-on-the-old-and-new-testament
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Here is an excerpt from the Baker NT Commentary: 

 

Here is an excerpt from the NICNT: 

 

My Top Recommendations: 

Word Biblical Commentary  NICOT/NICNT 

     
 

http://www.logos.com/product/8006/word-biblical-commentary
http://www.logos.com/product/5185/the-new-international-commentary-on-the-old-and-new-testament
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HOW TO EVALUATE A DIGITAL BOOK 

When it comes to building a digital library it not only takes money, but wisdom! Not all books are created 

equal. Therefore, in order to stretch your dollar and make the most of your study time, it is imperative to have 

the best possible resources. I truly believe one good book is worth ten mediocre books, so choose wisely! The 

following criteria will help you find the best resources.  

 

 Determine the category of the resource (Bible, English Dictionary, Exegetical Commentary, etc.) 

 See the Logos Product comparison page for category ideas 

 See your Library and look at the column type for category ideas 

 

 Generate a list of books in the category and sort the books from the most expensive to the least expensive 

 Go to the Logos.com store and search on the category (i.e. encyclopedia) 

 

 Re-sort your search results to sort by price. Note: You may want to increase the number of product to show. 
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 Now that you have a list of books to choose from, here are some specific items to look for to help you in the decision. 

Note: Once you identify the book, the product page may give you a page view, if not you may need to visit Amazon.com 

or books.google.com/ to Look Inside the book and see what is inside the book. 

 Publisher: Was the book published by a significant publisher? 

 Year Published: How recent and updated is the material. This is important in reference books. 

 Page Count: (More pages for your money (Total Price / # of Pages) 

 Table of Contents: This is the easiest way to compare two or more books. You will quickly see if one book covers 

more content and material than the other books. 

 Chapter Length: This is very revealing and a great way to compare books that are very similar. If you can find a 

topic that both discuss in a chapter, the longer chapter usually proves to be more detailed. 

 Outlines: A book that takes an effort to outline its content is a book that is organized and most often very 

structured, making reading and skimming for content easier. 

 Bibliography:  Look to see if there are additional sources cited at the end of each chapter or at the end of the 

book. A large bibliography can point you to better resources, as well as show you how researched the author is. 

If you were trying to decide between two or more books, I would choose the one with the bibliography. 

 Bible Verses: You want a lot of Bible Cross References in your book! This is so critical! A lot of talk without a lot 

of verses makes the book more difficult to use when it comes to searching, and may be less anchored to the 

Biblical text. Note: In print, look at the end of the book and see if it has a Scripture index. 

 Original Language: Does the book contain Hebrew and Greek words or transliteration (English spellings of 

Hebrew/Greek Words)? This demonstrates a high level of detail and scholarship. 

 Illustrations/Maps/Charts: Frankly, you can never have too many of these, so any book that has these 

immediately jumps to the top of my list! 

 Logos Collection: If the book you are looking to buy is part of a Logos collection, then don’t buy it separately, 

unless you absolutely need it and have no plans to upgrade to the larger collection. My rule of thumb: if 50% of 

the larger collection contains books you would use, it’s worth upgrading at some point. Additionally, if the books 

you want cost at least 50% of the upgrade, get the larger collection. 

 Book is Part of a Special Collection: Many times a book you want may be found in a special collection. Always, 

examine these collections and weigh out the value.  

 CHECK OUT REJOICE SOFTWARE! Many times they have special deals that you should not pass up: 

o Here are some links to current specials: 

o http://www.dxcart.com/cart/?id=8698&code=BKBKNTC (Baker NT Commentary) 

http://www.dxcart.com/cart/?id=8698&code=NLMLEBSL (Max Lucado Essential Bible Library) 

o http://rejoicesoftware.com/ebible_special.htm (eBible) 

o http://www.dxcart.com/cart/?id=8698&code=NLTPCEB (The Preachers Commentary) 

o http://www.dxcart.com/cart/?id=8698&code=BKGEISL (Norman Geisler Apologetics Library) 

http://rejoicesoftware.com/specials.htm 

Do you have criteria for book selection that I have not mentioned? Let me know at tips@learnlogos.com 

 

http://www.amazon.com/
http://books.google.com/
http://rejoicesoftware.com/
http://www.dxcart.com/cart/?id=8698&code=BKBKNTC
http://www.logos.com/product/4233/bakers-new-testament-commentary
http://www.dxcart.com/cart/?id=8698&code=NLMLEBSL
http://rejoicesoftware.com/ebible_special.htm
http://www.dxcart.com/cart/?id=8698&code=NLTPCEB
http://rejoicesoftware.com/preachers_comm_details.htm
http://www.dxcart.com/cart/?id=8698&code=BKGEISL
http://rejoicesoftware.com/geisler_details.htm
http://rejoicesoftware.com/specials.htm
mailto:tips@learnlogos.com
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HARMONIES, PARALLELS, & SYNOPTIC 

 

If you are studying, teaching, and/or preaching from one of the gospels, then these resources are absolutely invaluable 

and required to have. They are an excellent way to understand the chronology and details of our Lord and Savior’s life 

on earth. The good news is Logos includes quite a few helps for this in Logos 4. 

 Eusebian Canons                            

 Gospel Synopsis, by Jeffrey Glen Jackson                 

 Harmony of the Gospels                            

 A Harmony of the Gospels, by A .T. Robertson                            

 A Harmony of the Synoptic Gospels                            

 Records of the Life of Jesus                            

 Synopsis of the Four Gospels, by Kurt Aland  
 
Additional Cross Reference Resources that may be included in your gospel studies: 

 Pastoral Epistles, by Rick Brannan                           

 Synopsis of the Old Testament, by Jeffrey Glen Jackson 

 Old Testament Allusions                            

 Old Testament Quotes in the New Testament (HCSB)                          

 A Harmony of Samuel, Kings, and Chronicles, by William Day Crockett   

 Jude–2 Peter, by Jeffrey Glen Jackson                            

Note: All of these are available in Scholar’s Collection or higher.  See Logos product comparison for details. 
 
Here is a list of additional books with Harmonies and Synoptic analysis to add to your library: 

Click on the book image to learn more. 

    **This is not a logos book, but I highly recommend it 

  

http://www.logos.com/comparison
http://www.logos.com/product/3580/a-simplified-harmony-of-the-gospels
http://www.logos.com/product/7016/a-harmony-of-the-gospels
http://www.logos.com/product/7220/synoptic-gospels
http://www.christianbook.com/nasb-harmony-of-the-gospels/robert-thomas/9780060635244/pd/063524X?item_code=WW&netp_id=142430&event=ESRCG&view=details
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 Harmony of the Gospels Defined:  
A harmony of the Gospels attempts to organize Matthew-John into chronological order. The Biblical text is typically 
shown side by side in full context. See the example below from the Logos Edition of the Harmony of the Gospels: 
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 Synoptic Gospel Defined: 
The synoptic takes the approach that the gospels come from one single source. So instead of showing the text side by 
side in full context, they try to identify what is the unique information from each text to identify the original single text.  
See the example below from the Logos Edition A Harmony of the Synoptic Gospels for Historical and Critical Study:
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ROY ZUCK - VITAL ISSUES (12 Volumes) 
 

What if you could find concise, scholarly, articles on vital Christian issues? Well, look no further than the Roy Zuck’s 12 

Volume set of Vital Issues. The best way to show the scope of these books is to provide the table of contents for each 

book. Click the link above to learn more at Logos.com store. 

 

Vital Apologetic Issues: Examining Reason and Revelation in Biblical Perspective 

 

  

http://www.logos.com/product/4449/roy-zuck-vital-issues-series
http://www.logos.com/product/4449/roy-zuck-vital-issues-series
http://www.logos.com/product/4449/roy-zuck-vital-issues-series
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Vital Biblical Issues: Examining Problem Passages of the Bible 

 

Vital Christology Issues: Examining Contemporary and Classic Concerns 
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Vital Christian Living Issues: Examining Crucial Concerns in Spiritual Life 

 

Vital Church Issues: Examining Principles and Practices in Church Leadership 
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Vital Contemporary Issues: Examining Current Questions and Controversies 

 

Vital Ministry Issues: Examining Concerns and Conflicts in Ministry 
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Vital Missions Issues: Examining Challenges and Changes in World Evangelism 

 

Vital New Testament Issues: Examining New Testament Passages and Problems 
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Vital Old Testament Issues: Examining Textual and Topical Questions 

 

Vital Prophetic Issues: Examining Promises and Problems in Eschatology 
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Vital Theological Issues: Examining Enduring Issues of Theology 

 

So what does an article look like? Here is a brief sample: 
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DEUTERONOMY: WHAT RESOURCES WOULD YOU RECOMMEND? 
 

Exegetical Commentaries 

Word Biblical Commentary: Deuteronomy, Pt 1 

Word Biblical Commentary: Deuteronomy, Pt 2 

NICOT: The Book of Deuteronomy 

ICC: A Critical and Exgetical Commentary on Deuteronomy 

Expositional Commentaries 

The New American Commentary: Deuteronomy 

The Pulpit Commentary: Deuteronomy 

Lange’s Commentary: Deuteronomy 

ITC: Journeying with God: Deuteronomy 

JPS Torah Commentary: Deuteronomy 

Introductory Commentaries 

Be Equipped: Wiersbe, Warren W. 
Wesley’s Notes: Deuteronomy 

UBS Handbook: Deuteronomy 

Outlines 

The Book of Deuteronomy by Gingrich, Roy 

Create a collection of your Deuteronomy Commentaries 

Collection Name: Deuteronomy Resources  

Collection Rule: subject:deuteronomy 

Note: To create a collection: Tools > Collection 

 

  

http://www.logos.com/product/1320/word-biblical-commentary-volume-6a-deuteronomy-1-21-9
http://www.logos.com/product/2299/word-biblical-commentary-volume-6b-deuteronomy-21-10-34-12
http://www.logos.com/product/5185/the-new-international-commentary-on-the-old-and-new-testament
http://www.logos.com/product/4105/a-critical-and-exegetical-commentary-on-deuteronomy-3rd-ed
http://www.logos.com/product/2032/the-new-american-commentary-deuteronomy
http://www.logos.com/product/14116/the-pulpit-commentary-deuteronomy
http://www.logos.com/product/5759/langes-commentary-on-the-holy-scriptures
http://www.logos.com/product/3382/word-and-presence-a-commentary-on-the-book-of-deuteronomy
http://www.logos.com/product/3928/the-jps-torah-commentary-deuteronomy
http://www.logos.com/product/2557/be-equipped
http://www.logos.com/product/9130/john-wesley-collection
http://www.logos.com/product/8861/a-handbook-on-deuteronomy
http://www.logos.com/product/8292/the-book-of-deuteronomy
http://www.logos.com/product/8292/the-book-of-deuteronomy


 
 

 
80 

 

 

JOSHUA: WHAT RESOURCES WOULD YOU RECOMMEND? 
 

Exegetical Commentaries 

Word Biblical Commentary: Joshua 

NICOT: The Book of Joshua 

Expositional Commentaries 

The New American Commentary: Joshua 

Joshua: An Expositional Commentary (Boice) 

The Pulpit Commentary: Joshua 

Lange’s Commentary: Joshua 

ITC: Journeying with God: Joshua 

Introductory Commentaries 

Be Strong: Wiersbe, Warren W. 

Wesley’s Notes: Joshua 

UBS Handbook: Joshua 

Outlines 

The Book of Joshua by Gingrich, Roy 

Create a collection of your Exodus Commentaries 

Collection Name: Joshua Resources  

Collection Rule: subject:joshua 

Note: To create a collection: Tools > Collection 

 

 

 

http://www.logos.com/product/1340/word-biblical-commentary-volume-7-joshua
http://www.logos.com/product/5185/the-new-international-commentary-on-the-old-and-new-testament
http://www.logos.com/product/2043/the-new-american-commentary-joshua
http://www.logos.com/product/8188/joshua-an-expositional-commentary
http://www.logos.com/product/14127/the-pulpit-commentary-joshua
http://www.logos.com/product/5759/langes-commentary-on-the-holy-scriptures
http://www.logos.com/product/3399/inheriting-the-land-a-commentary-on-the-book-of-joshua
http://www.logos.com/product/125/be-strong
http://www.logos.com/product/9130/john-wesley-collection
http://www.logos.com/product/8862/a-handbook-on-the-book-of-joshua
http://www.logos.com/product/8301/the-book-of-joshua
http://www.logos.com/product/8301/the-book-of-joshua
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JUDGES: WHAT RESOURCES WOULD YOU RECOMMEND? 
 

Exegetical Commentaries 

Word Biblical Commentary: Judges 

ICC: A Critical and Exgetical Commentary on Judges 

Expositional Commentaries 

The New American Commentary: Judges/Ruth 

The Pulpit Commentary: Judges 

Lange’s Commentary: Judges 

ITC: Journeying with God: Judges 

Preacher’s Commentary: Judges/Ruth 

Believers Church Bible Commentary: Judges 

Introductory Commentaries 

Be Available: Wiersbe, Warren W. 

Wesley’s Notes: Judges/Ruth 

 

Outlines 

The Book of Judges/Ruth by Gingrich, Roy 

Create a collection of your Judges Commentaries 

Collection Name: Judges Resources  

Collection Rule: subject:judges 

Note: To create a collection: Tools > Collection 

 

  

http://www.logos.com/product/8806/word-biblical-commentary-vol-8-judges
http://www.logos.com/product/4106/a-critical-and-exegetical-commentary-on-judges
http://www.logos.com/product/2044/the-new-american-commentary-judges-ruth
http://www.logos.com/product/14148/the-pulpit-commentary-judges
http://www.logos.com/product/5759/langes-commentary-on-the-holy-scriptures
http://www.logos.com/product/3381/at-risk-in-the-promised-land-a-commentary-on-the-book-of-judges
http://www.logos.com/product/2356/the-preachers-commentary-series-volume-7-judges-ruth
http://www.logos.com/product/8896/judges
http://www.logos.com/product/115/be-available
http://www.logos.com/product/9130/john-wesley-collection
http://www.logos.com/product/8302/the-books-of-judges-and-ruth
http://www.logos.com/product/8302/the-books-of-judges-and-ruth
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RUTH: WHAT RESOURCES WOULD YOU RECOMMEND? 
 

Exegetical Commentaries 

Word Biblical Commentary: Ruth/Esther 

NICOT: The Book of Ruth 

Expositional Commentaries 

The New American Commentary: Judges/Ruth 

The Pulpit Commentary: Ruth 

Lange’s Commentary: Ruth 

ITC: Journeying with God: Ruth 

Preacher’s Commentary: Judges/Ruth 

Believers Church Bible Commentary: ruth/Jonah/Esther 

Introductory Commentaries 

Be Committed (Ruth/Esther): Wiersbe, Warren W. 

Wesley’s Notes: Judges/Ruth 

Outlines 

The Book of Judges/Ruth by Gingrich, Roy 

Create a collection of your Exodus Commentaries 

Collection Name: Ruth Resources  

Collection Rule: subject:ruth 

Note: To create a collection: Tools > Collection 

 

 

 

  

http://www.logos.com/product/1360/word-biblical-commentary-volume-9-ruth-esther
http://www.logos.com/product/5185/the-new-international-commentary-on-the-old-and-new-testament
http://www.logos.com/product/2044/the-new-american-commentary-judges-ruth
http://www.logos.com/product/14162/the-pulpit-commentary-ruth
http://www.logos.com/product/5759/langes-commentary-on-the-holy-scriptures
http://www.logos.com/product/3386/surely-there-is-a-future-a-commentary-on-the-book-of-ruth
http://www.logos.com/product/2356/the-preachers-commentary-series-volume-7-judges-ruth
http://www.logos.com/product/8897/ruth-jonah-esther
http://www.logos.com/product/117/be-committed
http://www.logos.com/product/9130/john-wesley-collection
http://www.logos.com/product/8302/the-books-of-judges-and-ruth
http://www.logos.com/product/8302/the-books-of-judges-and-ruth
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1 SAMUEL & 2 SAMUEL: WHAT RESOURCES WOULD YOU RECOMMEND? 
 

Exegetical Commentaries 

Word Biblical Commentary: 1 Samuel 

Word Biblical Commentary: 2 Samuel 

NICOT: The Book of 1 Samuel 

ICC: A Critical and Exgetical Commentary on 1 & 2 Samuel 

Expositional Commentaries 

The New American Commentary: 1 &  2 Samuel 

The Pulpit Commentary: 1 Samuel 

The Pulpit Commentary: 2 Samuel 

Lange’s Commentary: 1 & 2 Samuel  

ITC: Journeying with God: 1 & 2 Samuel 

Introductory Commentaries 

Be Restored (1 Samuel): Wiersbe, Warren W. 

Be Successful (2 Samuel & 2 Chronicles): Wiersbe, Warren W. 

Wesley’s Notes: 1 & 2 Samuel 

UBS Handbook: 1 Samuel 

UBS Handbook: 2 Samuel 

Outlines 

The Book of 1 Samuel by Gingrich, Roy 

The Book of 2 Samuel by Gingrich, Roy 

Create a collection of your 1 & 2 Samuel Commentaries 

Collection Name: 1 & 2 Samuel Resources  

Collection Rule: subject:samuel 

Note: To create a collection: Tools > Collection 

 

http://www.logos.com/product/1310/word-biblical-commentary-volume-10-1-samuel
http://www.logos.com/product/1317/word-biblical-commentary-volume-11-2-samuel
http://www.logos.com/product/5185/the-new-international-commentary-on-the-old-and-new-testament
http://www.logos.com/product/4109/a-critical-and-exegetical-commentary-on-the-books-of-samuel
http://www.logos.com/product/2024/the-new-american-commentary-1-2-samuel
http://www.logos.com/product/14195/the-pulpit-commentary-1-samuel
http://www.logos.com/product/14237/the-pulpit-commentary-2-samuel
http://www.logos.com/product/5759/langes-commentary-on-the-holy-scriptures
http://www.logos.com/product/3396/let-us-be-like-the-nations-a-commentary-on-1-and-2-samuel
http://www.logos.com/product/2558/be-successful
http://www.logos.com/product/2559/be-restored
http://www.logos.com/product/9130/john-wesley-collection
http://www.logos.com/product/8864/a-handbook-on-the-first-book-of-samuel
http://www.logos.com/product/8865/a-handbook-on-the-second-book-of-samuel
http://www.logos.com/product/8303/the-book-of-1st-samuel
http://www.logos.com/product/8304/the-book-of-2nd-samuel
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7 KEY PRINCIPLES OF JESUS’ PRAYER LIFE, Part 2/7 
 

PRINCIPLE #2:  People and Places of Prayer 

The second principle of prayer is that people and location did not interfere with Christ’s priority to pray, but were 

integrated into His pattern of prayer. For throughout Jesus’ ministry, He found a place to pray amidst the constant needs 

of the people that He was responsible for ministering to.  At times this required Jesus to withdraw completely from 

them.  At other times, He withdrew with several or more disciples.  And yet, there are times where He remained with 

the people and prayed before them.  It should be noted that when Jesus was alone, the Scriptures do not necessarily 

mention Him praying.  However, because of Jesus’ pattern of prayer, we can reasonably presume that He was praying at 

some point in His solitude.  

A) Solitude.   

There are several examples where Jesus withdrew to be alone with God the Father in prayer.  For example, the 

temptation in the wilderness (Luke 3:21, Matt 3:13–17, Mark 1:9–11), prior to His betrayal by Judas withdrawing to 

Mount Olivet (Luke 21:37) and after the feeding of five thousand (Matthew 14:23) we are told that Jesus went to pray 

alone.  Regardless of recent events, present situations or what lies ahead, Jesus establishes a priority to pray to God the 

Father. 

B) Several Companions.   

On several occasions we see Jesus withdrawing not by Himself, but taking along several companions.  One example is at 

the Mount of Transfiguration mentioned in Luke 9:28.  Another example would be when Christ withdrew from Galilee 

before heading to Bethsaida after the news that John the Baptist had been killed (Matthew 14:13, Mark 6:31-34, Luke 

9:10-16, and John 6:1-3). Another example would be the high priestly prayer of Jesus in the upper room in John 17:1-26.  

C) Sizeable Crowds.   

At crucial times, the Lord Jesus Christ would even pray before a large crowd and address God the Father directly as 

“Father”.  In many of these cases, it was to demonstrate the unique relationship between Himself and God the Father.  

For example, in Matthew 11:25-27, Jesus praises God the Father in a prayer before the multitudes for the believing 

repentant “infants” in spite of the unrepentant cities of Chorazin, Capernaum and Bethsaida.   In Luke 23:34, Jesus from 

the cross intercedes for the soldiers before the multitudes by praying to God the Father. In Luke 23:46, Jesus cries out 

with a loud voice before those watching the crucifixion and prays entrusting His Spirit to God the Father. The last 

example is the raising of Lazarus from the dead in John 11:41-42 where Jesus thanks God in His public prayer.  

Whether after a busy day of ministry or even the death of a close companion, Jesus’ pattern was to pray at times in 

isolation, with close companions, and/or sometimes even before large crowds so that God was glorified. 
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7 KEY PRINCIPLES OF JESUS’ PRAYER LIFE, Part 3/7 
 

PRINCIPLE #3: Preparing for Significant Events and Decisions 

Jesus demonstrates to us the need to seek guidance in prayer in anticipation of upcoming decisions and events.  Seeking 

God’s wisdom (James 1:5) and will in these matters through prayer and His Word, must not be neglected regardless of 

the activities that may be required to plan and prepare for ministering. 

A) Jesus Prayed Before Significant Decisions: Apostles Chosen.  

One of the more remarkable passages of prayer is Luke 6:12-16, the choosing of the twelve apostles.  Specifically in Luke 

6:12 are two points that need emphasizing.  First is the phrase ‘He spent the whole night’ and ‘prayer to God’.  Jesus 

spent the whole night watching and persevering in this vigil (Louis Godet, A Commentary on the Gospel of St. Luke, p. 

299) and coupled with ‘prayer to God’ which is an objective genitive not a subjective genitive (Daniel B. Wallace, Greek 

Grammar Beyond the Basics - Exegetical Syntax of the New Testament, p. 117).  Therefore, grammatically, we may 

conclude that Jesus communed with the Father in a specific prayer about the decision to choose the twelve apostles, 

setting aside the second priority of sleep. 

B) Jesus Prayed Before Significant Events: Betrayal, Arrest, & Cross.   

In one of the most revealing passages into the mind and heart of Christ regarding His death on the cross we see three 

prayers of petition by the Lord Jesus Christ in the garden of Gethsemane (Matthew 26:36-46, Mark 14:32–42; Luke 

22:40–46).  First, we have Jesus withdrawing with several close disciples, and then, secondly, withdrawing Himself from 

them to pray alone.  We see how Jesus prayed about His death on the cross that was about to take place and the sin 

bearing and resulting defilement from man’s iniquity. No doubt His agony is reflected in these prayers/petitions (John F. 

MacArthur, Matthew Commentary 24-28, p. 170).  Three supplications were offered and stand before us never to forget 

that in the face of any trial, difficulty, and/or decision, we must call upon the Lord in prayer. 

  

logosres:nasb95;ref=BibleNASB95.Jas1.5
logosres:nasb95;ref=BibleNASB95.Lk6.12-16
logosres:gs-ggbtb;ref=Page.p_116;off=1270
logosres:gs-ggbtb;ref=Page.p_116;off=1270
logosres:nasb95;ref=BibleNASB95.Mt26.36-46
logosres:nasb95;ref=BibleNASB95.Mk14.32-42
logosres:nasb95;ref=BibleNASB95.Lk22.40-46
logosres:nasb95;ref=BibleNASB95.Lk22.40-46
logosres:mattmntc;ref=Bible.Mt26.36;off=3409
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7 KEY PRINCIPLES OF JESUS’ PRAYER LIFE, Part 4/7 
 

PRINCIPLE #4: Progression of Ministry 

In the trench-work of ministering, where people demand attention, prayer must not be neglected.  No person, event, 

nor circumstance should hinder the primacy of prayer.  Whether Jesus was being baptized, confronted with death of a 

loved one, or even approached by inquiring individuals the progression of ministry necessitates prayer. 

A) Jesus’ Baptism.   

In Luke 3:21-22 we see Jesus praying and immediately heaven was opened and the Holy Spirit descended upon Him in 

bodily form like a dove.  At this hinge, between the baptism of Jesus and the temptation in the wilderness by Satan we 

see Jesus exemplifying for us that all activities are to be bathed in prayer.  Although we do not know what type of prayer 

Jesus prayed, we do read what follows that prayer, the descent of the Holy Spirit upon Him.    

B) Raising of Lazarus.   

In John 11, we have a discourse of the death and resurrection of Lazarus.  The prayer of Jesus for Lazarus to rise from the 

dead is not recorded in the Scriptures, however we do read in John 11:41 about Jesus giving thanks to God the Father 

before the people as a result of the resurrection of Lazarus.  As these events progress, amidst those mourning Lazarus’ 

death as well as Jesus’ own grief, Jesus lifts up a prayer of thanksgiving.  Once again, illustrating that Jesus was 

continually in prayer (John Peter Lange, Gospel According to John, p. 356) no matter how busy. 

C) Answering the Greeks.  

The Passover before Jesus was to be crucified was approaching and Jesus was answering questions from the Greeks in 

John 12:20-43.  As Jesus taught the people that He must die, He petitioned God the Father to glorify His name.  Soon 

after this prayer, the voice of God the Father speaks forth from heaven for all to hear (John 12:28).  It is important to 

note that although Jesus is ministering to the people, Jesus Himself is troubled, and yet in spite of His grief and the 

multitude of questions, Jesus prays not for Himself but for God’s glory (Beauford Bryant & Mark Krause, The College 

Press NIV Commentary: John, p. 275). 
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7 KEY PRINCIPLES OF JESUS’ PRAYER LIFE, Part 5/7 
 

PRINCIPLE #5: Post-Ministry 

At the end of a ministering event or the close of any activity, the principle to pray post-ministry must be employed.  

Reflecting on the blessings, successes, and failures of ministering one must come to God the Father with gratitude, 

praise and worship regardless of the temptation to neglect prayer due to exhaustion or other excuses. 

A) After Feeding the 5000.  

It is amazing to see that after a significant ministry event/miracle, it is recorded in Scriptures that Jesus allocates time to 

pray. He sends the disciples away in a boat and heads alone to the mountains to pray (Matthew 14:23, Mark 6:46, John 

6:15).  As exhausting as ministry was, Jesus always found time to pray. 

B) After the Return of the 70 Disciples.   

In the passage of Luke 10:21-22 the seventy disciples that Jesus sent out earlier (Luke 10:1) have returned with much 

joy.  And this brought about a divine initiated joy (Alfred Plummer, International Critical Commentary on St. Luke, p. 281) 

in Christ which resulted in open prayer of praise to God the Father in Luke 10:21.  Once again Christ manifests to us the 

priority of prayer after ministering to others. 
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7 KEY PRINCIPLES OF JESUS’ PRAYER LIFE, Part 6/7 
 

PRINCIPLE #6: Persecution 

The Lord Jesus Christ Himself best portrays the principle of prayer in the course of persecution like no other individual in 

the biblical text. For we see our Lord and Savior under the severest of trials, death on the cross and at the core of His 

persecution and pain, prayer permeates throughout His suffering on our behalf for our sin. On the cross, the Scriptures 

reveal to us seven sayings of Jesus; three of these sayings are considered prayers, which will be examined. 

A) Commencement of the Crucifixion.  

Jesus utters the following words, recorded in Luke 23:33, seemingly immediately at the beginning of His crucifixion, 

“Father, forgive them; for they do not know what they are doing”. This is an intercessory prayer to God the Father on 

behalf of His tormentors (John MacArthur, MacArthur Study Bible, p. 1564). This perfect example, amid the intensity of 

such pain, Jesus showed us the model that prayer has to inaugurate our trials.  Jesus Christ, in spite of the injurious 

nature of the cross, committed this to prayer, looking past the circumstance to the hearts of His ignorant enemies.  

B)  Continuance of the Crucifixion.  

The fourth saying of Jesus on the cross is placed before us in the written Word of God in Matthew 27:46, “My God, my 

God why have you forsaken me”.  This prayer, in the form of a question, refers back to Psalm 22:1.  These words reveal 

to us the anguish of Jesus as a result of being separated from God the Father for the first and only time, because of His 

sin bearing (John MacArthur, Matthew Commentary 24-28, p. 270).  In the middle of our Lord’s suffering for sin, He 

turns to prayer and compels us to consider doing the same regardless of other priorities and especially during the 

intensive, moments of service and trials. 

C)  Conclusion of the Cross.  

It is recorded in Luke 23:46, “Father, into your hands I commit my spirit”.  This final seventh saying of Jesus from the 

cross, refers back to Psalm 35:1 (Nolland, John, Word Biblical Commentary Vol. 35c: Luke 18:35-24:53, p. 1158) 

consummating with prayer the completion of His cross work to atone for sin. Nearing the end of His work, Jesus’ prayer 

is a reminder that when the end is in sight, pray. 
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7 KEY PRINCIPLES OF JESUS PRAYER LIFE, Part 7/7 
 

PRINCIPLE #7: Intercessory Prayer 

The principle of intercessory prayer for people cannot be overlooked nor missed in the life of Jesus.  Additionally, some 

intercessory prayers are not recorded; however, the Scriptures reveal that Jesus had indeed interceded for individuals.  

A.  Prayer for Peter.   

In Luke 22:32 we discover that Jesus had been requested by Satan to sift Peter like wheat.  However, we read that Jesus 

had prayed for Peter at some point earlier in time.  Although we do not know when this prayer was offered, it reveals 

that Jesus never lost site of people amid the demands and pressures of life and ministry. 

B.  Priestly Prayer.   

In John 17:1-26, in the upper room before Jesus’ betrayal we have the longest single prayer of Jesus found in the New 

Testament (Beauford Bryant and Mark Krause, The College Press NIV Commentary: John, p. 338).  The Lord Jesus is 

amongst the disciples and it has been an evening full of activity. Jesus had washed their feet (John 13:1-20), the Passover 

meal was completed and the Lord’s Supper was instituted (Matthew 26:26-29), Judas had left to betray Jesus (John 

13:21-30), and right before they sang a hymn and departed, Jesus took the time to pray this petition. Not only did Jesus 

pray for Himself, but He prayed for the disciples, and future believers in His great high priestly prayer (Robert L. Thomas 

and Stanley N. Gundry, A Harmony of the Gospels With Explanations and Essays, p. 218). These particular petitions were 

not about wealth, prestige, or worldly influence but that present and future believers may be kept from evil and the evil 

one, separated from the sinful world, eligible for duty, and delivered safely to their heavenly home (Marcus Rainsford, 

Our Lord Prays for His Own, p. 173). Amid these significant activities, Jesus made prayer a priority. 

III. Conclusion 

The living of life will have its ebbs and flows, but prayerful communion with the Father must remain the steadfast 

practice of every born-again believer.  To truly prioritize prayer in a busy schedule there must be prayer before, during, 

and after any and all activities and seasons of peace, prosperity, persecutions or even painful trials.  Not only petitioning 

on behalf of self but for others as well.  This is the pattern Jesus exemplified throughout His ministry- alone, before few 

and before many. Even though we have few examples of the words of Jesus’ prayers (Beauford Bryant and Mark Krause, 

The College Press NIV Commentary: John, p. 337), what is said and seen from His prayer life is adequate to conclude that 

prayer was a priority for Jesus.   His example is sufficient to necessitate us to the identical priority.  Lastly, Christ was 

sinless, He had the perfect relationship with the Father, and He made prayer a priority while doing the will of the Father.   

WARNING: 

Prayerlessness is willful independence 
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OUTLINES & THEIR TITLES – WHAT MAKES A GREAT HEADLINE 
 

Now that most sermons are going online, a sermon title and corresponding outline will be the difference between one 

sermon being heard and another being overlooked. Therefore, think thoughtfully and carefully about your titles and 

outlines. The principles for a good title apply for a good outline as well. Here is advice from various preaching books: 

Advice for Creating an Effective Sermon Title (Note: some of these books may not work if you do not own the book) 

Anderson, Kenton C. Choosing to Preach: A Comprehensive Introduction to Sermon Options and Structures, p 152. Grand 

Rapids, MI: Zondervan Publishing House, 2006.  

 CP:CISOS: 11. Title Your Sermon 

Robinson, Haddon W. and Craig Brian Larson. The Art and Craft of Biblical Preaching: A Comprehensive Resource for 

Today's Communicators. 1st ed., p 370. Grand Rapids, MI: Zondervan Publishing House, 2005. 

 ACBP:CRTC: Chapter 100: The Purpose-Driven Title 

MacArthur, John F., Jr. Rediscovering Expository Preaching, p 239. Dallas: Word Publishing, 1992. 

 REP: Choosing a Title for a Message 

Hamilton, Donald L. Homiletical Handbook, p 67. Nashville, TN: Broadman Press, 1992. 

 Homiletical Handbook: Step 9: Choose a Title 

 Homiletical Handbook: Step 12: Choose a Title 

Gugliotto, Lee J. Handbook for Bible Study: A Guide to Understanding, Teaching, and Preaching the Word of God. 

electronic ed. Hagerstown, MD: Review and Herald Publishing Association, 2001. 

 Handbook for Bible Study: Choosing a Title 

Brown, H.C., Jr, H. Gordon Clinard, Jesse J. Northcutt and Al Fasol. Steps to the Sermon: An Eight-Step Plan for 

Preaching With Confidence. Revised., p 112, p 113. Nashville, TN: Broadman & Holman Publishers, 1996. 

 SS:ESPPWCR: The Title 

Another place to learn techniques to improve your sermon titles come from a source you might not initially consider: 

newspapers & blogs! Check out the following links: 

 http://www.blogussion.com/content-management/better-blog-titles/ 

 http://michelfortin.com/write-magnetic-headlines-with-these-7-tips/ 

 http://outspokenmedia.com/blogging/write-killer-blog-titles/ 

 http://www.copyblogger.com/10-sure-fire-headline-formulas-that-work/ 

 http://web.ku.edu/~edit/heads.html 

 http://www.copyblogger.com/how-to-write-headlines-that-work/ 

http://www.logos.com/product/5431/choosing-to-preach
logosres:choosng2prch;pos=Article$3DPT2.1.2.11$7CArticleLength$3D1150$7CContext$3D11.$2520Title$2520$7COffset$3D0$7COffsetInContext$3D0$7CResource$3DLLS:CHOOSNG2PRCH$7CVersion$3D2010-03-29T19:14:14Z
http://www.logos.com/product/5429/the-art-and-craft-of-biblical-preaching
http://www.logos.com/product/5429/the-art-and-craft-of-biblical-preaching
logosres:artcrftbbclpr;pos=Article$3DPT5.CH100$7CArticleLength$3D585$7CContext$3DChapter$252010$7COffset$3D0$7COffsetInContext$3D0$7CResource$3DLLS:ARTCRFTBBCLPR$7CVersion$3D2010-03-23T18:14:27Z
http://www.logos.com/product/654/rediscovering-expository-preaching
logosres:expsprch;pos=Article$3Dch12.4$7CArticleLength$3D561$7CContext$3DChoosing$2520a$7COffset$3D0$7COffsetInContext$3D0$7CResource$3DLLS:37.0.1$7CVersion$3D2009-10-26T23:35:43Z
http://www.logos.com/product/7413/homiletical-handbook
logosres:homiltchbk;pos=Article$3DPT2.CH5.STP9$7CArticleLength$3D1291$7CContext$3DStep$25209:$2520Ch$7COffset$3D0$7COffsetInContext$3D0$7CResource$3DLLS:HOMILTCHBK$7CVersion$3D2009-10-28T19:35:52Z
logosres:homiltchbk;pos=Article$3DPT2.CH4.STP12$7CArticleLength$3D2183$7CContext$3DStep$252012:$2520C$7COffset$3D0$7COffsetInContext$3D0$7CResource$3DLLS:HOMILTCHBK$7CVersion$3D2009-10-28T19:35:52Z
logosres:hbkbibst;pos=Article$3DHBKBIBST.6.8$7CArticleLength$3D894$7CContext$3DChoosing$2520a$7COffset$3D0$7COffsetInContext$3D0$7CResource$3DLLS:34.0.38$7CVersion$3D2002-08-08T19:04:44Z
logosres:stepssrmn;pos=Article$3DCH6.1$7CArticleLength$3D671$7CContext$3DThe$2520Title$250a$7COffset$3D0$7COffsetInContext$3D0$7CResource$3DLLS:STEPSSRMN$7CVersion$3D2009-10-27T19:16:17Z
http://www.blogussion.com/content-management/better-blog-titles/
http://michelfortin.com/write-magnetic-headlines-with-these-7-tips/
http://outspokenmedia.com/blogging/write-killer-blog-titles/
http://www.copyblogger.com/10-sure-fire-headline-formulas-that-work/
http://web.ku.edu/~edit/heads.html
http://www.copyblogger.com/how-to-write-headlines-that-work/
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NOTES FOR THE PULPIT: MANUSCRIPT TO MEMORIZE 

If you have watched a young seminary student preach, they fall in two basic categories. They are either tied significantly 

to their notes, or they have next to nothing in the pulpit. This illustrates the dilemma most teachers/preachers face 

today: how much information should one bring into the pulpit. There are advantages and disadvantages to both 

methods. A properly constructed manuscript is a wonderful way to think through the whole sermon from start to finish. 

All the illustrations, expositions, applications, transitions are easily accessible and can be referenced during the 

preaching event. However, dependence on a manuscript in the pulpit can minimize eye contact, sound unnatural and 

too academic, and overwhelm the audience with too much detail and technical information. On the other hand, a 

minimal outline or no-outline is a great way to connect to the audience and be very personable. However, imprecision, 

lack of detail, and lack of structure opens the door for shallow preaching and emotionalism that in the long run won’t 

develop disciples grounded in the Scriptures. Admittedly, these are extreme pictures of both styles to make a point. So is 

there a happy balance? Can we have your cake and eat it to? I believe there is and the key is found in the method of 

preparation.  

So whether you use a detailed manuscript, notes, or nothing at all, let me offer the follow suggestions. First, let’s 

remember every destination begins with a journey, and every journey is incremental with milestones. In other words, 

don’t flip the switch overnight. My advice to the “manuscripters” is to move to less notes and to the “noteless” is to add 

more detail. Now with that said, here are some practical tips. 

 Develop your outline first from the text and memorize. Memorizing this alone will provide a framework that any 

audience can follow. The outline should have audible, visual, and textual clues to guide you and the audience to the next 

point. Also, show a sequence or process which in turn can make the outline more memorable. For example, Sit, Stand, 

Run, and Rest. (See Best Practice Video, Lesson 5, Exercises 6-7 | Seminar/Webinar Session #4) 

 Memorize your introduction, proposition, and conclusion. This alone can have a dramatic effect gaining the 

attention of the audience at the beginning and assuring that you will avoid closing too abruptly. This will create 

confidence in the audience you are prepared. 

  Practice explaining your point out loud in a conversational manner. Remove technical language and avoid confusing 

explanations. If you cannot “keep it simple” and clear, then study the topic further or avoid the subject altogether. I do 

not mean to avoid difficult subjects, but that clarity is critical and this ensures your audience can understand. 

 Memorize your applications and illustrations. Once again you will connect better with your audience and this portion 

of the lesson will be more authentic. If you can’t memorize these items, most likely they are too long and too complex. 

 Memorize your transitions. This will allow you to flow from one point to the next naturally and the audience will 

never know if you added or subtracted material during the preaching event. 

 Discover your practice point. After the sermon is finished, start practicing start to finish. Find out how many times it 

takes to get through the sermon with the most eye contact, and the key parts memorized.  

 Bring what is essential to the pulpit. After you practice you will know what you have memorized and what needs 

practice. Always bring the outline, introduction, proposition, conclusion, and anything else that you need. 
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THE NECESSARY CONNECTION BETWEEN THE TEXT & APPLICATION 

When we take up the role of teaching and preaching we must be mindful of the warning found in James 3:1 -  

Let not many of you become teachers, my brethren, 
knowing that as such we will incur a stricter judgment. 

 
One of easiest ways to incur stricter judgment is to command your audience to obey an application that is not rooted in 
the Biblical text. This falls under the same condemnation by Jesus of the scribes and Pharisees in Luke 11:46 

 

But He said, “Woe to you lawyers as well!  

For you weigh men down with burdens hard to bear,  

while you yourselves will not even touch the burdens with one of your fingers. 

Imagine having to explain yourself before the Lord how you told people to “obey man” rather than “obey God”. In 
addition to this, when an application is not rooted in the Biblical text, there is significant risk that you may contradict the 
commands of scripture or worse introduce heresy.  
 
So how do we keep the application rooted in the text? Here are some practical steps: 
 
 Study the passage and be clear on the author’s intended meaning 
 
 Identify any clear commands in the text and relay that to the audience (do not add and do not subtract) 
 
 Check your cross reference section in the passage guide and see if there are related passages that have an application 
tied to the text of the passage you are studying. 
 
 Consult application commentaries like Jon Courson, Life Application Bible Commentary, Application Commentaries 
Bundle, or NIV Application Commentary for OT / NT. 
 
 Create a collection of your devotionals and search for your passage in them <bible = john 3:16>  

 See Orange Overview Training CD (Beginner > Searching Books > Collections) 
 
 Create a principle tied to the text than can be universally applied to the audience   

 See Blue Best Practices Training 1 & 2 (Lesson 9) 

 Test the application against yourself, are you willing to apply? 

 

 

  

http://www.logos.com/product/8649/the-jon-courson-essential-bible-study-library
http://www.logos.com/product/5762/the-life-application-bible-commentary
http://www.logos.com/product/7658/application-commentaries-bundle
http://www.logos.com/product/7658/application-commentaries-bundle
http://www.logos.com/product/5461/niv-application-commentary-old-testament-prophets
http://www.logos.com/product/5459/niv-application-commentary-new-testament
http://www.learnlogos.com/Learn_Logos_4_Training_CD_s/1814.htm
http://www.learnlogos.com/Learn_Logos_4_Training_CD_s/1814.htm
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PLACEMENT OF THE ILLUSTRATION & APPLICATIONS 

In the body of the sermon or lesson, there are three locations to place an illustration and application. Let’s look at each 
location and its corresponding benefits. 

Before your exposition: This is utilized to introduce your exposition 

 It prepares the audience for the point, increasing the chances the idea will be heard in its entirety. 

 It can be used to remove prejudice and persuade the audience to listen to what will follow 

 It can generate interest and curiosity so that the exposition is stronger and more memorable 

 It’s a great way to transition from the previous point so there is a clear break between the ideas 

 It is recommended you open with an illustration, rather than an application. 

 Keep your illustration brief and to the point. 

 Don’t allow your illustration to be more memorable than the exposition both in emotional content and in length 
of time 

During the Exposition: This is utilized to emphasize the exposition 

 Since your illustration or application will follow a portion of your exposition, you will want to ensure that the 
illustration and application is brief and has a concluding format or style. 

 The illustration and application must repeat the point in a practical and relevant way. 

 Depending on the length of your exposition, do not employ more than one illustration and one application for 
each point. 

 Only use an illustration or application here for lengthy points. If you exposition is too brief, you run the risk of 
your illustration and application getting too much attention. 

After the Exposition: This is utilized to summarize your exposition 

 Employing an illustration or application at the end of your exposition can strengthen the ideas presented and 
make them stand out even further. 

 I recommend applications more than illustration to be used after the exposition. 

 Guard against introducing new ideas with the illustration and application, the goal is to repeat the ideas of the 
exposition in a concluding manner. 

Recommend Resources for Building Sermons: 

Choosing to Preach The Art and Craft of Biblical Preaching Preaching that Changes Lives 

        

  

http://www.logos.com/product/5431/choosing-to-preach
http://www.logos.com/product/5429/the-art-and-craft-of-biblical-preaching
http://www.logos.com/product/2399/preaching-that-changes-lives
http://www.logos.com/product/5431/choosing-to-preach
http://www.logos.com/product/5429/the-art-and-craft-of-biblical-preaching
http://www.logos.com/product/2399/preaching-that-changes-lives
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RHETORICAL DEVICES, PART 1 
 

Effective rhetoric combines the power of logic and the art of persuasion to inform and change the minds of any listener. 

We use rhetorical devices all the time without realizing it. For example, when we ask a question that the audience 

already knows is a rhetorical device to involve the audience. In the next several enewsletters, we will provide you a list 

of rhetorical devices; some from the Bible others from outside the Bible that you can employ in your lessons and 

sermons. Rhetorical devices can range from the sounds, to words, to sentence structures and more!  

#1 Absurd: Using the unrealistic to drive home a “realistic” point 

Micah 6:6 With what shall I come to the Lord And bow myself before the God on high? Shall I come to Him with burnt 

offerings, With yearling calves? 7 Does the Lord take delight in thousands of rams, In ten thousand rivers of oil? Shall I 

present my firstborn for my rebellious acts, The fruit of my body for the sin of my soul?  

#2 Alliteration: Repeating sounds, typically with two or more words. 

Is 43:19a “Behold, I will do something new, Now it will spring forth; Will you not be aware of it?  

This verse is also alliterated (h sound) in the Hebrew: 

 

Assonance: Rhyme, repetition of sounds in words or syllable1 

“A stitch in time saves nine” 

 

 

                                                           
1 Bruce K. Waltke, The Book of Proverbs. Chapters 1-15, The New International Commentary on the Old Testament 

(Grand Rapids, MI: Wm. B. Eerdmans Publishing Co., 2004), 41. 
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WHAT VERSION DO YOU HAVE? 
 

Q1: John, how do I know if I have the latest version of Logos 4? 

A1: There are several ways: 

 First, always check what current version you have. 

 Click the help button > Choose About Logos Bible Software  

 

 

 Check and confirm the latest version here: Click Here 

 

 To download the latest version: 

 In the command box type Update Now and press enter (Note: You must be connected to the internet) 

 

 

  

Latest Version for 

Beta Testers 

Latest Version for 

All Users 

http://wiki.logos.com/The_Logos_4_Beta_Program
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PERSONAL BOOK BUILDER TRAINING 

Q1: I heard Logos released a tool where you can make your own Logos searchable books, what is this and how do I get 

trained? 

A1: This tool is called “Logos Personal Books”. It’s available in version 4.3 or higher. 

A2: You can get trained three ways: 

 Use the limited help file (FREE): Tools > Personal Books > Press F1 (help) or click the question mark  

 

 Purchase the webinar – Approximately 2 Hours of Training ($ 4.99) Click here for Preview & Purchase 

 Purchase the Bundle (Overview and Best Practices) and get the webinar for FREE  

o Click Here to Learn about the Video training CDs/Download (15+ Hours of Logos 4 Training) 

 
Training Bundle 

 

 

 

  

http://www.learnlogos.com/Webinar_Personal_Book_Builder_Overview_p/pb1.htm
http://www.learnlogos.com/Learn_Logos_4_Training_CD_s/1814.htm
http://www.learnlogos.com/Learn_Logos_4_Training_CD_s/1814.htm
http://www.learnlogos.com/Webinar_Personal_Book_Builder_Overview_p/pb1.htm


 

 
97 

 

 

PERSONAL BOOKS 
 

Q1: I want to search only my personal books, how do I do this? 

A1: The easiest way to do this is to create a collection of all your personal books.  

 Tools > Collections 

 

 Provide a name for this collection. I have named mine Personal Books. For the rule, type edition:user 

 

 Close the window by click in the x
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BOOLEAN OPERATORS? 
 

Q1: What is a Boolean operator and how do I use them? 

A1: A Boolean operator allows you to include or exclude information in your searches.  

 The AND operate will look for ALL the items in your search 

Note: In Logos, Boolean operators MUST ALWAYS BE CAPITALIZED 

 Faith AND Hope AND Love  

 In this example, we found all the verses that have faith, hope, and love! This is the default for Logos. 

 

 The OR operator will look for EITHER of the items in your search 

 Faith OR love OR hope 

 (faith, hope, love) – this is a list and works the same way. 

 



 

 
99 

 The ANDNOT operator will look for the first word and exclude the second word. In other words, any article that has 

faith and love will not appear in your search results. So use this carefully.  

 Faith ANDNOT love  

 Faith -love 

 

To learn more about Boolean Operators: Click Here 

  

http://wiki.logos.com/Detailed_Search_Help#Using_Boolean_Operators
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SERACHING THE WORDS OF CHRIST AND MORPHOLOGY 
 

Q1: I would like to search for all the commands that Jesus spoke. Is that possible? 

A1: Great Question! This was a little tricky to figure out, but it is possible. 

 11 Minutes: This worked, but it took some time – 11 Minutes! And I have a fast computer! So be patient for the 

search results. 

 

 

 

 

 

 

 

 

 

 

 

 

Email me your questions, and maybe you will be in the next newsletter! tips@learnlogos.com 

 

http://www.learnlogos.com/index.php?option=com_content&view=article&id=84
http://www.learnlogos.com/index.php?option=com_content&view=article&id=77:webinar-schedule&catid=60
http://learnlogos.com/index.php?option=com_content&view=article&id=76:learn-more&catid=66
http://learnlogos.com/index.php?option=com_content&view=article&id=78:distant-education-class-outline&catid=65
http://learnlogos.com/index.php?option=com_content&view=article&id=81:personalized-training-overview&catid=64
http://learnlogos.com/index.php?option=com_content&view=article&id=82:tips-trick-and-help&catid=62
mailto:tips@learnlogos.com


Welcome! More than a Manual… 
If you like this eNewsletter let us know and tell others on Facebook! Now let’s get ready to LearnLogos! 

Note: You can click on the colored links above and it will take you to LearnLogos.com to learn more about all of the 

available training products. There are other types of links in this document: book links, Scripture links, and more. Click 

on them too! 

Thanks and Enjoy! 

John Fallahee, President/CEO & Video Trainer 

RECENT NEWS 
More Webinars Released! Only $ 9.99 $ 4.99 Click image to learn more! 

     

Note: Most webinars are 1 ½ hours in length! Amazing value!  

 

#2 Logos 4.5 Training update releasing before end of Day 

6 New Videos 

 Overview of the New Highlighting features 

 Overview of the New Note features 

 Exploring the new relationship between notes and Highlighting 

 Checking your Base Package 

 Explore the Wiki via help menu 

 Turn on/off the notes in the reading view 

  

Volume 7, Issue 1/2 John Fallahee, M.B.A., M.Div.  
Your Personal Training Assistant! 

http://www.learnlogos.com/Learn_Logos_4_Training_CD_s/1814.htm
http://www.learnlogos.com/category_s/1477.htm
http://www.learnlogos.com/category_s/1514.htm
http://www.learnlogos.com/category_s/1513.htm
http://www.learnlogos.com/category_s/1821.htm
http://www.learnlogos.com
http://www.learnlogos.com/Learn_Logos_4_Training_CD_s/1814.htm
http://www.facebook.com/learnlogos
http://www.learnlogos.com/Calling_all_Students_Using_Logos_4_for_School_p/students.htm
http://www.learnlogos.com/Top_100_Shortcuts_for_Logos_4_Part_3_6_Seminar_p/top100pt3.htm
http://www.learnlogos.com/Studying_Important_Doctrine_Faith_Unbelief_p/faithunbelief.htm


 
 
 

 

 

 

® 

Click here to get the latest Logos Free Books: 

http://www.logos.com/products/search?q=price%3a0&start=0 

Click here to get the latest Vyrso Free Books: 

® 

http://vyrso.com/products/search?q=price%3a0  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1Logos Bible Software & Vyrso are registered trademarks of Logos Research Systems. 

http://www.logos.com/products/search?q=price%3a0&start=0
http://vyrso.com/products/search?q=price%3a0
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THE GRID VIEW 

If you have taken advantage of the “Favorites” feature in Logos, by now you should have several items in the list and it 

may be quite disorganized. To optimize/organize the list, I recommend that you organize your links alphabetically as 

seen below. 

 

HOW TO:  

 Go to the main menu and choose Tools, then choose Favorites 

 

 Click New Folder 

 

 Rename the folder to ‘A’. Note: Repeat the process for the whole alphabet 

 

 

Note: See Overview (Orange CD) > Getting Started > Favorites & Bookmarks to learn more about Favorites. 

  

http://www.learnlogos.com/Learn_Logos_4_Training_CD_s/1814.htm
http://www.learnlogos.com/Learn_Logos_4_Training_CD_s/1814.htm


 
 
 
 

 

PRAYERS OF PAUL 
 

One of the ways to learn more about prayer is to read about those who prayed. Since 

we have looked at Jesus and prayer in previous eNewsletters, let’s look and learn  

from the Apostle Paul. First let’s begin by finding all the passages where Paul  

mention’s prayer. 

HOW TO: 

 Go to the main menu and choose Search 

 

 Choose Bible from the search menu 

 

 To search just Paul’s letters, you need to create a search range to search only  

Romans through Philemon. 

 Click All Passages  

 

 At the bottom, enter the following information and click the Save button. 

 

Note: Now we are ready to search your bible 

 Type the following phrase in your search box and press enter 

 

 What to do with the search results? 

 Make a list of everything Paul personally prayed about 

 Make a list of everyone whom Paul interceded for in prayer 

 Make a list of what Paul asked others to pray about 

 Make a list of how Paul discusses the Trinity 

http://www.LearnLogos.com
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DETERMINING DATE RANGES FOR BOOKS OF THE BIBLE 
 

If you have spent any time reading commentaries, you probably have noticed that the commentaries provide a date for 

the writing of the book. For example, here is an excerpt from the Bible knowledge Commentary1 

 

Just in these two paragraphs alone we have two possible dates for Revelation. This poses a problem. For example, if 

John wrote the book before the fall of Jerusalem, then how should we know interpret the book? 

So what do we do with all these dates? 

HOW TO:  

 Using the Passage Guide (Tools > Passage Guide), enter the first verse of the book. For example, Revelation 1:1 

Note: We are using the passage guide to help locate all our commentaries quickly. We are using verse 1:1 to place us at 

the front of the commentary. 

 

                                                           
1 John F. Walvoord, Roy B. Zuck and Dallas Theological Seminary, vol. 2, The Bible Knowledge Commentary : An 

Exposition of the Scriptures (Wheaton, IL: Victor Books, 1983-), 925. 

logosres:bkc;ref=VolumePage.V_2,_p_925;off=1954


 
 
 Click the first title in your commentary list 

 

 Click in the newly opened commentary and press Page Up button on your keyboard or use the Up Arrow to scroll 

upward in the book until you see the paragraph where dates are being discussed. 

 Here you are after you click the link. 

 

 Here you are after you press Page Up or Up Arrow 

 

 Now review all your commentaries from the passage guide and make a list of all your dates in chronological order. 

Please note the evidence that the commentaries use to support or reject the proposed date. 

 

 

 

 

 

 

 Weigh the evidence that has been provided and choose a date range rather than a specific date. Please note that 

some Bible books provide their own date evidence and that should always be used as the primary date. 

 

 

Commentary   Date Ranges    

Bible Knowledge:  95-96 ad 70 ad 

Word Biblical Commentary: > 80 <100 

NICOTT:   98-117  41-54 

ICC:     60, 64-68, 70-75 
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SURPRISING INSIGHTS FOR YOUR NEXT OUTLINE 
 

 

The other day I was reading through the Art of Preaching Old Testament Narrative2 and was surprised on the author’s 

perspective in outlining for a sermon. He suggested the following: 

 Don’t try to create outlines that people will remember 

 View main points as endings, not beginnings 

 State your outline points in full sentences 

 Think in terms of moves rather than points 

At first blush, you might say that it is the opposite of everything you have observed in the pulpit, been trained, or even 

what you are currently doing Sunday to Sunday. But as I read further, and I suggest you get this book and do the same 

for a more detailed explanation, the author has hit upon something we have forgotten in our preaching – the sermon on 

Sunday, the Sunday school lesson, or even the Bible study is narrative by nature. An expository sermon can take a 

narrative/story like form with the goal that the audience can learn what the text means while engaging in a memorable 

experience but not sacrificing the depth needed to go below the surface of the text. Keep in mind this works best for 

narrative passages.  

What do you do about the epistles and other doctrinal heavy passages? Utilize other narrative passages from the Old 

and New Testament that can illustrate positively or negative the doctrine being discussed. This way, you can make both 

books more accessible to the audience. 

  

                                                           
2 Steven D. Mathewson, The Art of Preaching Old Testament Narrative (Grand Rapids, MI: Baker Academic, 2002), 123. 

http://www.logos.com/product/5361/the-art-of-preaching-old-testament-narrative
http://www.logos.com/product/5361/the-art-of-preaching-old-testament-narrative


 
 
 

 

LOUW-NIDA AND HEBREW WORD STUDY  
 

Hopefully by now you have had a chance to learn a little about Louw-Nida from my training videos. For a quick review, 

the Louw-Nida is a numbering system that can help you determine not only the meaning of a word in the Greek New 

Testament, but it can also help you find related words. For example, love (agape) is Louw-Nida 25.43 and is part of the 

category 25 ‘Attitudes and Emotions’. Furthermore, it is part of a sub-category ‘Love, Affection, Compassion’. The 

Greek-English Lexicon of the New Testament Dictionary is where you can find these definitions, similar terms and learn 

what it can and cannot mean. By the way, you can find a link to your Louw-Nida in your interlinear Bible. 

Greek-English Lexicon of the New Testament Dictionary  ESV Bible 

 

 

Note: To display your Louw-Nida number links, in your interlinear Bible click display and make sure Louw-Nida is 

checked. 

 

Now how does Hebrew play into all this?  

HOW TO:  

 First, let’s open A Dictionary of Biblical Languages Hebrew Old Testament  

 Second, make sure your Reverse interlinear is open. I am going to use the ESV for this example. 

logosres:louwnida;ref=LouwNida.25
logosres:louwnida;ref=LouwNida.25
logosres:esv;ref=BibleESV.Jn3.16
logosres:dblhebr;art=title
logosres:esv;ref=BibleESV.Jn3.16
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 Go to John 3:16 by entering John 3:16 in the Bible reference box and press Enter. 

 

 Next, right click on the first use of ‘love’ and choose from the menu Louw-Nida. 

 

 Next, at the left click ‘Search all open resource’ (note: you could search entire library if you did not have the 

dictionary open) 

 Next, change the search criteria by removing = (equal sign) replacing it with the ~ (approximate sign) and press enter 

to re-run the search: <LouwNida ~  Louw Nida 25.43> 

 Locate in your search results Dictionary of Biblical Languages with Semantic Domains: Hebrew (Old Testament). You 

should have 43 hits, in 41 articles. 

  

 Lastly, please examine the search results. If you look closely, you will find not only the Hebrew equivalent for 

‘Agape’/‘love’, but other Hebrew words related to love! 

 

 

logosres:dblhebr;art=title


 
 
 

 

                   APPLICATION: IT’S EASIER TO LEARN FROM THE SUCCESSES AND 

FAILURES OF OTHERS, THAN TO SUCCEED OR FAIL ON YOUR OWN! 
 

Some have suggested that the test of true maturity is the ability to learn from others. Expressions like “Fools rush in 

where angels fear to tread” would affirm such statements. So, if we can learn from others, why not explore the life 

lessons from individuals disclosed in the pages of scriptures, uncensored and with the full life-experience in view? 

Once you have determined the application, the more difficult task is identifying the appropriate individual to discuss in 

light of your application in a negative or positive way. Therefore, let’s presume your application is “revenge”, how do we 

find the right individual(s)? 

Let me show you how. 

HOW TO:  

 Let’s create a collection of all key Bible Dictionaries (they contain a lot of data on people in the Bible) 

 Go to the main menu and choose Tools > Collections 

 

 Name the collection: Bible Dictionaries, and use the rule subject:“bible--dictionaries” 

 

 Next we need to search this collection for the word “revenge” 

 From the main menu, click Search  

 

 Choose Basic search 
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 Select your collection Bible Dictionaries 

 

 Type in your application keyword revenge and press enter to start searching 

 

 Read through your search results. Here is an example from Easton’s Bible Dictionary 

 

To learn more on creating a collection and searching see the Overview CD 

 

Beginner > Searching Books > Collections (5:28 Minutes) 

Beginner > Searching Books > Basic Search (7:00 Minutes) 

 

http://www.learnlogos.com/Learn_Logos_4_Training_CD_s/1814.htm
http://www.learnlogos.com/Learn_Logos_4_Training_CD_s/1814.htm


 
 
  

 

     PHRASE SEARCHING 

Searching for phrases (2-5 words) is important in identifying recurring ideas as well as to see patterns in the Biblical 

writers. There are three basic ways to search for a phrase:  

 Search on the English phrase 

 Search on the Hebrew/Greek Manuscript 

 Search on the Hebrew/Greek lemma 

The first two are easily accomplished in Logos 4 simply by  selecting the text, then right clicking on the text, and 

choosing selection from the right menu, and then choosing  searching this resource from the left menu. 

 

But there are problems searching phrases in this manner. First, if you are searching on the English, the translator may 

change the English tense or even the word itself. This change will make it next to impossible to find the repeated phrase. 

Second, if you are searching on the manuscript form, then word order or a change in morphology will result in a similar 

fate. So how do you work around this problem? You have to search the lemma. Let’s learn how. 

Let’s search on the phrase “elementary principles of the world” in Colossians 2:20. (I got this idea from a Q&A session 

with Pastor Jasper Willaims, III). 

 

 

 

 
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HOW TO:  

 First open the NASB and your Greek Bible (NA27 with Morphology) 

 

 Turn on sympathetic highlighting so as you select the NASB, the NA27 will be automatically selected and vice versa. 

 Click the visual filter (3 colored circles) 

 Check the box labeled Sympathetic Highlighting 

 Do this for both Books 

 

 In the NASB, select the phrase “elementary principles of the world” (Note: see how the Greek Text is selected 

automatically) This makes it easy for you to determine which Greek words are associated with the English words as well 

as to see if they are together or separate by other words in the Greek. 

 

 Let’s now right click on elementary in the NASB 

 Choose from the menu at the right Lemma 

 At the menu on the left, choose Search this Resource 

 

Note: The reason we search on the lemma through the menu is for logos to populate the search field with the search 

phrase <Lemma = lbs/el/στοιχεῖον> 

Note: The reason we have the Greek text open is to see how many Greek words make of the English phrase. 

 

logosres:nasb95;ref=BibleNASB95.Col2.20
logosres:na27;ref=BibleNA27.Col2.20


 
 
 Since there are three Greek words, copy and paste this search phrase three times in the search box so it looks like the 

following 

  

 Next, we are going to replace the two other Greek words with the Greek words for “the” and “world”. Let’s begin by 

right clicking on the word “the”, then choose lemma, then choose Copy. 

 

 Go to the search tab, select the second Greek word, then right click on the selected text, and choose paste. 

 

 Repeat this process for “world”. Your final search phrase will look as follows. Go ahead and press enter to search. 

IMPORTANT: Put one space between each group of lemma 

  

See next page for Search Results. 
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 Here are the search results 

 

Analysis: We would expect Colossians 2:8 & 2:20 to appear, however, Galatians 4:3 has been added to the list. We 

would have missed this because the NASB used ‘things’ instead of ‘principles’. 

Now how cool is that!  

Note: Currently, Logos does not have the ability to select a phrase and automatically populate the search box with the 

lemmas, so we have to do this manually. Sounds like a great feature request! : ) 

 

 

 

 

  

Learn at 
Your Pace 

http://www.learnlogos.com/category_s/1513.htm
http://www.learnlogos.com/category_s/1477.htm
http://www.learnlogos.com/category_s/1821.htm


 
 
 

 

Hebrew & Greek Grammar Made Simple 

 

Working with the original language is a serious undertaking, but can be made simple with the use of these two 

inexpensive, and concise resources. These two resources can’t be a substitute for seminary classes on Hebrew and 

Greek languages, but they can guide you through basic grammar.  

  
Hebrew Bible Insert $ 4.95 Greek New Testament Insert $ 4.95 

 

 

http://www.logos.com/product/689/hebrew-bible-insert-a-students-guide-to-the-syntax-of-biblical-hebrew
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1 & 2 KINGS: WHAT RESOURCES WOULD YOU RECOMMEND? 
 

Exegetical Commentaries 

Word Biblical Commentary: 1 Kings 

Word Biblical Commentary: 2 Kings 

ICC: A Critical and Exgetical Commentary on the Books of Kings 

Expositional Commentaries 

The New American Commentary: 1,2 Kings 

The Pulpit Commentary: 1 Kings 

The Pulpit Commentary: 2 Kings 

Lange’s Commentary: Kings (Part of 63 Volume Set) 

The Preacher’s Commentary Series: 1,2 Kings 

Introductory Commentaries 

Be Responsible: Wiersbe, Warren W. 
Be Distinct: Wiersebe, Warren W. 

Outlines 

The Book of 1 Kings by Gingrich, Roy 

The Book of 2 Kings by Gingrich, Roy 

Create a collection of your 1 & 2 King Commentaries 

Collection Name: 1 & 2 Kings Resources  

Collection Rule: subject:"1 kings" OR subject:"2 kings" 

Note: To create a collection: Tools > Collection 

 

  

http://www.logos.com/product/1308/word-biblical-commentary-volume-12-1-kings-2nd-ed
http://www.logos.com/product/1315/word-biblical-commentary-volume-13-2-kings
http://www.logos.com/product/4110/a-critical-and-exegetical-commentary-on-the-books-of-kings
http://www.logos.com/product/2023/the-new-american-commentary-1-2-kings
http://www.logos.com/product/14257/the-pulpit-commentary-1-kings
http://www.logos.com/product/14258/the-pulpit-commentary-2-kings
http://www.logos.com/product/5759/langes-commentary-on-the-holy-scriptures
http://www.logos.com/product/2358/the-preachers-commentary-series-volume-9-1-2-kings
http://www.logos.com/product/2560/be-responsible
http://www.logos.com/product/2561/be-distinct
http://www.logos.com/product/8305/the-book-of-1st-kings
http://www.logos.com/product/8305/the-book-of-1st-kings


 
 
 

 

 

WHO PRAYED IN THE OLD TESTAMENT, PART 1? 
It’s one thing to study prayer, it another thing to study those who have prayed, and it’s entirely on a different level when 

you pray. To improve your prayer life and grow in the area of prayer you need to study prayer and those who prayed in 

the Bible. The following search shows you how you can identify those who prayed in the Old Testament and New 

Testament. And once you identify those who pray, you can see how God responded. 

HOW TO:  

 First we need to identify all the Hebrew words associated with prayer.  

Search > Basic Search > “Hebrew words for prayer” 

 

 If you have “Every Prayer in the Bible”, they provide a list of Hebrew words associated with prayer 

 

1722a עָתָר (ʿātār) suppliant, worshiper (Zech 3:10). 
 intervene, interpose, pray (pālal) פָלַל 1776
 encounter, meet, reach, entreat, make intercession (pāgaʿ) פָגַע 1731
 hear, listen to, obey (šāmaʿ) שָמַע 2412
 ask, inquire, borrow, beg (šāʾal) שָאַל 2303
 I, be gracious; pity; in Hithpael stem to beseech, implore (ḥānan) חָנןַ 694
 I, to answer, respond, testify, speak, shout (ʿānâ) עָנהָ 1650

 I (we) pray; now (nāʾ) נאָ 1269

 

 Open your favorite interlinear Bible. I will use the NASB95. 

 Next, click the link with the number above to open the TWOT dictionary to the Hebrew word 

 Right click on the Hebrew word and choose “headword” and then choose “Search all Open Resources” 

 

 Examine your search results in your Bible by reading the context and observe what you learn about prayer 

http://www.logos.com/product/2253/every-prayer-in-the-bible
logosres:twot;ref=TWOT.TWOT_No._1722a
logosres:twot;ref=TWOT.TWOT_No._1776
logosres:twot;ref=TWOT.TWOT_No._1731;off=-265
logosres:twot;ref=TWOT.TWOT_No._2412;off=-480
logosres:twot;ref=TWOT.TWOT_No._2303
logosres:twot;ref=TWOT.TWOT_No._694
logosres:twot;ref=TWOT.TWOT_No._1650;off=-274
logosres:twot;ref=TWOT.TWOT_No._1269
logosres:evprayib;ref=Page.p_3;off=488
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PREACHING CLASS WITH CHARLES H. SPURGEON 
 

If you want to grow as a preacher, you have to study the Bible, read sermons from preachers throughout the ages, study 

contemporary preachers, read books on preaching, and most importantly practice by preaching to others. With this in 

mind, I would like to recommend to you one book that stands head and shoulders above all others as a starting place to 

improve your preaching: Lecture to my Students by Charles H. Spurgeon 

 
The following Screen shot reveals the table of contents for each book. 

Approximately 1000 pages of preaching insights from the Prince of Preachers! 

   

 

 

http://www.logos.com/product/6241/lectures-to-my-students


 
 

 

COLLECTIONS 
 

Q1: John, what collections do you use regularly for your Bible Study? 

A1: I use the following collections for each step in the Bible study process. (Tools > Collections > New) 

COLLECTION NAME: Step 01 – Prayer 

COLLECTION RULE: title:prayer OR subject:prayer 

COLLECTION NAME: Step 02 - Meditation & Devotions 

COLLECTION RULE: type:devotional OR subject:devotional OR title:devotional 

COLLECTION NAME: Step 03 - Historical Background Resources 

COLLECTION RULE: subject:commentaries OR title:handbook OR title:survey OR subject:"bible--dictionaries" OR subject:archaeology 

OR subject:"bible--encyclopedia" 

COLLECTION NAME: Step 04 - Theology: Journals & Systematics 

COLLECTION RULE: type:journal OR subject:theology OR subject:doctrine 

COLLECTION NAME: Step 05 - Observing the Text 

COLLECTION RULE: title:outline OR title:survey OR title:charts OR author:gingrich –american 

COLLECTION NAME: Step 06 - Word Studies 

COLLECTION RULE: type:lexicon OR author:wuest OR title:"word pictures" OR title:"word studies" OR title:vocabulary OR 

title:"anchor yale" OR subject:diction* 

COLLECTION NAME: Step 08 - Solving Problems 

COLLECTION RULE: subject:"apologetics" OR type:journal OR type:commentary OR type:grammar 

COLLECTION NAME: Step 09 – Application 

COLLECTION RULE: subject:devotional OR series:"life application" OR author:courson OR type:lectionary OR subject:sermon 

COLLECTION NAME: Step 10 – Illustrations 

COLLECTION RULE: subject:illustrations OR subject:hymn OR subject:quotations OR subject:anecdote OR type:devotional 

COLLECTION NAME: Step 11 – Sermons 

COLLECTION RULE: title:sermons OR author:macarthur 

 

 

Email me your questions, and maybe you will be in the next newsletter! tips@learnlogos.com 

 

mailto:tips@learnlogos.com
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